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Safety  

The caution and danger statements that this document contains can be referenced 

in the multilingual IBM® Safety Information document that is provided with every 

IBM TotalStorage® DS4000 Storage Subsystem. Each caution and danger 

statement is numbered for easy reference to the corresponding statements in the 

translated document. 

v   Danger: These statements indicate situations that can be potentially lethal or 

extremely hazardous to you. A danger statement is placed just before the 

description of a potentially lethal or extremely hazardous procedure, step, or 

situation. 

v   Caution: These statements indicate situations that can be potentially hazardous 

to you. A caution statement is placed just before the description of a potentially 

hazardous procedure step or situation. 

v   Attention: These notices indicate possible damage to programs, devices, or 

data. An attention notice is placed just before the instruction or situation in which 

damage could occur.

Before installing this product, read the following danger and caution notices. 
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Statement 1: 

  

 

DANGER

Electrical current from power, telephone, and communication cables is 

hazardous. 

To avoid a shock hazard: 

v   Do not connect or disconnect any cables or perform installation, 

maintenance, or reconfiguration of this product during an electrical 

storm. 

v   Connect all power cords to a properly wired and grounded electrical 

outlet. 

v   Connect to properly wired outlets any equipment that will be attached to 

this product. 

v   When possible, use one hand only to connect or disconnect signal 

cables. 

v   Never turn on any equipment when there is evidence of fire, water, or 

structural damage. 

v   Disconnect the attached power cords, telecommunications systems, 

networks, and modems before you open the device covers, unless 

instructed otherwise in the installation and configuration procedures. 

v   Connect and disconnect cables as described in the following table when 

installing, moving, or opening covers on this product or attached 

devices.

 To Connect: To Disconnect: 

1.   Turn everything OFF. 

2.   First, attach all cables to devices. 

3.   Attach signal cables to connectors. 

4.   Attach power cords to outlet. 

5.   Turn device ON. 

1.   Turn everything OFF. 

2.   First, remove power cords from outlet. 

3.   Remove signal cables from connectors. 

4.   Remove all cables from devices.
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Statement 3: 

  

 

CAUTION: 

When laser products (such as CD-ROMs, DVD drives, fiber optic devices, or 

transmitters) are installed, note the following: 

v   Do not remove the covers. Removing the covers of the laser product could 

result in exposure to hazardous laser radiation. There are no serviceable 

parts inside the device. 

v   Use of controls or adjustments or performance of procedures other than 

those specified herein might result in hazardous radiation exposure.

  

 

DANGER

Some laser products contain an embedded Class 3A or Class 3B laser 

diode. Note the following. 

Laser radiation when open. Do not stare into the beam, do not view directly 

with optical instruments, and avoid direct exposure to the beam. 

Class 1 Laser statement 

  

 

IEC 825-11993 CENELEC EN 60 825 
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Statement 4: 

  

 

 

 

 

 

 

 

 

≥ 18 kg (39.7 lb) ≥ 32 kg (70.5 lb) ≥ 55 kg (121.2 lb)
  

CAUTION: 

Use safe practices when lifting. 

 Statement 5: 

  

 

CAUTION: 

The power control button on the device and the power switch on the power 

supply do not turn off the electrical current supplied to the device. The device 

also might have more than one power cord. To remove all electrical current 

from the device, ensure that all power cords are disconnected from the power 

source.

1

2
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Statement 8: 

  

 

CAUTION: 

Never remove the cover on a power supply or any part that has the following 

label attached. 

  

 

Hazardous voltage, current, and energy levels are present inside any 

component that has this label attached. There are no serviceable parts inside 

these components. If you suspect a problem with one of these parts, contact 

a service technician.
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About  this  document  

This document describes procedures for adding new Fibre Channel or SATA hard 

drives or new IBM TotalStorage DS4000 drive expansion enclosures containing new 

Fibre Channel or SATA hard drives to an existing IBM DS4000 Storage Subsystem 

configuration. This document also describes the procedure for migrating either Fibre 

Channel hard drives or IBM TotalStorage DS4000 storage expansion enclosures 

containing Fibre Channel hard drives from one DS4000 storage subsystem to 

another. 

FAStT product renaming 

IBM has renamed some FAStT family products. Table 1 identifies each DS4000 

product name with its corresponding previous FAStT product name. Note that this 

change of product name only indicates no change in functionality or warranty. All 

products listed below with new names are functionally-equivalent and 

fully-interoperable. Each DS4000 product retains full IBM service as outlined in 

service contracts issued for analogous FAStT products. 

 Table 1. Mapping of FAStT names to DS4000 Series names 

Previous FAStT Product Name  Current DS4000 Product Name  

IBM TotalStorage FAStT Storage Server IBM TotalStorage DS4000 

FAStT DS4000 

FAStT Family DS4000 Mid-range Disk System 

FAStT Storage Manager vX.Y (for example 

v9.10) 

DS4000 Storage Manager vX.Y (for example 

v9.10) 

FAStT100 DS4100 

FAStT600 DS4300 

FAStT600 with Turbo Feature DS4300 Turbo 

FAStT700 DS4400 

FAStT900 DS4500 

EXP700 DS4000 EXP700 

EXP710 DS4000 EXP710 

EXP100 DS4000 EXP100 

FAStT FlashCopy FlashCopy for DS4000 

FAStT VolumeCopy VolumeCopy for DS4000 

FAStT Remote Mirror (RM) Enhanced Remote Mirroring for DS4000 

FAStT Synchronous Mirroring Metro Mirroring for DS4000 

Global Copy for DS4000
(New Feature = Asynchronous Mirroring 

without Consistency Group) 

Global Mirroring for DS4000
(New Feature = Asynchronous Mirroring with 

Consistency Group)
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Who should read this document 

This document is intended for system administrators who are familiar with the IBM 

TotalStorage DS4000 storage subsystem components, terminology, and DS4000 

Storage Subsystem administrative tasks. 

Illustrations 

Illustrations contained in this document depict general visual characteristics of the 

DS4000 Storage Subsystem, storage expansion unit, and fibre channel drive 

hardware cited. They are not intended for use as detailed DS4000 storage 

hardware images. 

Using this document 

Before you proceed to complete any storage addition or migration procedures 

detailed in this publication, familiarize yourself with the principles, prerequisite 

instructions at Chapter 2, “Prerequisites to adding capacity and hard drive 

migration,” on page 35, as well as the following storage addition or migration 

procedures applicable to your specific needs. 

v   Chapter 3, “Adding one or more new hard drives,” on page 45 

v   Chapter 4, “Migrating one or more hard drives,” on page 51 

v   Chapter 5, “Adding expansion units containing new hard drives,” on page 59 

v   Chapter 6, “Migrating expansion units containing hard drives,” on page 77 

v   Chapter 7, “Upgrading a storage subsystem in a functioning configuration,” on 

page 93

Your familiarity with the principles, preliminary procedures, and detailed steps 

described in this document is critical to prevent loss of data availability, and in some 

cases, loss of data. If you have questions about the procedures described in this 

document, please contact the IBM Help Center in your geography for assistance. 

Important: 

1.   Do not mix SATA and Fibre Channel drives in the same enclosure. 

2.   Do not place SATA drives in a fibre channel enclosure (DS4300 or EXP710). 

3.   Do not place fibre channel drives in a SATA enclosure (DS4100 or EXP100). 

4.   Do not mix SATA drive expansion enclosures (EXP100) and Fibre channel drive 

enclosures (EXP700, EXP710 and EXP500) in the same drive loop or the same 

DS4000 Storage Subsystem unless you purchase the fibre channel/SATA 

intermix premium feature entitlement and upgrade the controller firmware to 

06.10.11.xx or higher.

DS4000 installation process overview 

The following flow chart gives an overview of the DS4000 hardware and the 

DS4000 Storage Manager software installation process. Lined arrows in the flow 

chart indicate consecutive steps in the hardware and software installation process. 

Labeled arrows indicate which current documents provide detailed information about 

those steps. 
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DS4000 Storage Subsystem publications 

The following tables present an overview of the DS4500, DS4400, DS4300, 

DS4100, and DS4800 Storage Subsystem product libraries, as well as other related 

documents. Each table lists documents that are included in the libraries and what 

common tasks they address. 

You can access the documents listed in these tables at one of the following Web 

sites: 

www.ibm.com/servers/storage/support/disk/ 

www.ibm.com/shop/publications/order/ 

DS4500 Storage Server library 

Table 2 on page xx associates each document in the DS4500 (previously 

FAStT900) Storage Server library with its related common user tasks.

Figure 1. Installation process flow by current publications
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Table 2. TotalStorage DS4500 Fibre Channel Storage Server document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM  TotalStorage 

DS4500 Installation 

and Support Guide, 

GC26-7727 

U U U 

IBM TotalStorage 

DS4500 Fibre 

Channel Cabling 

Instructions, 

GC26-7729 

U U 

IBM TotalStorage 

DS4500 Storage 

Server User’s 

Guide, GC26-7726 

U U U 

IBM TotalStorage 

DS4500 Rack 

Mounting 

Instructions, 

GC26-7728 

U U 
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DS4400 Storage Server library 

Table 3 associates each document in the DS4400 (previously FAStT700) Storage 

Server library with its related common user tasks. 

 Table 3. TotalStorage DS4400 Fibre Channel Storage Server document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM DS4400 Fibre 

Channel Storage 

Server User’s 

Guide, GC26-7730 

U U U U U 

IBM DS4400 Fibre 

Channel Storage 

Server Installation 

and Support Guide, 

GC26-7731 

U U U U 

IBM DS4400 Fibre 

Channel Cabling 

Instructions, 

GC26-7732 

U U 
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DS4300 Storage Server library 

Table 4 associates each document in the DS4300 (previously FAStT600) Storage 

Server library with its related common user tasks.

 Table 4. TotalStorage DS4300 Fibre Channel Storage Server document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4300 Fibre 

Channel Storage 

Server Installation 

and User’s Guide, 

GC26-7722 

U U U 

IBM TotalStorage 

DS4300 Rack 

Mounting 

Instructions, 

GC26-7724 

U U 

IBM TotalStorage 

DS4300 Fibre 

Channel Cabling 

Instructions, 

GC26-7725 

U U 

IBM TotalStorage 

DS4300 SCU  Base 

Upgrade Kit, 

GC26-7740 

U U 

IBM TotalStorage 

DS4300 SCU  Turbo 

Upgrade Kit, 

GC26-7741 

U U 

IBM TotalStorage 

DS4300 Turbo 

Models 6LU/6LX 

Upgrade Kit, 

GC26-7723 

U U 
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DS4100 Storage Server library 

Table 5 associates each document in the DS4100 (previously FAStT100) Storage 

Server library with its related common user tasks.

 Table 5. TotalStorage DS4100 SATA Storage Server document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4100 Installation, 

User’s and 

Maintenance Guide, 

GC26-7733 

U U U U U 

IBM TotalStorage 

DS4100 Fibre 

Channel Cabling 

Instructions, 

24P8973 

U 
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DS4800 Storage Subsystem library 

Table 6 associates each document in the DS4800 Storage Subsystem library with 

its related common user tasks.

 Table 6. TotalStorage DS4800 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4800 Installation, 

User’s and 

Maintenance Guide, 

GC26-7748 

U U U U U 

IBM TotalStorage 

DS4800 Installation 

and Cabling 

Overview, 22R4738 

U 
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DS4000 Storage Manager Version 9 publications 

Table 7 associates each document in the DS4000 Storage Manager (previously 

FAStT Storage Manager) library with its related common user tasks. 

 Table 7. TotalStorage DS4000 Storage Manager Version 9 titles by user tasks 

Title User tasks 

Planning Hardware 

installation 

Software 

installation 

Configuration Operation and 

administration 

Diagnosis and 

maintenance 

IBM TotalStorage 

DS4000 Storage 

Manager Version 9 

Installation and 

Support Guide for 

Windows 

2000/Server 2003, 

NetWare, ESX 

Server, and Linux, 

GC26-7706 

U U U 

IBM TotalStorage 

DS4000 Storage 

Manager Version 9 

Installation and 

Support Guide for 

AIX, UNIX, Solaris 

and Linux on 

POWER,  

GC26-7705 

U U U 

IBM TotalStorage 

DS4000 Storage 

Manager Version 9 

Copy Services 

User’s Guide, 

GC26-7707 

U U U U 

IBM TotalStorage 

DS4000 Storage 

Manager Version 9 

Concepts Guide, 

GC26-7734 

U U U U U U
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Other DS4000 and DS4000-related documents 

Table 8 associates each of the following documents with its related common user 

tasks. 

 Table 8. TotalStorage DS4000 and DS4000–related document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM Safety 

Information, 

33P2406 

U 

IBM TotalStorage 

DS4000 Quick Start 

Guide, GC26-7738 

U U 

IBM TotalStorage 

DS4000 Hardware 

Maintenance 

Manual,GC26-7702 

U 

IBM TotalStorage 

DS4000 Problem 

Determination 

Guide, GC26-7703 

U 

IBM Fibre Channel 

Planning and 

Integration: User’s 

Guide and Service 

Information, 

SC23-4329 

U U U U 

IBM TotalStorage 

DS4000 FC2-133 

Host Bus Adapter 

Installation and 

User’s Guide, 

GC26-7736 

U U 

IBM TotalStorage 

DS4000 FC2-133 

Dual Port Host Bus 

Adapter Installation 

and User’s Guide, 

GC26-7737 

U U 

IBM TotalStorage 

DS4000 Fibre 

Channel and Serial 

ATA Intermix 

Premium Feature 

Installation Overview 

GC26-7713 

U U U U 

Fibre Channel 

Solutions - IBM 

DS4000 EXP500 

Installation and 

User’s Guide, 

59P5637 

U U U U U 

 

xxvi Adding and Migrating Drives and Expansion Enclosures to DS4000 Storage Servers



Table 8. TotalStorage DS4000 and DS4000–related document titles by user tasks (continued) 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4000 EXP700 

and EXP710 

Storage Expansion 

Enclosures 

Installation, User’s, 

and Maintenance 

Guide, GC26-7735 

U U U U U 

IBM TotalStorage 

DS4000 Hard Drive 

and Storage 

Expansion 

Enclosures 

Installation and 

Migration Guide, 

GC26-7704 

U U 

IBM DS4000 

Management Suite 

Java User’s Guide, 

32P0081 

U U 

IBM Netfinity®  Fibre 

Channel Cabling 

Instructions, 

19K0906 

U 

IBM Fibre Channel 

SAN Configuration 

Setup Guide, 

25P2509 

U U U U 

  

How to send your comments 

Your feedback is important to help us provide the highest quality of information. If 

you have any comments about this document, please either fill out the Readers’ 

comments form (RCF) at the back of this document and give it to an IBM 

representative, or submit it in one of the following ways: 

v   E-mail 

–   Submit your comments over the Internet to: 

starpubs@us.ibm.com

–   Submit your comments over IBMLink™ from the U.S.A. to: 

STARPUBS at SJEVM5

–   Submit your comments over IBMLink from Canada to: 

STARPUBS at TORIBM

–   Submit your comments over IBM Mail Exchange to: 

USIB3WD at IBMMAIL

Be sure to include the name and order number of the document and, if 

applicable, the specific location of the text that you are commenting on, such as 

a page or table number. 
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v   Mail 

Complete the Readers’ comments form (RCF) at the back of this document and 

return it by mail. If the RCF Business Reply Mailer has been removed, you can 

address your comments to: 

International Business Machines Corporation 

Information Development 

Dept. GZW 

9000 South Rita Road 

Tucson, Arizona 85744-0001 

U.S.A.
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Chapter  1.  Introduction  

Scalability is a primary attribute of the IBM TotalStorage DS4000 Storage 

Subsystem family. Whenever the need arises, you can expand a DS4000 Storage 

Subsystem from its minimum to its maximum capacity configuration. To expand 

DS4000 Storage Subsystem configurations you can purchase additional equipment 

or, in some cases, migrate equipment from DS4000 Storage Subsystem 

configurations previously deployed. 

The typical DS4000 Storage Subsystem drive connects to both Controller A and 

Controller B. Taken together, these connections represent dual drive loops or a 

redundant drive loop pair. You must connect drive loops in pairs to enable 

redundant drive loop configurations (two data paths per drive enclosure). 

Note:  In the DS4800 Storage Subsystem publications, these redundant drive loop 

pairs are referred to as redundant drive channel pairs. 

Table 9 provides a list of the maximum allowable number of drives and drive loop 

pairs for each DS4000 Storage Subsystem by machine type and model number. It 

also specifies storage expansion enclosure license requirements. 

 Important:  

 Do not intermix fibre channel devices (such as the DS4300 Storage Subsystem and 

EXP500 or EXP710 storage expansion enclosure) and SATA devices (such as the 

DS4100 Storage Subsystem and EXP100 storage expansion enclosure) in the 

same storage subsystem environment unless you purchase the fibre channel/SATA 

intermix premium feature entitlement and upgrade the DS4000 Storage Subsystem 

controller firmware to 06.10.11.xx or higher. See “IBM TotalStorage DS4000 Fibre 

Channel and Serial ATA Intermix Premium Feature” on page 15 for more 

information. 

  Table 9. Maximum allowable drives and drive loop pairs in DS4000 storage servers 

Product name 

Machine 

type 

Model 

number 

Maximum 

number of 

drives 

Maximum 

number of 

drive loop 

pairs 

Storage 

expansion unit 

license 

requirement 

IBM TotalStorage 

DS4100 Storage 

Subsystem (Single 

Controller model) 

1724 1SC 14 0 None. The 

DS4100 Single 

Controller 

Storage 

Subsystem does 

not support 

storage 

expansion 

enclosure 

attachment. 

IBM TotalStorage 

DS4100 Storage 

Subsystem 

1724 100 56 1 None 
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Table 9. Maximum allowable drives and drive loop pairs in DS4000 storage 

servers (continued) 

Product name 

Machine 

type 

Model 

number 

Maximum 

number of 

drives 

Maximum 

number of 

drive loop 

pairs 

Storage 

expansion unit 

license 

requirement 

IBM TotalStorage 

FAStT200 Fibre 

Channel Storage 

Subsystem 

3542 1RU
1RX 

38 1 None 

IBM TotalStorage 

FAStT200 High 

Availability (HA) Fibre 

Channel Storage 

Subsystem1 

2RU
2RX 

66 1 None 

IBM TotalStorage 

FAStT500 Fibre 

Channel Storage 

Subsystem2 

3552 1RU
1RX 

224 2 None 

IBM TotalStorage 

DS4300 Fibre 

Channel Storage 

Subsystem 

1722 60X 

60U 

56 1 Purchase 

storage 

expansion unit 

entitlements in 

increments up to 

three storage 

expansion units 

per DS4300 

Storage 

Subsystem. 

IBM TotalStorage 

DS4300 Fibre 

Channel Storage 

Subsystem (with 

Turbo option) 

112 1 None. The 

DS4300 (with 

Turbo option) 

includes a seven 

storage 

expansion unit 

entitlement. 

IBM TotalStorage 

DS4300 Fibre 

Channel Storage 

Subsystem (Single 

Controller model) 

6LU
6LX 

14 0 None. The 

DS4300 Single 

Controller 

Storage 

Subsystem does 

not support 

storage 

expansion 

enclosure 

attachment. 

IBM TotalStorage 

DS4400 Fibre 

Channel Storage 

Subsystem2 

1742 1RU
1RX 

224 2 None 

IBM TotalStorage 

DS4500 Fibre 

Channel Storage 

Subsystem2 

1742 90X 

90U 

224 2 None 
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Table 9. Maximum allowable drives and drive loop pairs in DS4000 storage 

servers (continued) 

Product name 

Machine 

type 

Model 

number 

Maximum 

number of 

drives 

Maximum 

number of 

drive loop 

pairs 

Storage 

expansion unit 

license 

requirement 

IBM TotalStorage 

DS4800 Fibre 

Channel Storage 

Subsystem2 

1815 82x or 

84x
2 

224 2 None 

Notes:  

1.   The maximum number of drives supported by the FAStT200 HA Storage Subsystem 

(models 2RU and 2RX) assumes attachment to 4 14-drive storage expansion enclosures 

containing 56 fibre channel drives. 

2.   The maximum number of drives supported by FAStT500, DS4400, DS4500, and DS4800 

Storage Subsystems assumes their attachment to 16 14-drive storage expansion 

enclosures.
  

Intermixing storage expansion enclosures 

This section contains information on the following topics: 

v   Intermixing EXP500 and EXP700 storage expansion enclosures 

v   Intermixing EXP700 or EXP100, and EXP710 storage expansion enclosures

For important information about using the Intermix premium feature, including 

configuration and setup requirements, see “IBM TotalStorage DS4000 Fibre 

Channel and Serial ATA Intermix Premium Feature” on page 15. 

For hardware compatibility, ensure that the environmental service module (ESM) 

firmware for each storage expansion enclosure and the storage server controller 

firmware are either at or above the levels that are recommended in Table 22 on 

page 37 and Table 23 on page 38. 

DS4000 Storage Subsystems support the addition of external drive enclosures by: 

v   Providing additional storage capacity (as in the case of DS4400 and DS4500 

Storage Subsystems) 

v   Enabling the expansion of a storage subsystem’s capacity beyond that of a given 

DS4000 Storage Subsystem chassis (as in the case of DS4100 and DS4300 

Storage Subsystems)

When increasing the capacity of your storage subsystem in either of these ways, 

you might choose to add external drive enclosures of the same model and type or 

of different types. IBM does not support the combination of every DS4000 external 

drive enclosure type and model in every DS4000 Storage Subsystem configuration. 

Restrictions on the connection of drive enclosures that differ by model and type to 

DS4000 Storage Subsystems are documented in this section. 

Table 10 on page 4 indicates, by model, which DS4000 expansion enclosures can 

coexist in the same redundant drive loop of a DS4000 Storage Subsystem. 
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Table 10. Mixed DS4000 expansion enclosure compatibility in storage subsystems by model 

DS4000 expansion 

enclosure 

DS4000 

EXP100 (SATA) 

DS4000 

EXP500 (Fibre 

Channel) 

DS4000 

EXP700 (Fibre 

Channel) 

DS4000 

EXP710 (Fibre 

Channel) 

IBM  TotalStorage 

DS4000 EXP100 

(SATA) 

U�1� U�2� U�2� 

IBM  TotalStorage 

DS4000 EXP500 (Fibre 

Channel) 

U�4� 

(1 Gbps only) 

U�3� 

(1 Gbps only) 

IBM  TotalStorage 

DS4000 EXP700 (Fibre 

Channel) 

U�2� U�3� 

(1 Gbps only) 

U�3� U�5� 

IBM  TotalStorage 

DS4000 EXP710 (Fibre 

Channel) 

U�2� U�5� U�5� 

�1�Requires controller firmware 06.10.11.xx or higher (DS4300 with Turbo option, DS4400, 

and DS4500), 06.12.03.xx or higher (DS4300 Base, DS4100 Base) or 06.14.xx.xx (DS4800). 

Note: There are versions of 05.41.xx.xx controller firmware that also provide DS4000 

EXP100 support for DS4300 (with Base or Turbo option), DS4400, and DS4500 Storage 

Subsystems or versions of 05.42.xx.xx xx controller firmware that also provide DS4000 

EXP100 support for DS4100 Storage Subsystems. However, IBM recommends that you use 

controller firmware version 06.12.xx.xx for the DS4100, DS4300 (with Base or Turbo option), 

DS4400, and DS4500 Storage Subsystems, instead. 

�2� Supported only with fibre channel/SATA intermix entitlement purchase and controller 

firmware version 06.10.11.xx or higher. In addition, the storage subsystem must also be in 

the DS4000 Storage Subsystem list that support FC/SATA intermix premium feature. 

�3� Requires controller firmware 05.2x.xx.xx or higher. 

�4� Requires controller firmware 04.xx.xx.xx or higher. 

�5� Requires controller firmware 06.10.11.xx or higher.
  

Table 11 indicates what DS4000 expansion enclosures can attach to DS4000 

Storage Subsystems by model. 

 Table 11. DS4000 expansion enclosure compatibility with DS4000 Storage Subsystems by 

model 

DS4000 storage 

device 

DS4000 

EXP100 (SATA) 

DS4000 

EXP500 (Fibre 

Channel) 

DS4000 EXP700 

(Fibre Channel) 

DS4000 EXP710 

(Fibre Channel) 

DS4100 Storage 

Subsystem (Base 

model, SATA) 

U 

DS4100 Storage 

Subsystem (Single 

Controller model, 

SATA) 

FAStT200 Storage 

Subsystem (Fibre 

Channel) 

U 

(1 Gbps only) 

U 

(1 Gbps only) 
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Table 11. DS4000 expansion enclosure compatibility with DS4000 Storage Subsystems by 

model (continued) 

FAStT500 Storage 

Subsystem (Fibre 

Channel) 

U 

(1 Gbps only) 

U 

(1 Gbps only) 

DS4300 Storage 

Subsystem (Base 

model, Fibre 

Channel) 

U�1� U 

DS4300 Storage 

Subsystem (Single 

Controller model, 

Fibre Channel) 

DS4300 Storage 

Subsystem (Turbo 

option, Fibre 

Channel) 

U�2��3� U�2� U�2��4� 

DS4400 Storage 

Subsystem (Fibre 

Channel) 

U�2��3� U 

(1 Gbps only) 

U�2� U�2��4� 

DS4500 Storage 

Subsystem (Fibre 

Channel) 

U�2��3� U 

(1 Gbps only) 

U�2� U�2��4� 

DS4800 Storage 

Subsystem (Fibre 

Channel) 

U�2��3� U�2��4� 

�1� The DS4300 base will support FC/SATA intermix only when the controller firmware is of 

version 06.12.xx.xx or higher and the fibre channel/SATA intermix entitlement is purchased. 

In addition, although the DS4300 Storage Subsystem (Base model) will support fibre channel 

or SATA drives with controller firmware version 05.41.xx.xx, it will not support both in a mixed 

environment. It will, however, support SATA drives in an attached storage enclosure (only), 

but never in the DS4300 Storage Subsystem, itself. In addition, before the DS4300 Storage 

Subsystem (Base model) will support a DS4000 EXP100 drive enclosure, it is necessary to 

remove all fibre channel drives from the DS4300 chassis. 

�2� The intermix of DS4000 EXP700 and EXP710 fibre channel drive enclosures with 

DS4000 EXP100 SATA drive enclosures in a given DS4000 Storage Subsystem is supported 

only with fibre channel/SATA intermix entitlement purchase and controller firmware version 

06.10.11.xx or higher. The DS4800 Storage Subsystems do not support the attachment of 

EXP700 drive expansion enclosures. You must upgrade the EXP700 drive expansion 

enclosure to EXP710 before attaching to the DS4800 Storage Subsystem. 

�3� DS4000 Storage Subsystems require the following firmware to manage EXP100 

expansion enclosures. 

DS4300 Base or Turbo and DS4500 

Either 05.41.5x.xx or 06.1x.xx.xx. Version 06.12.xx.xx or higher is recommended. 

DS4400 

06.1x.xx.xx. Version 06.12.xx.xx or higher is recommended. 

DS4800 

Version 06.14.xx.xx or higher is recommended.

�4� Requires controller firmware version 06.1x.xx.xx or higher. Version 06.12.xx.xx or higher 

is recommended for DS4300 Base or Turbo, DS4400 and DS4500. For DS4800, version 

06.14.xx.xx or higher is recommended.
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Currently, IBM supports three different storage expansion enclosure models - 

EXP100, EXP700 and EXP710. Table 12 lists those drive expansion enclosure 

models that are considered of the same storage enclosure type for the purpose 

grouping together in an intermixed SATA/fibre channel storage expansion enclosure 

loop configuration. 

 Table 12. DS4000 drive expansion enclosure models compatible in intermixed loop 

configurations only when contiguously grouped 

Group-compatible EXP100 

models 

Group-compatible EXP700 

models 

Group-compatible 

EXP710 models 

1710-10X 1740-1RU 1740-710 

1710-10U 1740-1RX 1740-1RU1 

1724-1XP 1740-1RX1 

1.   Consider and treat this EXP700 model as an EXP710 for grouping purposes only once 

upgraded with the DS4000 EXP700 field upgrade to switched ESMs.
  

You can mix DS4000 TotalStorage EXP500 (which operates only at 1 Gbps) and 

DS4000 TotalStorage EXP700 (which operates at either 1 Gbps or 2 Gbps) storage 

expansion enclosures in the same redundant drive loop pair in all DS4400 and 

DS4500 Storage Subsystem configurations. There is no restriction to the physical 

sequence of mixed EXP700 and EXP500 expansion units in the same redundant 

drive loop pair. You cannot mix these enclosures in the same redundant drive loop 

pair in DS4100, DS4300 and DS4800 Storage Subsystem configurations. 

The DS4100 Storage Subsystems support only the DS4000 EXP100 storage 

expansion enclosures. The DS4300 Storage Subsystems support only 2 Gbps 

storage expansion enclosures, such as the DS4000 EXP700/EXP710 or the 

DS4000 EXP100. The DS4800 Storage Subsystem supports only the DS4000 

EXP710 or the DS4000 EXP100 storage expansion enclosures. See Table 11 on 

page 4. See “Intermixing EXP500 and EXP700 storage expansion enclosures” on 

page 7 for additional information. 

When connecting the DS4000 EXP500 and EXP700 enclosures in the same 

DS4000 Storage Subsystem, although the EXP700 storage expansion enclosure is 

capable of operating at 2 Gbps, you must set the fibre channel speed of drive loops 

in a mixed storage expansion enclosure environment to the lowest fibre channel 

speed supported by all hardware in the loop, which is 1 Gbps. If one of the drive 

loops in a DS4000 Storage Subsystem configuration is set to 1 Gbps, you must set 

all of the drive loops to 1 Gbps. This speed restriction applies to all four drive loops 

in either the DS4400 or DS4500 Storage Subsystem configuration, even where 

some of the drive loops consist only of EXP700 storage expansion enclosures that 

might otherwise operate at 2 Gbps. 

Although you can intermix DS4000 EXP700 storage expansion enclosures and 

DS4000 EXP100 with EXP710 storage expansion enclosures in the same 

redundant drive loop pair in a DS4000 Storage Subsystem configuration, you must 

group together all DS4000 EXP710 storage expansion enclosures in the redundant 

drive loop. See “Intermixing EXP700 or EXP100, and EXP710 storage expansion 

enclosures” on page 9 and Table 12 for additional information. 

Do not intermix DS4000 EXP500 (which operates only at 1 Gbps) and DS4000 

EXP710 or EXP100 (which operate only at 2 Gbps) storage expansion enclosures 

in the same redundant drive loop pair. Also, do not attach these storage expansion 

enclosures to the same controller. 
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Although there are no restrictions against cabling DS4000 EXP100 and DS4000 

EXP700 storage expansion units together. For ease of future maintenance and 

possible troubleshooting, however, IBM recommends that you group or plan your 

configuration to allow for grouping of all DS4000 drive expansion enclosures by 

type in a DS4000 Storage Subsystem redundant drive loop, if possible. 

 Attention:   Even though IBM supports intermixing different drive expansion 

enclosure models in the same redundant drive loop, we recommend use of a single 

drive expansion enclosure model (for example, EXP100, EXP500, EXP700, or 

EXP710) in a given redundant drive loop. This is the best practice. 

 Important:  

 Do not change the speed of a drive loop while the DS4000 Storage Subsystem is 

powered on. Such a speed change will cause unpredictable results. 

 To change the speed of a drive loop: 

__ Step 1.   Prepare applications for DS4000 Storage Subsystem shutdown. 

__ Step 2.   Shutdown the DS4000 Storage Subsystem. 

__ Step 3.   Shutdown the DS4000 storage expansion enclosures. 

__ Step 4.   Change the fibre channel speed settings. 

__ Step 5.   Power on the DS4000 storage expansion enclosures. 

__ Step 6.   Power on the DS4000 Storage Subsystem. 

__ Step 7.   Restore DS4000 Storage Subsystem host application operations.

Note:  For additional information on turning a storage server on and off, see the 

DS4000 Storage Subsystem Installation, User’s, and Maintenance Guide. 

For more information on these guides, see the following Web site: 

www.ibm.com/servers/storage/support/disk/ 

See “DS4000 Storage Subsystem drive loop schemes” on page 21 and “Setting 

enclosure IDs” on page 26 for details on cabling DS4000 Storage Subsystems and 

storage expansion enclosures together as well as setting their enclosure IDs. 

Intermixing EXP500 and EXP700 storage expansion enclosures 

Figure 2 on page 8 illustrates cabling of DS4000 TotalStorage EXP500 and EXP700 

storage expansion enclosures in a mixed configuration.
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There are maximum limits to the number of fibre channel hard drives that you can 

configure in redundant drive loop pairs. The maximum number of drives dictates a 

fixed number of supported EXP500 and EXP700 drive enclosure 

combinations.Table 13 on page 9 lists the numbers of EXP500 and EXP700 storage 

expansion enclosures that you can combine for use in a single redundant drive loop 

pair. Table 13 on page 9 assumes that a DS4000 Storage Subsystem is generally 

capable of addressing the maximum of 112 fibre channel hard drives for each 

redundant drive loop pair. 

 Important:  

 IBM supports only those EXP500 and EXP700 Storage Expansion Unit 

combinations listed in Table 13 on page 9. 

Minihub speed
must be set to
1Gbps for all

four drive
minihubs

Drive loop
A

Drive loop
B

EXP500 and
EXP700 drive
enclosures are

in the same
drive loop

d
s
h

0
0

0
2

4

DS4400 Storage Server

DS4000 EXP700

DS4000 EXP700

DS4000 EXP500

  

Figure 2. DS4000 EXP500 and EXP700 cabling in a mixed configuration
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Table 13. Supported EXP500 and EXP700 combinations per maximum redundant drive loop 

pair drives 

Total number of 

EXP500 enclosures 

per redundant drive 

loop pair 

Total number of 

EXP700 enclosures 

per redundant 

drive loop pair 

Maximum number of 

storage expansion 

units per redundant 

drive loop pair 

Maximum number 

of drives per 

redundant drive 

loop pair 

11 0 11 110 

10 0 10 100 

9 1 10 104 

8 2 10 108 

7 3 10 112 

6 3 9 102 

5 4 9 106 

4 5 9 110 

3 6 9 114 

2 6 8 104 

1 7 8 108 

0 8 8 112
  

Note:  The combination of three EXP500 and six EXP700 storage expansion 

enclosures has the maximum number of 114 drives per redundant drive loop 

pair. You can have this maximum number of hard drives per drive loop pair 

only in this mixed EXP500 and EXP700 configuration. 

Intermixing EXP700 or EXP100, and EXP710 storage expansion 

enclosures 

Attention:  Before intermixing EXP710 and EXP100 drive expansion enclosures in 

a DS4000 Storage Subsystem you must purchase IBM TotalStorage DS4000 SATA 

and fibre channel storage expansion enclosure intermix entitlement and carefully 

read this section. 

It is possible to intermix EXP700 or EXP100, and EXP710 storage expansion 

enclosures in the same drive loop. To do so, however, you must group all of the 

EXP710 storage expansion enclosures together to enable the EXP710 Reliability 

and Serviceability (RAS) features and to optimize the data transfering between the 

EXP710 enclosures. Figure 3 on page 11 through Figure 4 on page 12 illustrate two 

acceptable EXP700 and EXP710 intermixing cabling configurations in which all 

EXP710 storage expansion enclosures are grouped together. Figure 5 on page 13 

shows an acceptable configuration that is not recommended because it could 

present cabling problems later on if you add new EXP710 drive enclosures to a 

redundant drive loop that is already configured. Figure 6 on page 14 and Figure 7 

on page 15 show two unacceptable intermixed configurations in which all EXP710 

storage expansion enclosures are not grouped together. 

These intermixing requirements must also be met if you are upgrading some (but 

not all) of the EXP700 storage expansion enclosures in a drive loop with the 

EXP700 Models 1RU/1RX Switched-ESM Option Upgrade Kit (P/N 25R0166). Once 

upgraded, these EXP700 drive expansion enclosures are considered EXP710 drive 

expansion enclosures, even though the machine type and models might be still be 

shown as EXP700 machine types and models. 
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Important:  

 IBM does not support any configuration in which EXP710 drive expansion 

enclosures are not grouped together. 

 Figure 3 on page 11 though Figure 5 on page 13 show three acceptable EXP700 

and EXP710 intermixing cabling configurations in which all EXP710 storage 

expansion enclosures are grouped together. Note that in Figure 5 on page 13, the 

EXP710 storage expansion enclosures are grouped together, even though the 

EXP700 storage expansion enclosures are not grouped together. 

Although illustrations Figure 3 on page 11 through Figure 7 on page 15 incorporate 

the DS4000 DS4300 Storage Subsystem for the sake of example, other DS4000 

storage servers might be acceptable replacements. The DS4000 EXP100 would 

also intermix successfully with an EXP710 when substituted for an EXP700 in an 

equivalent loop configuration. 
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Figure 3. Acceptable intermixed EXP700 (or EXP100) and EXP710 loop configuration (1 of 3)
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Figure 4. Acceptable intermixed EXP700 (or EXP100) and EXP710 loop configuration (2 of 3)
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In Figure 6 on page 14 and Figure 7 on page 15, the intermixed configurations 

shown are not supported because the EXP710 storage expansion enclosures in the 

redundant drive loop are not grouped together. When substituting a DS4000 

EXP100 for an EXP700 enclosure in an equivalent drive loop cabling configuration, 

the intermixed drive loop cabling is also not supported.
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Figure 5. Acceptable (not recommended) intermixed EXP700 (or EXP100) and EXP710 loop 

configuration (3 of 3)

 

Chapter 1. Introduction 13



d
s
h
0
0
0
1
6

EXP710

EXP700

EXP700

EXP710

Figure 6. Unacceptable intermixed EXP700 (or EXP100) and EXP710 loop configuration (1 of 

2)
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IBM TotalStorage  DS4000 Fibre Channel and Serial ATA  Intermix 

Premium Feature 

Note:  For the most current information on the DS4000 Fibre Channel and SATA 

(FC/SATA) Enclosure Intermix premium feature, see the IBM TotalStorage 

Support Web site: 

http://www-1.ibm.com/servers/storage/support/disk/ 

The DS4000 FC/SATA Intermix premium feature supports the concurrent attachment 

of Fibre Channel and SATA storage expansion enclosures to a single DS4000 

controller configuration. With this premium feature, you can create and manage 

d
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h
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1
7

EXP710

EXP700

EXP710

EXP700

  

Figure 7. Unacceptable intermixed EXP700 (or EXP100) and EXP710 loop configuration (2 of 

2)
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distinct arrays that are built from either Fibre Channel disks or SATA disks and 

allocate logical drives to the appropriate applications using a single DS4000 

Storage Subsystem. 

The TotalStorage DS4500, DS4400, and DS4300 with Standard/Base or Turbo 

options storage subsystems with this premium feature can support the attachment 

of DS4000 EXP700 and EXP710 Fibre Channel Disk Expansion enclosures and 

DS4000 EXP100 Serial ATA Disk Expansion enclosures concurrently. The 

TotalStorage DS4800 with this premium feature supports the attachment of DS4000 

EXP710 Fibre Channel and EXP100 SATA drive expansion enclosures concurrently. 

Please contact IBM for information regarding future DS4000 Storage Subsystem 

support. 

The FC/SATA Intermix premium feature requires that you upgrade the DS4500, 

DS4400, or DS4300 Turbo storage subsystems to DS4000 Storage Manager 

version 9.10 or later (controller firmware level 6.10.10.xx or later) in the upgrade 

sequence in these instructions. The DS4800 is shipped with controller firmware 

version 06.14.xx.xx or later and the required DS4000 Storage Manager version 9.14 

or later, so no upgrades would be required for the DS4800. 

The FC/SATA Intermix Option installation kit includes the following items: 

v   The IBM TotalStorage DS4000 Fibre Channel and Serial ATA Intermix Premium 

Feature Installation Overview 

v   The DS4000 FC/SATA Intermix premium feature entitlement document 

v   The DS4000 FC/SATA Intermix premium feature activation document, which 

includes the feature activation code and the instructions about how to generate 

the key file 

v   The DS4000 Storage Subsystem NVSRAM Support for DS4000 FC/SATA 

Enclosure Intermix CD

Note:  The NVSRAM file in this CD is for the DS4000 Storage Subsystems with 

controller firmware version 06.10.xx.xx only. Do not use this NVSRAM file 

if the DS4000 Storage Subsystems have controller firmware version 

06.12.xx.xx or later installed. Use the NVSRAM files that are packaged 

with the version 06.12.xx.xx or later DS4000 Storage Subsystem controller 

firmware packages instead.

The FC/SATA  Intermix premium feature installation 

To use the FC/SATA Intermix premium feature upgrade, perform the following steps: 

1.   Purchase an IBM TotalStorage DS4000 Fibre Channel/SATA Intermix 

entitlement. Contact your IBM reseller or representative for additional 

information. 

2.   Upgrade your DS4000 ESM firmware to the level that is compatible with each 

particular enclosure type. 

 Attention:  You should perform any ESM code upgrades that are required 

before you perform any other code upgrades. 

Table 14 on page 17 indicates which ESM firmware levels are compatible with 

each enclosure type. 
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Table 14. ESM firmware levels by storage expansion enclosure type 

Storage expansion enclosure type ESM firmware level 

DS4000 EXP100 9554 (See note a below) 

DS4000 EXP700 9326 or later (See notes b and c below) 

DS4000 EXP710 9627 or later (See note d below)
  

Notes:  

a.   You must upgrade the EXP100 ESM firmware to version 9554 first on those 

DS4000 Storage Subsystems on which the controller firmware version 

05.41.1x.xx is installed. The EXP100 ESM firmware cannot be upgraded to 

version 9554 on those DS4000 Storage Subsystems on which other 

versions of controller firmware are installed. 

b.   You must upgrade the EXP700 ESM firmware to version 9326 or later 

before you upgrade the DS4000 Storage Subsystem controller firmware to 

version 06.1x.xx.xx. 

c.   The DS4800 Storage Subsystem does not support DS4000 EXP700 drive 

expansion enclosures. 

d.   The EXP710 ESM firmware must be at version 9629 or later for DS4800 

configurations.

3.   If necessary, upgrade your host software to DS4000 Storage Manager version 

9.10 or later. You can download upgrades for the applicable DS4000 storage 

subsystem over the Internet from the IBM DS4000 Storage Manager Support 

Web site. Refer to the Storage Manager Installation and Support Guide for your 

operating system. 

4.   Upgrade your DS4000 Storage Subsystem controller firmware to version 

06.10.10.xx or later to use with DS4000 Storage Manager host software version 

9.10 or later. IBM recommends the controller firmware version 06.12.xx.xx and 

later for the DS4300, DS4400 and DS4500 Storage Subsystems and 

06.14.xx.xx and later for DS4800 Storage Subsystems. For more information, 

refer to the IBM DS4000 Storage Manager Installation and Support Guide for 

the appropriate operating system of the host computer on which the DS4000 

Storage Manager host software will be installed or upgraded. 

The latest versions of the DS4000 Storage Subsystem controller firmware and 

the host software are available for download over the Internet from the DS4000 

TotalStorage Support Web page: 

www.ibm.com/servers/storage/support/disk/ 

5.   Upgrade your DS4000 storage subsystem controller NVSRAM to the 

appropriate version of NVSRAM files based on the controller firmware version 

as indicated below. 

 Attention:  To verify the DS4000 Storage Subsystem controller firmware 

version, right-click the controller icon in the Subsystem Management window of 

the DS4000 Storage Subsystem that you are working on. Select Properties in 

the pull-down list and, when the Properties window opens, look for the value on 

the right of the Firmware Version field.

If  the installed controller firmware is of version 06.10.xx.xx 

To implement the FC/SATA Intermix feature, download the appropriate 

NVSRAM file from the DS4000 Storage Subsystem NVSRAM Support 

for DS4000 FC/SATA Enclosure Intermix CD that is associated with your 

host operating system. The filenames of the NVSRAM files that enable 

the FC/SATA intermix premium feature have an “I” character prefix, for 
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example, I1742F900R910V04.dlp. The appropriate NVSRAM file for a 

given storage subsystem can be found in one of the following 

directories: 

v   \NVSRAM\DS4300_FAStT600turbo 

v   \NVSRAM\DS4400_FAStT700 

v   \NVSRAM\DS4500_FAStT900

Notes:  

a.   The controller firmware of the DS4300 Storage Subsystem with 

Standard/Base option must be at 06.12.xx.xx or later in order to 

support the DS4000 FC/SATA Intermix premium feature. 

b.   The DS4800 Storage Subsystems are released with controller 

firmware version 06.14.xx.xx. There are no previous versions of 

controller firmware for it.

If the installed controller firmware is of version 06.12.xx.xx or later 

Attention:  Do not use the NVSRAM file in the DS4000 Storage 

Subsystem NVSRAM Support for DS4000 FC/SATA Enclosure Intermix 

CD. Install the appropriate NVRAM for your DS4000 Storage 

Subsystem that is packaged with the controller firmware that you 

installed in the DS4000 Storage Subsystem in step 4 on page 17 

above. 

The DS4000 FC/SATA Intermix premium feature is entitled and requires 

the use of a feature key to enable the option. To obtain the feature key 

identifier, you need a feature activation code, which is printed on the 

IBM premium feature activation card. You also need your controller unit 

IBM serial number, which is printed on the label on the back of your 

DS4000 Storage Subsystem. Follow the instructions in the FC/SATA 

intermix premium feature activation card for instructions about how to 

generate the required feature key and enable the FC/SATA intermix 

premium feature.

 Attention:  

 For DS4000 Storage Subsystems with controller firmware version 06.10.xx.xx 

installed, the FC/SATA Intermix premium feature is activated when you download 

the NVSRAM file. Nonetheless, you MUST generate the premium feature key and 

retain it because you will need it to activate the FC/SATA Intermix premium feature 

when the controller firmware is upgraded to version 06.12.xx.xx or higher. 

If you try to use the premium feature activation key with controller firmware version 

06.10.xx.xx, you will get an error message that the Premium Feature that you are 

attempting to enable with this feature key file is not supported on the current 

configuration of this subsystem. 

For the DS4000 Storage Subsystems with the controller firmware version 

06.12.xx.xx or later installed, you must generate the premium feature key file to 

enable the FC/SATA intermix feature. You cannot use the NVSRAM files included in 

the DS4000 FC/SATA Enclosure Intermix CD. 

 For more information about how to enable the premium feature or the feature key, 

read the activation instructions or contact your IBM representative. 
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Restrictions 

Important:  When you add drive expansion enclosures of different types, if the 

grouping of the enclosure types forces the new enclosures to be cabled 

in the middle of the drive loop, it is strongly recommended that you 

power down the configuration or schedule your installations during 

offpeak I/O periods. You can use the performance monitor function in 

the DS4000 Storage Manager Subsystem Management window to 

determine offpeak I/O periods. 

If you cannot power down the configuration to install a new enclosure in 

the middle of the loop, you must use the DS40000 Storage Manager 

Subsystem Management window to verify that the interrupted drive loop 

is up and optimal before you modify the other drive loop. This 

minimizes the chance that arrays will fail because of cabling errors. 

Therefore, it is also important to plan for additions to the configuration 

prior to your initial installation. It is also best practice to take these 

same precautions when you add new enclosures to either end of the 

redundant drive loop. 

The following restrictions apply to the use of the DS4000 FC/SATA Intermix 

premium feature: 

Compatible storage subsystems 

Only the following DS4000 Storage Subsystems support the FC/SATA 

Intermix premium feature: 

v   DS4300 Standard/Base or Turbo 

v   DS4400 

v   DS4500 

v   DS4800

Contact IBM for information regarding future DS4000 Storage Subsystem 

support.

Grouping DS4000 storage expansion enclosures in a redundant drive loop 

 Attention: 

 Configurations that do not follow the DS4000 storage expansion enclosures 

grouping restriction are not supported. 

 You must group like DS4000 storage expansion enclosure types in adjacent 

positions on the Fibre Channel loop when they are intermixed in a DS4000 

Storage Subsystem redundant drive loop configuration. Figure 8 on page 20 

shows two ways to group your expansion enclosures.

 

Chapter 1. Introduction 19

|

|
|
|
|
|
|
|

|
|
|
|
|

|
|
|
|

|
|

|
|
|

|

|

|

|

|
|

|

|

|
|

|
|
|
|



EXP100 EXP710

EXP100 EXP100

EXP710 EXP700

EXP710 EXP100

EXP700 EXP710

EXP700 EXP700

d
s
h
0
0
0
3
0

Correct Intermix Configuration
(note expansion unit type)

Incorrect Intermix Configuration
(note expansion unit type)

You must group like enclosure types together, regardless of type, as the 

configuration on the left shows. In the configuration on the left, the 

EXP700s are grouped together at the top of the loop, followed by the 

EXP710s, which are grouped together at the middle of the loop, followed by 

the EXP100s which are grouped together closest to the controller. The 

storage expansion enclosure types are indicated in the expansion unit types 

indicated in the lower right corner of each enclosure. 

 In the configuration on the right, the enclosures are cabled in a random 

order and are not grouped by type. IBM does not support DS4000 storage 

subsystem configurations when they are cabled in this way.

Note:  For the purposes of the storage expansion enclosures grouping 

restriction, note the following considerations: 

v   All models of the EXP100 are considered to be the same from a 

grouping perspective. For example, the EXP100 1710-10X, 

1710-10U, and the 1724-1XP are considered like enclosure types 

and must be grouped together. 

Figure 8. Correct and incorrect ways to group DS4000 storage expansion enclosures in a 

redundant drive loop
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v   All models of the EXP700 are considered to be the same from a 

grouping perspective. For example, the EXP700 1740-1RU, and 

the 1740-1RX are considered like enclosure types and must be 

grouped together. 

v   Once the EXP700 has been upgraded with the EXP710 ESM 

firmware, it is considered an EXP710, regardless of the machine 

type and model.

Cannot mix drive types  

Arrays must consist exclusively of either Fibre Channel or SATA drives. You 

cannot mix drive types in an array. 

 You cannot mix Fibre Channel and SATA drives in the same DS4000 

Storage Subsystem or storage expansion enclosure. Table 15 lists the drive 

types and their corresponding DS4000 Storage Subsystems and storage 

expansion enclosures. 

  Table 15. Drive types and their corresponding DS4000 Storage Subsystem and storage 

expansion enclosures 

Drive type Storage subsystem type Storage expansion 

enclosure type 

SATA DS4100 DS4000 EXP100 

Fibre Channel DS4300 Standard/Base
 or Turbo 

DS4400 

DS4500 

DS4800 

DS4000 EXP700 

DS4000 EXP710 

  

Cannot intermix drive types for hot spares 

SATA drives can function as hot spares for SATA drives only. 

 Fibre Channel drives can function as hot spares for Fibre Channel drives 

only. 

DS4300 Standard/Base or Turbo intermix configuration restrictions 

In DS4300 intermix configurations, if the FC/SATA Intermix premium feature 

is enabled along with the correct NVSRAM for Intermix is installed, the 

maximum number of expansion enclosures in a drive loop is limited to 

seven, regardless of whether there are drives in the DS4300 Storage 

Subsystem drive slots.

DS4000 Storage Subsystem drive loop schemes 

Although a variety of cable loop schemes might function acceptably, IBM 

recommends consistent use of only one such scheme when connecting DS4000 

Storage Subsystems and expansion enclosures. Figure 9 on page 22 illustrates the 

only cable loop scheme that IBM recommends when connecting DS4000 Storage 

Subsystems and expansion enclosures.
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Legend: 

�1� Integrated drive/controller DS4000 Storage Subsystem (for example, 

DS4300 or DS4100) 

�2� Controller only DS4000 Storage Subsystem (for example, DS4400 or 

DS4500)

IBM recommends against inconsistent use of any cable loop scheme. Even though 

cable loop schemes illustrated in Figure 10 on page 23 and Figure 11 on page 24 

are acceptable when connecting DS4000 Storage Subsystems and expansion 

enclosures, IBM recommends against their use because they are not standardized 

for IBM DS4000 Support. 

 Attention:   Do not make the cable schemes illustrated in Figure 12 on page 25 

or Figure 13 on page 26 because they will affect the diagnostic ability in the event 

of drive loop failures. 

IBM recommends against inconsistent use of any cable loop scheme. IBM also 

recommends against the use of the cable loop schemes shown in the following 

illustrations when connecting DS4000 Storage Subsystems and expansion 

enclosures because they are not standardized for IBM DS4000 Support. 
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1 2

  

Figure 9. Recommended cable loop scheme for connecting DS4000 storage devices

 

22 Adding and Migrating Drives and Expansion Enclosures to DS4000 Storage Servers



Legend: 

�1� Integrated drive/controller DS4000 Storage Subsystem (for example, 

DS4300 or DS4100) 

�2� Controller only DS4000 Storage Subsystem (for example, DS4400 or 

DS4500)
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Figure 10. Possible (but not recommended) alternate cable loop scheme for when connecting 

DS4000 storage devices
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Legend: 

�1� Integrated drive/controller DS4000 Storage Subsystem (for example, 

DS4300 or DS4100) 

�2� Controller only DS4000 Storage Subsystem (for example, DS4400 or 

DS4500)
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Figure 11. Possible (but not recommended) alternate cable loop scheme for connecting 

DS4000 storage devices
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Legend: 

�1� Integrated drive/controller DS4000 Storage Subsystem (for example, 

DS4300 or DS4100) 

�2� Controller only DS4000 Storage Subsystem (for example, DS4400 or 

DS4500)
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Figure 12. Unacceptable cable loop scheme for connecting DS4000 storage devices
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Legend: 

�1� Integrated drive/controller DS4000 Storage Subsystem (for example, 

DS4300 or DS4100) 

�2� Controller only DS4000 Storage Subsystem (for example, DS4400 or 

DS4500)

Setting enclosure IDs 

Each drive enclosure in a DS4000 Storage Subsystem drive loop must have a 

unique drive enclosure ID. DS4000 controllers use a combination of the enclosure 

ID and the number of the physical slot that a hard drive occupies to create a unique 

loop address or arbitrated loop physical address (AL_PA) for each drive in a drive 

loop. The enclosure ID consists of two digits, a tens (x10) digit and a ones (x1) 

digit. The possible values for the tens and the ones digits are 0-9 for FAStT500 

drive enclosures, and 0-7 for DS4400 drive enclosures. 

It is recommended as best practice that you give each drive expansion enclosure in 

a redundant drive loop a unique ones digit ID. This setting will enforce hard AL_PAs 

(unchangeable between Loop Initializations [LIPs]) for the drives and facilitate drive 

loop problem troubleshooting in the event of an error. If the ones digits are not 

unique, two or more devices will have the same hard AL_PA. In such a case, the 

controller will use soft AL_PAs for the devices that have identical hard AL_PAs. 

The problem with soft addressing is that addresses can change between LIPs. This 

possibility increases the difficulty of troubleshooting drive loop problems because it 

is difficult to ascertain whether the same device with a different address or a 
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1 2

  

Figure 13. Unacceptable cable loop scheme for connecting DS4000 storage devices
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different device might be causing a problem. Because the DS4000 Storage 

Subsystem can support more enclosures than available values of the enclosure ID 

ones digit, Table 16 through Table 20 on page 30 suggest enclosure ID settings for 

various drive expansion enclosure families to minimize soft addressing in a drive 

loop. 

 Table 16. EXP500 Storage Expansion Enclosure ID settings 

Storage expansion enclosure 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop if 

applicable/supported 

1st unit 

(storage expansion enclosure 

or storage server with internal 

drive slots) 

00 x0 

(where x is 2-7) 

2nd unit 

(EXP500) 

01 x1 

(where x is 2-7) 

3rd unit 

(EXP500) 

02 x2 

(where x is 2-7) 

4th unit 

(EXP500) 

03 x3 

(where x is 2-7) 

5th unit 

(EXP500) 

04 x4 

(where x is 2-7) 

6th unit 

(EXP500) 

05 x5 

(where x is 2-7) 

7th unit 

(EXP500) 

06 x6 

(where x is 2-7) 

8th unit 

(EXP500) 

07 x7 

(where x is 2-7) 

9th unit 

(EXP500) 

08 x8 

(where x is 2-7) 

10th unit 

(EXP500) 

09 x9 

(where x is 2-7) 

11th unit 

(EXP500) 

10 x0 

(where x is 3-7)
  

Note:  Drives in the 11th enclosures of each drive loop in Table 16 will have soft 

AL_PAs. 

Table 17 suggests enclosure ID settings that minimize soft addressing for EXP100 

storage expansion enclosures in a drive loop. 

 Table 17. EXP100 Storage Expansion Enclosure ID settings 

Storage expansion enclosure 

(unmixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop if 

applicable/supported 

1st unit 

(EXP100 Expansion Enclosure 

or DS4000 Storage Subsystem 

with internal drive slots) 

00 x0 

(where x is 2-7) 
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Table 17. EXP100 Storage Expansion Enclosure ID settings (continued) 

Storage expansion enclosure 

(unmixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop if 

applicable/supported 

2nd unit 

(EXP100) 

01 x1 

(where x is 2-7) 

3rd unit 

(EXP100) 

02 x2 

(where x is 2-7) 

4th unit 

(EXP100) 

03 x3 

(where x is 2-7) 

5th unit 

(EXP100) 

04 x4 

(where x is 2-7) 

6th unit 

(EXP100) 

05 x5 

(where x is 2-7) 

7th unit 

(EXP100) 

06 x6 

(where x is 2-7) 

8th unit 

(EXP100) 

07 x7 

(where x is 2-7) 

9th unit 

(EXP100, where the first unit is 

a DS4300 only) 

11 

  

Note:  All drives in drive loops described in Table 17 on page 27 will be assigned 

hard AL_PAs. 

Table 18 suggests enclosure ID settings that minimize soft addressing for EXP700 

or EXP710 storage expansion enclosures in a drive loop. 

 Table 18. EXP700 or EXP710 Storage Expansion Enclosure ID settings 

Storage expansion enclosure 

(unmixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop if 

applicable/supported 

1st unit 

(storage expansion enclosure 

or DS4000 Storage Subsystem 

with internal drive slots) 

00 x0 

(where x is 2-7) 

2nd unit 

(EXP700) 

01 x1 

(where x is 2-7) 

3rd unit 

(EXP700) 

02 x2 

(where x is 2-7) 

4th unit 

(EXP700) 

03 x3 

(where x is 2-7) 

5th unit 

(EXP700) 

04 x4 

(where x is 2-7) 

6th unit 

(EXP700) 

05 x5 

(where x is 2-7) 

7th unit 

(EXP700) 

06 x6 

(where x is 2-7) 
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Table 18. EXP700 or EXP710 Storage Expansion Enclosure ID settings (continued) 

Storage expansion enclosure 

(unmixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop if 

applicable/supported 

8th unit 

(EXP700) 

07 x7 

(where x is 2-7)
  

Note:  All drives in drive loops described in Table 18 on page 28 will be assigned 

hard AL_PAs. 

Table 19 suggests enclosure ID settings that minimize soft addressing for the 

EXP500 and EXP700 Storage Expansion Enclosure when intermixed in a redundant 

drive loop. 

 Table 19. Intermixed EXP500 and EXP700 Storage Expansion Enclosure ID settings 

Storage expansion enclosure 

models (intermixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop 

1st unit 

(storage expansion enclosure 

or DS4000 Storage Subsystem 

with internal drive slots) 

00 x0 

(where x is 2-7) 

2nd unit 

(EXP500 or EXP700) 

01 x1 

(where x is 2-7) 

3rd unit 

(EXP500 or EXP700) 

02 x2 

(where x is 2-7) 

4th unit 

(EXP500 or EXP700) 

03 x3 

(where x is 2-7) 

5th unit 

(EXP500 or EXP700) 

04 x4 

(where x is 2-7) 

6th unit 

(EXP500 or EXP700) 

05 x5 

(where x is 2-7) 

7th unit 

(EXP500 or EXP700) 

06 x6 

(where x is 2-7) 

8th unit 

(EXP500 or EXP700) 

07 x7 

(where x is 2-7) 

9th unit 

(EXP500 or EXP700) 

10 x0 

(where x is 2-7) 

10th unit 

(EXP500 or EXP700) 

11 x1 

(where x is 2-7)
  

Note:  The drives in the 9th and 10th enclosures in each drive loop described in 

Table 19 will have soft AL_PAs. 

Table 20 on page 30 suggests enclosure ID settings that minimize soft addressing 

for the EXP700 and EXP710 Storage Expansion Enclosure when intermixed in a 

redundant drive loop. 
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Table 20. Intermixed EXP700 and EXP710 Storage Expansion Enclosure ID settings 

Storage expansion enclosure 

models (intermixed) 

Enclosure ID setting for 

enclosure in the first 

redundant drive loop 

Enclosure ID setting for 

enclosure in the second 

redundant drive loop 

1st unit 

(storage expansion enclosure 

or DS4000 Storage Subsystem 

with internal slots) 

00 x0 

(where x is 2-7) 

2nd unit 

(EXP700 or EXP710) 

01 x1 

(where x is 2-7) 

3rd unit 

(EXP700 or EXP710) 

02 x2 

(where x is 2-7) 

4th unit 

(EXP700 or EXP710) 

03 x3 

(where x is 2-7) 

5th unit 

(EXP700 or EXP710) 

04 x4 

(where x is 2-7) 

6th unit 

(EXP700 or EXP710) 

05 x5 

(where x is 2-7) 

7th unit 

(EXP700 or EXP710) 

06 x6 

(where x is 2-7) 

8th unit 

(EXP700 or EXP710) 

07 x7 

(where x is 2-7)
  

Note:  The drives in the 9th and 10th enclosures in each drive loop described in 

Table 20 will have soft AL_PAs. 

Determining firmware levels 

There are two different methods to determine DS4000 Storage Subsystem, 

expansion unit, drive, and ESM firmware versions. Each method uses the DS4000 

Storage Manager client that manages the DS4000 storage subsystem with the 

attached expansion unit. 

Method one: 

For controllers with firmware version 6.1x.xx.xx or later, go to the Subsystem 

Management window and select Storage Subsystem → View Profile. For 

controllers with firmware version 5.xx.xx.xx.xx or earlier select View → Storage 

Subsystem Profile. When, under either circumstance, the Storage Subsystem 

Profile window opens, select the All tab and scroll through the Profile For Storage 

Subsystem to locate the following information.

Note:  The Profile For Storage Subsystem contains all the profile information for 

the entire subsystem. Therefore, it might be necessary to scroll through a 

large amount of information to locate the firmware version numbers.

DS4000 Storage Subsystem 

v   NVSRAM version 

v   Appware version (Appware is a reference to controller firmware). 

v   Bootware version (Bootware is a reference to controller firmware.)
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See the following example or snapshot of profile information. 

 Controller in Enclosure 0, Slot A 

Status: Online 

Current configuration 

Firmware version: 06.10.07.00 

Appware version: 06.10.07.00 

Bootware version: 06.10.07.00 

NVSRAM version: 1722F600R910V05 

  

Drives 

v   Firmware version

ESM 

v   ESM card firmware version

Method two: 

Select the appropriate procedure from the following options and complete it to 

obtain the specified firmware version. 

To obtain the controller firmware version: 

Right click the Controller icon in the Physical View pane of the Subsystem 

Management window and select Properties. The Controller Enclosure 

properties window opens and displays the properties for that controller. 

 You must perform this step for each individual controller. 

To obtain the drive firmware version: 

Right Click the Drive icon in the Physical View pane of the Subsystem 

Management window and select Properties. The Drive Properties window 

opens and displays the properties for that drive. 

 You must perform this step for each individual drive. 

To obtain the ESM firmware version: 

1.   In the Physical View pane of the Subsystem Management window, click 

the Drive Enclosure Component icon (which is the icon furthest to the 

right). The Drive Enclosure Component Information window opens. 

2.   Click the ESM icon in the left pane. The ESM information displays in the 

right pane of the Drive Enclosure Component Information window. 

3.   Locate the firmware version of each ESM in the drive enclosure.

To  obtain the drive enclosure component firmware version: 

1.   Click the Drive Enclosure Component icon (the icon located furthest to 

the right) in the Drive Enclosure frame in the Physical View pane of the 

Subsystem Management window. The Drive Enclosure Component 

Information window opens. 

2.   Click the ESM icon in the left pane. The ESM information displays in the 

right pane of the Drive Enclosure Component Information window. 

3.   Locate the firmware version of each ESM in the drive enclosure. 

You must perform this step for each drive expansion enclosure.
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Determining the product ID and model of a drive 

You can determine the product ID and model of a drive from the storage server 

profile through the menu option in the DS4000 Subsystem Management window. To 

get the profile, in the DS4000 Subsystem Management window, either click View → 

Storage Subsystem Profile (if the controller firmware version is 05.xx.xx, or 

earlier) or Storage Subsystem → View Profile (if the controller firmware version is 

06.xx.xx, or later). When the Storage Subsystem Profile window displays, click on 

the Drives tab and scroll down to the information about the drive which product ID 

and model you want to verify. See Table 21 for a sample profile indicating the 

product ID of the drive in slot 1 of enclosure ID 1 as ST3146807FC. 

 Table 21. Snapshot of profile information identifying the product ID of the drive in slot 1 of 

enclosure ID 1 as ST3146807FC 

HOT SPARE COVERAGE: 

 The following arrays are not protected: 1, 2 

  

 Total hot spare drives: 0 

  Standby: 0 

  In use: 0 

  

DETAILS: 

 Drive at Enclosure 1, Slot 1 

  Drive port: 1, Channel: 1; ID: 8/0xD9 

  Drive port: 2, Channel: 2; ID: 8/0xD9 

  Drive path redundancy: OK 

  Status: Optimal 

  Raw capacity: 136.732 GB 

  Usable capacity: 136.732 GB 

  Current data rate: 2 Gbps 

  Product ID: ST3146807FC        !# 

  Firmware version: B350 

  Serial number: 3HY062YK00007309FAT1 

  Vendor: IBM-ESXS 

  Date of manufacture: May 29, 2002 

  World-wide name: 20:00:00:04:cf:56:43:fb 

  Drive type: fibre channel 

  Speed: 10033 RPM 

  Mode: Assigned 

  Associated array: 1 

  

 Drive at Enclosure 1, Slot 2 

  Drive port: 1, Channel: 2; ID: 9/0xD9 

  Drive port: 2, Channel: 1; ID: 9/0xD9 

  Drive path redundancy: OK 

  Status: Optimal 

  Raw capacity: 136.732 GB 

  Usable capacity: 136.732 GB 

  Current data rate: 2 Gbps 

  

 

  

DS4000 Storage Manager installation and support guides 

This publication frequently cites IBM TotalStorage DS4000 Storage Manager 

installation and support guides supporting various versions and operating system 

environments. There are currently two, namely: 

v   IBM TotalStorage DS4000 Storage Manager Installation and Support Guide for 

AIX, HP-UX, Solaris and Linux on Power 
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v   IBM TotalStorage DS4000 Storage Manager Installation and Support Guide for 

Intel-based Operating System Environments

Visit the following Web site to access documentation related to your particular 

operating system and DS4000 Storage Manager version. 

www.ibm.com/servers/storage/support/disk/ 

See “DS4000 Storage Subsystem publications” on page xix for more information. 
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Chapter  2.  Prerequisites  to adding  capacity  and  hard  drive  

migration  

Perform the preliminary steps detailed in this chapter before you add storage 

capacity or migrate hard drives. After you meet these prerequisite requirements, 

proceed to any of the following sections to address your particular storage hardware 

addition or migration requirements: 

v   Chapter 3, “Adding one or more new hard drives,” on page 45 

v   Chapter 5, “Adding expansion units containing new hard drives,” on page 59 

v   Chapter 4, “Migrating one or more hard drives,” on page 51 

v   Chapter 6, “Migrating expansion units containing hard drives,” on page 77 

v   Chapter 7, “Upgrading a storage subsystem in a functioning configuration,” on 

page 93

Failure to perform the steps listed in this section might result in loss of data 

availability, and in some cases, loss of data. Perform the following steps on the 

DS4000 Storage Subsystem to which you will migrate or add new hard drives: 

__ Step 1.   Complete a full backup of all data residing on the DS4000 Storage 

Subsystem. 

__ Step 2.   Verify that the backup was successful. 

__ Step 3.   Verify that the DS4000 Storage Subsystem has the latest controller 

firmware, non-volatile storage random access memory (NVSRAM), and 

ESM firmware. 

 Attention:  If your DS4000 Storage Subsystem has controller firmware 

version 04.01.02.29 or lower, download and install controller firmware 

version 4.01.02.33 or higher before you download and install controller 

firmware version 5.30.xx.xx or higher. There are certain minimum 

controller firmware version requirements associated with various drive 

expansion enclosures. See Table 10 on page 4 and Table 11 on page 4 

for related information. 

__ Step 4.   Verify that the drive firmware is at the latest level. If it is not, see 

“Upgrading drive firmware levels” on page 39. 

__ Step 5.   Verify that the DS4000 Storage Subsystem to which you will migrate the 

hard drives is in optimal state. If it is not, perform the appropriate steps 

listed in the Recovery Guru to bring the storage subsystem into optimal 

state. 

__ Step 6.   Use the Read_Link_Status function of the Storage Manager client 

program and the DS4000 Storage Subsystem management event log 

(MEL) to verify that the drive loops are in optimal state. If the DS4000 

storage subsystem controller firmware is version 06.10.xx.xx or higher, 

use the drive channel diagnostics to determine if the drive loop is 

optimal. 

__ Step 7.   Investigate and resolve any errors that reported in the DS4000 Storage 

Subsystem MEL. 

__ Step 8.   Save and store the storage subsystem profile of the DS4000 Storage 

Subsystem. 

__ Step 9.   It is necessary to purchase the fibre channel/SATA intermix premium 

feature option and follow the associated instructions to activate the fibre 

channel/SATA premium feature.
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Important:  

 Do not store DS4000 Storage Subsystem profiles in the same location as the 

logical drives defined on your DS4000 Storage Subsystem. Should you do so, and 

a RAID array failure occurs during subsequent migration, the data will be lost. 

 If you are migrating drives from another DS4000 Storage Subsystem, you must also 

perform the preceding steps 1 on page 35 through 8 on page 35 on the DS4000 

Storage Subsystem from which you intend to migrate hard drives. You must also 

perform the following steps to flush server-cached I/O to disks. 

__ Step 1.   Stop all programs, services or processes in the host servers that 

access the logical drives defined in the migrated hard drives. 

__ Step 2.   Verify that there are no programs, services, or processes running in the 

background that might write data to the logical drives. (For example, 

Microsoft® MSCS service periodically writes to the “Quorum” disk.) 

__ Step 3.   Unmount the file systems to flush I/O from the server cache to disk. 

Notes:  

a.   In a Microsoft Windows® environment, it is also necessary for you to 

remove the drive letter or the mount points of the mapped LUNs 

instead of unmounting the file systems. 

b.   Consult documentation associated with your particular operating 

system for detailed information regarding the unmount procedure.

After you meet prerequisites described in this section, proceed to any of the 

following sections to address your particular drive migration requirements. 

v   Chapter 3, “Adding one or more new hard drives,” on page 45 

v   Chapter 5, “Adding expansion units containing new hard drives,” on page 59 

v   Chapter 4, “Migrating one or more hard drives,” on page 51 

v   Chapter 6, “Migrating expansion units containing hard drives,” on page 77 

v   Chapter 7, “Upgrading a storage subsystem in a functioning configuration,” on 

page 93

Verifying controller, NVSRAM, and ESM firmware file levels 

The controller firmware and NVSRAM of the DS4000 Storage Subsystem to which 

you will migrate hard drives, and the ESM firmware in the DS4000 storage 

expansion enclosures must be at the levels indicated in Table 22 on page 37 to 

ensure firmware compatibility between the migrating and original hardware. 

Additionally, DS4000 Storage Manager version 8.3 or higher client software, in 

conjunction with the controller firmware level 5.30.xx.xx or higher, allows you to 

upgrade the ESM firmware while the storage subsystem receives I/O from the host 

server. 

Note:  Always check the readme document included with the DS4000 Storage 

Subsystem controller firmware package for any ″no I/Os″ requirement during 

the controller firmware download. Certain controller firmware upgrade 

scenarios may require that you first quiesce host I/Os. 

Tip: Even though you can upgrade the DS4000 Storage Subsystem and ESM 

firmware while it processes I/O from the host server, schedule upgrades to occur 

during time periods of low I/O between the DS4000 Storage Subsystems and host 

servers. 
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Table 22 lists IBM DS4000 machine types and model numbers, as well as their 

current firmware (AppWare or BootWare) and NVSRAM versions. 

 Table 22. Compatible controller firmware and NVSRAM version by machine type and model 

number 

Product 

name/model 

Machine 

type 

Model 

number 

Firmware version 

(AppWare / 

BootWare) NVSRAM  version 

IBM TotalStorage 

DS4100 Storage 

Subsystem (Single 

Controller model) 

1724 1SC 05.42.18.00 N1724F10LR842V01 

IBM TotalStorage 

DS4100 Storage 

Subsystem 

1724 100 06.12.03.xx N1724F100R912V05 

IBM TotalStorage 

FAStT200 Fibre 

Channel Storage 

Subsystem 

3542 1RU 

1RX 

05.30.23.00 N3542-1RUR830V09 

IBM TotalStorage 

FAStT200 HA Fibre 

Channel Storage 

Subsystem 

2RU
2RX 

05.30.23.00 N3542-2RUR830V12 

IBM TotalStorage 

FAStT500 Fibre 

Channel Storage 

Subsystem 

3552 1RU 

1RX 

05.30.23.00 

(Appware) 

05.30.03.00 

(Bootware) 

N3552F500R830V05 

IBM TotalStorage 

DS4300 Fibre 

Channel Storage 

Subsystem 

1722 60X 

60U 

06.12.03.xx N1722F600R834V01 

IBM TotalStorage 

DS4300 Fibre 

Channel Storage 

Subsystem (with 

Turbo option) 

06.12.03.xx N1722F600R910V03 

IBM TotalStorage 

DS4300 Fibre 

Channel Storage 

Subsystem (Single 

Controller model) 

6LU 

6LX 

05.34.08.00 N1722F60LR834V04 

IBM TotalStorage 

DS4400 Fibre 

Channel Storage 

Subsystem 

1742 1RU 

1RX 

06.12.03.00 

(Appware)
06.10.04.00 

(Bootware) 

N1742F700R912V05 

IBM TotalStorage 

DS4500 Fibre 

Channel Storage 

Subsystem 

1742 90X 

90U 

06.12.03.00 

(Appware)
06.10.04.00 

(Bootware) 

N1742F900R912V06 

IBM TotalStorage 

DS4800 Fibre 

Channel Storage 

Subsystem 

1815 82x 

84x 

06.14.1x.xx N1815D480R914V05
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Note:  Visit the following Web site either to verify software version levels or to 

identify possible interim updates to firmware and NVSRAM file versions 

described in Table 22 on page 37. 

www-1.ibm.com/servers/storage/support/disk/ 

 Update the DS4000 controller firmware and NVSRAM to the levels indicated in 

Table 22 on page 37 (or higher) before you upgrade the ESM firmware on the 

storage expansion enclosures to versions indicated in Table 23. 

Table 23 lists IBM DS4000 storage expansion enclosure models by name, machine 

type, model number, and current ESM firmware version. 

 Table 23. Compatible expansion unit ESM firmware version by machine type and model 

number 

DS4000 Storage Expansion Unit 

product name/model 

Machine 

type 

Model 

number 

ESM firmware 

version 

IBM TotalStorage DS4000 EXP100 1710 10U 9554 

IBM TotalStorage DS4000 EXP500 3560 1RU
1RX 

9166 

IBM TotalStorage DS4000 EXP700 1740 1RU
1RX 

9327 

IBM TotalStorage DS4000 EXP710 1740 710 9629
  

Perform the following steps to upgrade ESM firmware for a down-level controller: 

__ Step 1.   Upgrade the DS4000 Storage Manager software to the latest version. 

That is DS4000 Storage Manager version 9.1x. For additional 

information, see the IBM TotalStorage DS4000 Storage Manager 

installation and support guide for the appropriate server operating 

system environment at: 

www-1.ibm.com/servers/storage/support/disk/

Note:  To ensure the highest level of software compatibility, update the 

host server’s multi-path software (Redundant Disk Array 

Controller [RDAC], IBMSAN.CDM, or Linux® failover adapter 

driver) to the level that is either supported by or released with 

the controller firmware that you intend to download. See the 

following Web site for current details on software compatibility: 

www-1.ibm.com/support/docview.wss?uid=psg1MIGR-50176 

__ Step 2.   Upgrade the controller firmware and NVSRAM. See Table 22 on page 

37 and the web site listed earlier in conjunction with step1. 

Note:  See the readme file in the DS4000 Storage Manager controller 

firmware package associated with the appropriate host operating 

system environment for a support statement about the 

concurrent controller firmware download (that is, downloading 

code to the DS4000 Storage Subsystem while it is processing 

I/O from the host server). 

__ Step 3.   Upgrade the storage expansion enclosure ESM firmware. With DS4000 

Storage Manager version 8.3 or higher and controller firmware version 

05.3x.xx.xx or higher, you can update the ESM firmware while the 

DS4000 Storage Subsystem is processing I/O from the host server if 
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the ESM firmware download is performed to only one storage 

expansion enclosure at a time. If you select multiple entries in the ESM 

firmware download window for ESM firmware download, you must 

quiesce I/Os from the host servers before starting the ESM firmware 

download process. 

 Important: 

 Even though the DS4000 Storage Subsystem supports controller and 

ESM firmware upgrade while the DS4000 Storage Subsystem 

processes I/O from the host server, schedule controller and ESM 

firmware upgrades to occur during time periods of low I/O between the 

DS4000 Storage Subsystems and host servers.

Upgrading drive firmware levels 

Attention:  1 Gbps fibre channel drives will not operate correctly in a 2 Gbps fibre 

channel drive loop. Always make certain that a fibre channel drive can operate at 

the fibre channel speed of the drive loop involved before inserting it into the drive 

slots in a DS4000 Storage Subsystem configuration. In needed, contact IBM 

support to ensure the compatibility of your drives before migrating them from one 

DS4000 configuration to another. 

Before you begin migration, upgrade the drive firmware to the latest level. Do not 

move or migrate fibre channel drives from a 1 Gbps fibre channel environment to a 

2 Gbps fibre channel environment unless you have installed the latest firmware 

documented to enable their operation in a 2 Gbps fibre channel environment. 

Downloading drive firmware 

 

Important: 

The following procedures assume you using controller firmware at version 

6.10.xx.xx or later. If you are using an earlier version refer to the following IBM 

web site for the appropriate firmware version documentation:

www.ibm.com/servers/storage/support/disk/ 

 This section provides instructions for downloading DS4000 drive firmware. See the 

online help for additional information. 

Important: 

1.   IBM supports firmware download with I/O, sometimes referred to as ″concurrent 

firmware download″. This feature is not supported for drive firmware. 

2.   Before starting the drive firmware download process: 

v   Stop all I/O activity before downloading drive firmware to a DS4000 Storage 

Server. 

v   Unmount the file systems on all logical drives accessing the drives that you 

select for firmware upgrade. 

v   Complete a full backup of all data residing on the drives that you select for 

firmware upgrade.

Downloading Storage Manager version 9.1x drive firmware 

To download drive firmware for DS4000 Storage Manager version 9.1x, perform the 

following steps: 

 1.   From the Enterprise Management window, select a storage subsystem. 
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2.   On the Enterprise Management window’s menu bar, click Tools → Manage 

Device. The Subsystem Management window opens. 

 3.   On the Subsystem Management window’s menu bar, click Advanced → 

Maintenance → Download → Drive Firmware/Mode pages .... The Download 

Drive Firmware wizard window opens to the Introduction page. Read the 

instructions displayed and click Next.

Note:  Storage Manager version 9.1x offers you the option to download and 

update up to four different firmware file types simultaneously. Previous 

Storage Manager versions did not offer this capability. 

 4.   Click Browse to locate the server directory that contains the firmware that you 

plan to download. 

 5.   Select the firmware file that you plan to download and click OK. The file 

appears listed in the ″Selected Packages″ window pane. 

 6.   Select the firmware file for any additional drive types that you intend to 

download and click OK. Additional files appear listed in the ″Selected 

Packages″ window pane. A maximum total of four drive types are possible. 

 7.   Click Browse to repeat step 6 until you have selected each firmware file that 

you plan to download. 

 8.   When you have finished specifying the firmware packages for download, select 

Next. 

 9.   The Select Drive window opens, containing two tabs, a Compatible Drives tab 

and an Incompatible Drives tab. The Compatible Drives tab contains a list 

of the drives compatible to the firmware package types that you selected. From 

that list, select the drives to which you plan to download the drive firmware that 

you selected in steps 6 and 7. 

Note:  The firmware that you propose to download should be listed on the 

Compatible Drives tab. If your particular drives’ product ID matches 

the firmware type, however, and it is not listed as compatible on the tab, 

contact your IBM technical support representative for additional 

instructions. 

10.   Select the Compatible Drives tab. 

Press and hold the Ctrl key while using your mouse to select multiple drives 

individually, or press and hold the shift key while using your mouse to select 

multiple drives listed in series. The compatible firmware that you selected in 

steps 5 and 6 will download to the drives that you select. 

11.   Click Finish to initiate download of the drive firmware to each compatible drive 

that you selected in step 9. 

12.   The Download Drive Firmware warning opens and prompts: ″Do you want to 

continue?″ Type yes and click OK to start the drive firmware download. 

13.   The Download Progress window opens. Do not intervene until the download 

process completes. 

14.   Every drive scheduled for firmware download will be designated as in 

progress until successful or failed.

Note:  Complete the following two steps if you receive a failure. 

a.   Click the Save as button to save the error log. 

b.   On the Subsystem Management window’s menu bar, click 

Advanced →Trouble Shooting → Open Event Log and complete 

the following tasks necessary to save the storage subsystem event 
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log before contacting your IBM Service Representative and 

proceeding to step 16. 

1)   Click the Select all button. 

2)   Click Save the Storage Subsystem Event Log.

15.   When the Close button appears active, the drive firmware download process is 

complete. 

16.   Click Close to exit the Download Progress window. 

17.   Use either of the following procedures to determine or verify what level of drive 

firmware resides on a particular drive: 

v   Right-click on that drive in the Logical/Physical View in the Subsystem 

Management window and click Properties. The associated drive firmware 

version will be listed in the drive properties table. 

v   Right-click on Storage Subsystem → View Profile in the Logical/Physical 

View of the Subsystem Management window.

Downloading Storage Manager version 8.x drive firmware 

To download drive firmware for DS4000 Storage Manager version 8.x, perform the 

following steps: 

 1.   From the Enterprise Management window, select a storage subsystem. 

 2.   Click Tools → Manage Device. The Subsystem Management window opens. 

 3.   Click Advanced → Download → Drive Firmware. The Download Drive 

Firmware window opens. It presents a list of all installed drives. 

 4.   From the list of all installed drives, select the drive to which you plan to 

download drive firmware. 

Press and hold the Ctrl key while using your mouse to select multiple drives 

singly, or press and hold the shift key while selecting multiple drives in series 

by using your mouse pointer. 

 5.   Click Browse to identify the directory that contains the drive firmware that you 

intend to download. 

 6.   Select the file containing the drive firmware that you intend to download. 

 7.   Select Start. The Confirm Download window appears. 

 8.   Type yes when the Confirm Download window prompts: Are you sure you 

want to continue? 

 9.   The download begins and the Status window indicates progress. Do not 

intervene until the download process completes. 

10.   When the Cancel button appears active, the download process is complete. 

Press Cancel to close the Status window. 

11.   To determine or verify the level of drive firmware residing on a particular drive, 

click View → Subsystem Profile in the Logical/Physical View of the Subsystem 

Management window.

Bringing storage subsystems and drive loops into optimal state 

Note:  For additional information on how to make this determination, see the 

DS4000 Problem Determination Guide associated with your particular 

DS4000 hardware model. 

After you have updated or verified that a DS4000 Storage Subsystem is using the 

latest firmware and NVSRAM: 
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__ Step 1.   Bring the DS4000 Storage Subsystem to its optimal state before 

reconfiguring it with new hardware. 

__ Step 2.   Use the DS4000 Storage Manager client program to display the status 

of the DS4000 Storage Subsystem and to correct any problems that 

might cause the DS4000 Storage Subsystem to enter its Needs 

Attention state. 

__ Step 3.   Verify that all indicator lights on the storage subsystem are in their 

optimal state. 

__ Step 4.   In addition, use the Read_Link_Status function of the DS4000 Storage 

Manager client program and the DS4000 Storage Subsystem MEL to 

verify that all components in the drive loop are in their optimal states 

(that is, there are no drive loop component errors in the event log and 

no errors in the Read_Link_Status window.) If you are using controller 

firmware 06.10.xx.xx, use the drive channel diagnostics to determine if 

the drive loop is optimal. See the DS4000 Storage Manager Client 

program Subsystem Management window Online help for more 

information on the RLS and drive channel diagnostics if they are 

supported by the installed version of your controller firmware. 

Drive channel diagnostics are only available if you are using controller 

firmware version 06.10.xx.xx. 

__ Step 5.   If the arrays are in degraded state due to a failed drive, correct the 

problem before migration.

If necessary, contact the IBM Help Center in your geography for assistance with 

event log interpretation. 

It is necessary for certain tasks to complete before proceeding to add drives or 

enclosures. Before you add drives or enclosures, verify that the storage subsystem 

involved is not performing any of the following tasks. 

v   Dynamic logical drive capacity expansion (dynamic volume expansion [DVE] or 

dynamic capacity expansion [DCE]) 

v   Logical drive segment size modification 

v   Array RAID-level modification 

v   User-initiated array redundancy checking (menu option Array → Check 

Redundancy in the Subsystem Management window) 

v   Remote mirror logical drive synchronization 

v   FlashCopy® or VolumeCopy logical drive creation 

v   Logical drive reconstruction or copyback. This action is sometimes referred to as 

logical drive sparing.

Saving the storage subsystem profile 

Use the DS4000 Storage Manager client program to save a DS4000 Storage 

Subsystem profile. Such a profile is necessary to restore a storage subsystem 

configuration in the event of a catastrophic failure. Migration from one DS4000 

Storage Subsystem configuration to another will require that you save both DS4000 

Storage Subsystem configuration profiles involved. For details on this procedure, 

see one of the following: 

v   DS4000 Storage Manager client program Client Subsystem Management window 

online help 

v   IBM TotalStorage DS4000 Storage Manager installation and support guide 

associated with your particular operating system environment located at: 

www-1.ibm.com/servers/storage/support/disk/ 
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v   Saving a module profile report and state capture information to help prevent data 

loss located at: 

www-3.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-4VVPEF
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Important:  

 Do not store DS4000 Storage Subsystem profiles in the same location as the 

logical drives defined on your DS4000 Storage Subsystem. Should you do so, and 

a RAID array failure occurs during subsequent migration, the data will be lost. 

Handling static-sensitive devices 

Attention:  Static electricity can damage electronic devices and your system. To 

avoid damage, keep static-sensitive devices in their static-protective packages until 

you are ready to install them. 

To reduce the possibility of electrostatic discharge (ESD), observe the following 

precautions: 

v   Limit your movement. Movement can cause static electricity to build up around 

you. 

v   Handle the device carefully, holding it by its edges or its frame. 

v   Do not touch solder joints, pins, or exposed printed circuitry. 

v   Do not leave the device where others can handle and possibly damage the 

device. 

v   While the device is still in its static-protective package, touch it to an unpainted 

metal part of the system unit for at least two seconds. This drains static electricity 

from the package and from your body. 

v   Remove the device from its package and install it directly into your system unit 

without setting it down. If it is necessary to set the device down, place it in its 

static-protective package. Do not place the device on your system unit cover or 

on a metal table. Take additional care when handling devices during cold weather 

because heating reduces indoor humidity and increases static electricity.
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Chapter  3.  Adding  one  or more  new  hard  drives  

While adding a hard drive to either a controller or a drive expansion enclosure, 

observe these important rules: 

v   Observe proper electrostatic discharge (ESD) procedures when handling 

electronic equipment. See “Handling static-sensitive devices” on page 44 for 

additional information. 

v   Never alter the physical configuration of a DS4000 Storage Subsystem while it is 

powered off unless you are instructed to do so as part of a DS4000 configuration 

procedure. Specifically, never attach storage components to, or remove storage 

components from, a configured DS4000 Storage Subsystem while it is powered 

off. 

v   Any hard drive, whether new or old, might contain configuration data. Unless you 

intend to migrate a drive from another DS4000 Storage Subsystem (retaining its 

configuration data), always use the following procedure to add one or more hard 

drives to a functioning DS4000 Storage Subsystem configuration. 

v   The following DS4000 Storage Subsystem devices support only 2 Gbps fibre 

channel hard drives: 

–   DS4000 EXP700 storage expansion units 

–   DS4000 EXP710 storage expansion units 

–   DS4300 storage servers

v    1 Gbps fibre channel drives will not work properly when you insert them into the 

drive slots of the aforementioned DS4000 storage devices.

 Attention:  Always make certain that a fibre channel drive can operate at the 

fibre channel speed of the drive loop involved before inserting it into the drive 

slots in a DS4000 Storage Subsystem configuration. In needed, contact IBM 

support to ensure the compatibility of your drives before migrating them from one 

DS4000 configuration to another. 

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine 

its ID or Model Number. Hard drives with ID or Model Number values that end 

with “04FC” or “03FC” are 1 Gbps fibre channel drives. For example, 

“ST173404FC”, “ST318203FC” and “ST136403FC” are model numbers that 

appear on several 1 Gbps fibre channel hard drives. 1 Gbps fibre channel drives 

can also be mounted in a tray with the front bezel that is about .75″ wider than 

the 2 Gbps drive tray bezel. 

You can also obtain the drive product model and ID through the DS4000 Storage 

Subsystem profile. For information on how to do so, see “Determining the 

product ID and model of a drive” on page 32. 

v   Do not mix SATA and fibre channel drives or enclosures together in the same 

drive loop behind a DS4000 storage subsystem unless the FC/SATA intermix 

premium feature is purchased and the DS4000 Storage Subsystem is in the 

storage subsystem list that support FC/SATA intermix feature. 

v   Do not install SATA drives in fibre channel drive expansion enclosures. 

v   Do not install fibre channel drives in SATA drive expansion enclosures.

The following procedure outlines the steps necessary to add one or more new hard 

drives to empty drive slots in either DS4100, FAStT200, or DS4300 controllers or in 

EXP100, EXP500, EXP700, or EXP710 storage expansion enclosures. If you plan 

to add a used drive, ensure that there is no configuration data on the drive that you 

need to preserve. Add drives to a DS4000 Storage Subsystem only while it is 

powered on and in optimal state. See the DS4000 Problem Determination Guide 
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associated with your particular DS4000 hardware model or “Bringing storage 

subsystems and drive loops into optimal state” on page 41 for additional information 

on how to make this determination. 

Activity 1: Disabling the drive migration settings 

Important: Unless you have already done so, please review the information in 

Chapter 1 and perform the prerequisites described in Chapter 2 before performing 

the activities described in this chapter. 

Before you add drives to the subsystem, perform this activity to remove any 

configuration data that they might contain. 

__ Step 1.   Open the Storage Manager client program’s Enterprise Management 

window. 

__ Step 2.   Right-click on the name of the DS4000 Storage Subsystem to which 

you intend to add drives and click Execute Script. 

__ Step 3.   A script editor window opens. Click File → Load Script. 

__ Step 4.   A Load Script file selection window opens. Locate and select the file 

named DisableDriveMigration.scr and click OK. The 

DisableDriveMigration.scr file is normally located in the SCRIPTS 

directory of the IBM DS4000 Storage Manager Installation Compact 

Disc (CD). Use this file to reset the DS4000 storage subsystem setting 

to ignore configuration data that might reside on newly discovered hard 

drives. Figure 15 on page 49 provides a listing of the 

DisableDriveMigration.scr file. 

__ Step 5.   Click Tools → Verify and Execute to run the script. 

__ Step 6.   When the script completes execution, reset both DS4000 controllers to 

enable the DS4000 drive migration setting. 

If you used the DisableDriveMigration.scr script associated with this 

document and described in Figure 14 on page 48, it is not necessary 

for you to perform this step because the last two commands in that 

script file automatically reset the controllers. 

To reset the controllers, open the Storage Subsystem Management 

window and sequentially (one at a time) reset each controller by clicking 

Advanced → Reset Controller. Then, follow the instructions in the 

Reset Controller window when it opens.

Activity 2: Inserting drives 

__ Step 1.   Insert drives as pairs (two at a time) into the empty drive slots. 

__ Step 2.   Wait (up to five minutes) until each drive pair has fully spun up and 

displayed in the DS4000 Storage Subsystem Management window 

before inserting the next drive pair.

Activity 3: Re-enabling the drive migration settings 

Perform this activity to re-enable the drive migration settings if you performed 

“Activity 1: Disabling the drive migration settings” to disable DS4000 storage 

subsystem drive migration settings. If you do not, whenever you might 

subsequently, even momentarily remove a drive from the storage subsystem for any 

reason, its configuration data will be cleared. When the storage subsystem next 

recognizes such a drive, it will display it as unconfigured. 

 

46 Adding and Migrating Drives and Expansion Enclosures to DS4000 Storage Servers

|
|
|



Attention: In order to prevent data loss, set the DS4000 Storage Subsystem drive 

migration to enable after you complete the hard drive addition process. 

__ Step 1.   Open the Storage Manager client program Enterprise Management 

window. 

__ Step 2.   Right-click on the name of the DS4000 Storage Subsystem to which 

you want to add drives and click Execute Script. 

__ Step 3.   A script editor window opens. Click File → Load Script. 

__ Step 4.   A Load Script file selection window opens. Locate, and select the file 

named EnableDriveMigration.scr and click OK. The file 

EnableDriveMigration.scr is normally located in the SCRIPTS directory of 

the IBM DS4000 Storage Manager Installation CD. Use this file to reset 

the DS4000 Storage Subsystem setting in order to check for 

configuration data that might reside on newly discovered hard drives. 

Figure 14 on page 48 provides a listing of the EnableDriveMigration.scr 

file. 

__ Step 5.   Click Tools → Verify and Execute to run the script. 

__ Step 6.   When the script completes execution, reset both DS4000 controllers to 

enable the DS4000 drive migration setting. 

If you use the EnableDriveMigration.scr script associated with this 

document and described in Figure 14 on page 48, it is not necessary 

for you to perform this step because the last two commands in that 

script file automatically reset the controllers. 

To reset the controllers, open the Storage Subsystem Management 

window and sequentially (one at a time) reset each controller by clicking 

Advanced → Reset Controller, and then following the instructions in 

the Reset Controller window when it opens. 

Result: The newly added drives are ready for you to configure and map 

to host servers.

The next two figures list the EnableDriveMigration.scr and DisableDriveMigration.scr 

files. 
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// Name: Enable Drive Migration 

// 

// Date: 05-08-2004 

// Revision: 1.3 

// Comments: 

// This script is intended to work with controllers at Firmware 05.30.xx.xx and 

// higher only. 

// 

// This script returned the FAStT to it’s default operation of importing 

// configuration informration from disks. 

// 

// This script will reboot both controllers in the FAStT unit. If your 

// hosts are configured for multi-path support, this can be done with I/O 

// running to the controllers. If your hosts are not configured for 

// redundant access you must schedule downtime before running this 

// script. 

// 

// See the directions at the bottom of this script if you do not have multi 

// path software installed and wish to prevent the controller restarts 

// 

// Show the current state of Drive Migration 

show "Showing the current state of Drive Migration (80=Off, 82=On)"; 

show controller[a] nvsrambyte[0x35]; 

show controller[b] nvsrambyte[0x35]; 

// 

// Setting Drive Migration to Enable 

show "Setting Drive Migration to Enable"; 

set controller[a] nvsrambyte[0x35] = 0x02,0x00; 

set controller[b] nvsrambyte[0x35] = 0x02,0x00; 

show controller[a] nvsrambyte[0x35]; 

show controller[b] nvsrambyte[0x35]; 

// 

// Reset Controllers to make changes active. Note: 

// To prevent the controllers from restarting, add ’//’ to the beginning 

// of each of the lines below. This will comment out the restart of the 

// controllers. Important: The controllers will have to be restarted for the 

// changes in this script to take effect. 

// 

show "Resetting controller A"; 

reset Controller [a]; 

show "Resetting controller B"; 

reset Controller [b]; 

show "Drive Migration is now enabled."; 

  

Figure 14. EnableDriveMigration.scr file listing
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// Name: Disable Drive Migration 

// 

// Date: 05-08-2004 

// Revision: 1.3 

// Comments: 

// This script is intended to work with controllers at Firmware 05.30.xx.xx and 

// higher only. 

// This script allows the addition of disk drives while the system is running 

// and by clearing the configuration of any drives as unused capacity 

// regardless of past configuration of these drives. 

// 

// Attention: This setting should not be left active after the new disks have 

// been added to the subsystem. Leaving this setting active could 

// cause the configuration for the FAStT to be lost if the FAStT is 

// power cycled incorrectly. Please run the EnableDriveMigration.scr 

// after all the disks are added. 

// 

// 

// This script will reboot both controllers in the FAStT unit. If your 

// hosts are configured for multi-path support, this can be done with I/O 

// running to the controllers. If your hosts are not configured for 

// redundant access you much schedule downtime before running this 

// script. 

// 

// Show the current state of Drive Migration 

show "Showing the current state of Drive Migration (80=Off, 82=On)"; 

show controller[a] nvsrambyte[0x35]; 

show controller[b] nvsrambyte[0x35]; 

// 

// Setting Drive Migration to Disable 

show "Setting Drive Migration to Disable"; 

set controller[a] nvsrambyte[0x35] = 0x02,0x02; 

set controller[b] nvsrambyte[0x35] = 0x02,0x02; 

show controller[a] nvsrambyte[0x35]; 

show controller[b] nvsrambyte[0x35]; 

// 

// Reset Controllers to make changes active 

// To prevent the controllers from restarting, add ’//’ to the beginning 

// of each of the lines below. This will comment out the restart of the 

// controllers. Important: The controllers will have to be restarted for 

// the changes in this script to take effect. 

show "Resetting controller A"; 

reset Controller [a]; 

show "Resetting controller B"; 

reset Controller [b]; 

// 

show "Drive Migration is now disabled. Add the new drives to the subsystem,"; 

show "then execute the EnableDriveMigrationScript.scr to re-enable drive "; 

show "migration."; 

  

Figure 15. DisableDriveMigration.scr file listing
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Chapter  4.  Migrating  one  or more  hard  drives  

Note:  When migrating hard drives from multiple DS4000 storage servers to a 

single DS4000 Storage Subsystem, move all of the hard drives from the first 

DS4000 Storage Subsystem as an independent "set" to the destination 

DS4000 Storage Subsystem. Before moving hard drives as a set from 

subsequent DS4000 Storage Subsystem, ensure that all of the hard drives 

from the previous set have been successfully transferred to the destination 

DS4000 Storage Subsystem. If you do not transfer hard drives as "sets" to 

the destination DS4000 Storage Subsystem, the newly relocated 

arrays/logical drives that are defined in these drives might not appear in the 

Subsystem Management window. 

While migrating a hard drive to either a controller or a drive expansion enclosure, 

observe these important rules: 

v   Observe proper ESD procedures when handling electronic equipment. See 

“Handling static-sensitive devices” on page 44 for additional information. 

v   Never alter the physical configuration of a DS4000 Storage Subsystem while it is 

powered off unless you are instructed to do so as part of DS4000 configuration 

procedure. Specifically, never attach storage components to or remove storage 

components from a configured DS4000 Storage Subsystem while it is powered 

off. 

v   Any hard drive, whether new or old, might contain configuration data. Use this 

procedure to preserve the configuration and user data in one or more hard drives 

that you will migrate to a functioning DS4000 Storage Subsystem configuration. 

Do not use this procedure if you are unsure of the quality of the data on the hard 

drives. 

v   The following DS4000 Storage Subsystem devices support only 2 Gbps fibre 

channel hard drives: 

–   DS4000 EXP700 storage expansion units 

–   DS4000 EXP710 storage expansion units 

–   DS4300 storage servers

v    1 Gbps fibre channel drives will not work properly when you insert them into the 

drive slots of the aforementioned DS4000 storage devices.

 Attention:  Always make certain that a fibre channel drive can operate at the 

fibre channel speed of the drive loop involved before inserting it into the drive 

slots in a DS4000 Storage Subsystem configuration. In needed, contact IBM 

support to ensure the compatibility of your drives before migrating them from one 

DS4000 configuration to another. 

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine 

its ID or Model Number. Hard drives with ID or Model Number values that end 

with “04FC” or “03FC” are 1 Gbps fibre channel drives. For example, 

“ST173404FC”, “ST318203FC” and “ST136403FC” are model numbers that 

appear on several 1 Gbps fibre channel hard drives. 1 Gbps fibre channel drives 

might also be mounted in a tray with the front bezel that is about .75″ wider than 

the 2 Gbps drive tray bezel. 

You can also obtain the drive product model and ID through the DS4000 Storage 

Subsystem profile. For information on how to do so, see “Determining the 

product ID and model of a drive” on page 32. 

v   Do not mix SATA and fibre channel drives or enclosures together in the same 

drive loop behind a DS4000 Storage Subsystem unless the FC/SATA intermix 
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premium feature is purchased and the DS4000 Storage Subsystem is in the 

storage subsystem list that support FC/SATA intermix feature. 

v   Do not install SATA drives in fibre channel drive expansion enclosures. 

v   Do not install fibre channel drives in SATA drive expansion enclosures

Activity 1: Preliminary activities 

The following procedure describes the steps that you must perform to migrate one 

or more drives from a functioning DS4000 Storage Subsystem configuration to 

another DS4000 Storage Subsystem configuration. Drives described in the following 

steps are those that contain configuration data that you want to preserve. Add such 

drives to a DS4000 Storage Subsystem only while it is powered on and in its 

optimal state. See the DS4000 Problem Determination Guide associated with your 

particular DS4000 hardware model or “Bringing storage subsystems and drive loops 

into optimal state” on page 41 for additional information on how to assess the state 

of a DS4000 Storage Subsystem. 

 Important:  

 Before you attempt to complete the drive migration procedure, review the 

information provided in Chapter 1 and perform the steps documented in Chapter 2, 

“Prerequisites to adding capacity and hard drive migration,” on page 35. 

 The procedure for migrating hard drives that contain configuration data that you 

want to preserve is as follows: 

Before you remove drives from a functioning DS4000 Storage Subsystem, perform 

the following steps to ensure that you successfully migrate the drives to the 

destination DS4000 Storage Subsystem. 

__ Step  1.   Perform a backup of the logical drives defined in the hard drives that 

you plan to migrate. 

__ Step  2.   Stop all programs, services or processes in the host servers that 

access the logical drives defined in the migrated hard drives. Ensure 

that there are not any running background programs, services or 

processes that write data to the logical drives. (For example, the 

Microsoft MSCS service periodically writes to the “Quorum” disk.) 

__ Step  3.   Unmount the file systems to flush I/O from the server cache to disks. 

Notes:  

a.   In a Microsoft Windows environment, remove the drive letter or the 

mount points of the mapped LUNs instead of unmounting the file 

systems. 

b.   Refer to the documentation associated with your particular 

operating system for detailed information regarding the Unmount 

procedure.

__ Step  4.   Verify that the DS4000 Storage Subsystem controller and NVSRAM of 

both the source and destination systems are at or above levels 

described in Table 22 on page 37. 

__ Step  5.   Verify that the names of the logical drives that are associated with 

hard drives on both the source and destination systems are unique. If 

they are not, make the necessary changes. 

__ Step  6.   In addition to array configuration information, any storage partitioning 

configuration data that may reside on drives you plan to migrate will 

migrate with those drives when installed on another DS4000 Storage 
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Subsystem. For this reason, take the following precautions to facilitate 

the migration process and prevent problems in storage partitioning 

configuration data migration. 

a.   If a DS4000 storage partitioning premium feature has been 

enabled both on a drive’s original and destination DS4000 storage 

servers, assure that the defined host ports, hosts, and host group 

names are unique to each DS4000 Storage Subsystem involved in 

the migration. 

b.   If you must use identical names on both DS4000 Storage 

Subsystems, make the names unique before you perform the drive 

migration. 

If necessary, customize the storage partitioning information on the 

DS4000 Storage Subsystem to which you have migrated the drives 

after you complete the migration. 

__ Step  7.   Delete any flashcopies of the logical drives defined on the drives that 

you plan to migrate. 

__ Step  8.   Remove any remote mirror relationships using the logical drives 

defined on the drives that you plan to migrate. 

__ Step  9.   Ensure that the arrays and logical drives are in optimal state before 

starting the migration process. See the DS4000 Problem 

Determination Guide associated with your particular DS4000 hardware 

model or “Bringing storage subsystems and drive loops into optimal 

state” on page 41 for additional information on how to make this 

determination. 

__ Step 10.   Place the arrays defined in the hard drives that you plan to migrate in 

offline state. To do so, right-click on the name of the array in the 

Storage Subsystem Management window and click Place → Offline. 

__ Step 11.   If you migrate drive expansion enclosures from a 1 Gbps fibre channel 

environment to a 2 Gbps fibre channel environment, verify that the 

fibre channel hard drives that you plan to migrate are each capable of 

2 Gbps operation and that you have installed the latest firmware 

enabling them to work properly in a 2 Gbps fibre channel environment. 

__ Step 12.   Save the DS4000 Storage Subsystem profile of the functioning 

DS4000 Storage Subsystem configuration to which the migration will 

occur in a location other than that of the logical drives you plan to 

migrate. 

__ Step 13.   If you migrate the drives to a single controller DS4000 Storage 

Subsystem (for example, DS4300 Storage Subsystem, model 6LU or 

6LX), change the logical drive’s preferred owner to Controller A using 

the DS4000 Storage Manager client program before taking it offline 

and removing it from the DS4000 Storage Subsystem. To set 

Controller A as the logical drive preferred owner, right-click the logical 

drive entry in the Subsystem Management window and select Change 

→ Ownership/Preferred Path → Controller A.

Activity 2: Removing the drives to be migrated 

While the functioning DS4000 Storage Subsystem is still powered on, remove the 

hard drives that you plan to migrate one at a time using the following steps: 

__ Step 1.   Press on the inside of the bottom of the tray handle to release the blue 

latch. 

__ Step 2.   Lift the closed latch to its open position. (The latch is at a 90-degree 

angle to the front of the drive when open.) 
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__ Step 3.   Using the handle, slowly pull the drive ½-inch out of its drive slot. 

__ Step 4.   Wait at least 30 seconds to allow the hard drive to spin down before 

fully removing it from the drive slot. 

__ Step 5.   Place the hard drive into an ESD bag or container before moving it to 

the new DS4000 Storage Subsystem. 

 

Legend: 

�1� Blue latch 

�2� Drive CRU handle 

�3� Tray 

�4� FC hard drive

Attention: Orient drives horizontally and place them in appropriate ESD 

bags or containers before relocation. When in transit, use only moving 

equipment that prevents shock to the drives. Never stack drives.

Activity 3: Inserting the drives to be migrated 

Note:  When migrating hard drives from multiple DS4000 Storage Subsystems to a 

single DS4000 Storage Subsystem, move all of the hard drives from the first 

DS4000 Storage Subsystem as an independent "set" to the destination 

DS4000 Storage Subsystem. Before moving hard drives as a set from 

subsequent DS4000 Storage Subsystems, ensure that all of the hard drives 

from the previous set have been successfully transferred to the destination 

DS4000 Storage Subsystem. If you do not transfer hard drives as "sets" to 

the destination DS4000 Storage Subsystem, the newly relocated 

arrays/logical drives that are defined using these drives might not appear in 

the Subsystem Management window.
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Figure 16. Drive CRU assembly
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__ Step 1.   While the destination DS4000 Storage Subsystem is powered on, insert 

the migrating drives into the empty drive slots in pairs. Wait (up to five 

minutes) until the inserted drive pair is fully spun up and displayed in 

the DS4000 Storage Subsystem Management window before inserting 

the next drive pair. 

__ Step 2.   As the DS4000 Storage Subsystem recognizes the drives, it reads and 

displays the array and logical drive information in the Logical/Physical 

view of the DS4000 Storage Subsystem Management window. The 

storage subsystem represents arrays in offline state until it recognizes 

that you have inserted all of the drives that comprise an array. 

__ Step 3.   After you migrate all of the drives, manually change the state of the 

arrays and logical drives involved from optimal to online state if it has 

not changed automatically. To do so, right-click on the array name in the 

Storage Subsystem Management window and select Place → Online. If 

any of the following conditions persist, contact the IBM Help Center in 

your geography for assistance: 

v   The empty drive slot icon ( 

  

) displayed for the drive slot into which 

you inserted the migrating drive. 

v   The Failed unconfigured drive icon ( 

  

) or the Failed configured 

drive icon ( 

  

) displayed for the drive slot into which you inserted 

the migrating drive. 

v   Array configuration data on the drives you have added is incomplete. 

v   You cannot bring the array online.

Attention: Do not initialize a drive that you want to keep (by 

right-clicking its icon and selecting Initialize from the pull-down menu) if 

it contains configuration or user data. Initializing any drives in a defined 

array causes all hard drives known to comprise that array to return to 

the Unconfigured Capacity storage pool, deleting their array definitions 

from the DS4000 Storage Subsystem configuration. The user data on 

such drives is lost. 

Result: Once the arrays are online, they are ready to for you to 

configure and map to host servers. You might also then recreate 

flashcopies of the logical drives. 

__ Step 4.   Use the DS4000 Storage Manager program to view the storage 

partitioning definitions and make any necessary corrections. 

__ Step 5.   The DS4000 Storage Subsystem that the drives are migrated from will 

display the logical drives that are defined in these drives as “missing 

LUNs”. In order to remove these “missing LUNs” entries, right-click on 

each entry and select Delete from the pull-down menu.

Migrating arrays within storage subsystems 

 Important:  

1.   Ensure that your controller firmware is at or above the level documented in 

Table 22 on page 37. Do not rearrange more than two or three arrays at a time. 

2.   Unmount the file systems to flush I/O from the server cache to disks.

Notes:  

a.   In a Microsoft Windows environment, remove the drive letter or the mount 

points of the mapped LUNs instead of unmounting the file systems. 
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b.   Consult documentation associated with your particular operating system for 

detailed information regarding the Unmount procedure. 

Using the configuration data on existing drives, it is possible to redistribute the 

drives that made up an RAID array across a storage subsystem to which you may 

be adding expansion enclosures. Figure 17 illustrates a storage array distributed 

across three drives on a single storage device before and after reordering. When 

you redistribute each drive to a different position in the same storage enclosure as 

recommended, the array automatically redistributes accordingly. 

 

Figure 18 illustrates a storage array distributed across three drives on a single 

storage device before reordering across two storage devices. When the drives are 

redistributed across an additional storage enclosure in the storage subsystem as 

recommended, the array automatically redistributes accordingly. 

 

Figure 19 on page 57 illustrates two arrays distributed across five drives and two 

storage enclosures before and after reordering the same drives across other drive 

slots in the same two storage enclosures. 

 Important:  

 Before you attempt to reinsert any of the drives from either enclosure, place the 

array into offline state using the DS4000 Storage Manager client and completely 

remove all of the drives of both arrays from both storage enclosures and wait for 

the storage manager to mark the arrays/logical drives as missing. After you insert 

the drives associated with the first array, wait until that array comes online in a 

DS4000 Storage Manager Subsystem Management window before you insert the 

drives associated with the second array. 
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Figure 17. Manner recommended for reordering a defined array using empty slots in one 

storage enclosure
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Figure 18. Manner recommended for reordering a defined array using empty slots in two  

storage enclosures
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Perform the following steps to ensure success when you reorder drives that make 

up arrays across different drive slots in the same DS4000 Storage Subsystem 

configuration. 

 1.   Start the DS4000 Storage Manager Client program and open the Subsystem 

Management window (for the DS4000 Storage Subsystem which drives you 

intend to reorder). 

 2.   Set the arrays that you plan to move offline. 

 3.   Mark the drives in the arrays. 

 4.   Unlatch the drives from their respective slots. Wait at least 2 minutes for each 

drive to spin down. 

 5.   Slowly and carefully remove the drives from their slots. 

 6.   Assure that all of the drives that made up the arrays are completely removed 

from their slots. 

 7.   Wait for the storage manager to mark the arrays/logical drives as missing in 

the Subsystem Management window. See Figure 20. Do not proceed to step 8 

until all of the defined logical drives in the array(s) whose drives are removed 

from the DS4000 enclosures display as missing.
 

 8.   Carefully reinsert all of the drives that made up a single array into the empty 

slots of the storage enclosure. Do not insert the drives into empty slots that are 

part of another array definition whose drives are still inserted in the storage 

enclosures. Data on the drives you insert will be replaced with the 

reconstructed data from the previously installed RAID array. 

 9.   The system will recognize the array and bring it online when you finish 

inserting all of the drives. 

1 2 3 1 2 A

3 BA B

d
s
h
0
0
0
0
2

Before After

Empty slot

Drive associated with array

Drive associated with array

  

Figure 19. Reordering multiple defined arrays across previously used slots in two storage 

enclosures
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Figure 20. Subsystem Management Logical/Physical View of Missing Logical Drives
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10.   Repeat steps 8 on page 57 and 9 on page 57 for each of the arrays that were 

removed from the storage enclosure. 

11.   Save the storage subsystem profile. See “Saving the storage subsystem 

profile” on page 42 for information on performing this activity.

Note:  Do not reinsert drives from multiple arrays in random order into the 

storage enclosures.
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Chapter  5.  Adding  expansion  units  containing  new  hard  

drives  

 Important:  

 Observe proper ESD procedures when handling electronic equipment. See 

“Handling static-sensitive devices” on page 44 for additional information. 

 While adding storage expansion enclosures containing new hard drives, observe 

these important rules: 

v   Never alter the physical configuration of a DS4000 Storage Subsystem while it is 

powered off unless you are instructed to do so as part of DS4000 Storage 

Subsystem configuration procedure. Specifically, never attach storage 

components to or remove storage components from a configured DS4000 

Storage Subsystem while it is powered off. 

v   Any hard drive, whether new or old, might contain configuration data. Unless you 

intend to migrate drives from another DS4000 Storage Subsystem (retaining their 

configuration data), always use the following procedure to add one or more 

storage expansion enclosures containing one or more hard drives to a 

functioning DS4000 Storage Subsystem configuration. 

v   The following DS4000 Storage Subsystem devices support only 2 Gbps fibre 

channel hard drives: 

–   DS4000 EXP700 storage expansion units 

–   DS4000 EXP710 storage expansion units 

–   DS4300 storage servers

v    1 Gbps fibre channel drives will not work properly when you insert them into the 

drive slots of the aforementioned DS4000 storage devices.

 Attention:  Always make certain that a fibre channel drive can operate at the 

fibre channel speed of the drive loop involved before inserting it into the drive 

slots in a DS4000 Storage Subsystem configuration. In needed, contact your IBM 

support representative to ensure the compatibility of your drives before migrating 

them from one DS4000 configuration to another. 

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine 

its ID or Model Number. Hard drives with ID or Model Number values that end 

with “04FC” or “03FC” are 1 Gbps fibre channel drives. For example, 

“ST173404FC”, “ST318203FC” and “ST136403FC” are model numbers that 

appear on several 1 Gbps fibre channel hard drives. 1 Gbps fibre channel drives 

might also be mounted in a tray with the front bezel that is about .75″ wider than 

the 2 Gbps drive tray bezel. 

You can also obtain the drive product model and ID through the DS4000 Storage 

Subsystem profile. For information on how to do so, see “Determining the 

product ID and model of a drive” on page 32. 

v   Do not mix SATA and fibre channel drives or enclosures together in the same 

drive loop unless you have met the fibre channel/SATA intermix requirements. 

See “Intermixing storage expansion enclosures” on page 3 for that information. 

v   Do not install SATA drives in fibre channel drive expansion enclosures. 

v   Do not install fibre channel drives in SATA drive expansion enclosures.

The following procedure describes the steps required to add one or more DS4000 

storage expansion enclosures containing new drives to a functioning DS4000 

Storage Subsystem configuration. 
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Activity 1: Preliminary activities 

 Important:  

 Before you attempt to complete the drive migration procedure, review the 

information provided in Chapter 1 and perform the steps documented in Chapter 2, 

“Prerequisites to adding capacity and hard drive migration,” on page 35. 

 Add a new DS4000 storage expansion enclosure as follows: 

__ Step 1.   Verify that the DS4000 Storage Subsystem is both powered on and in 

optimal state. See the DS4000 Problem Determination Guide 

associated with your particular DS4000 hardware model or “Bringing 

storage subsystems and drive loops into optimal state” on page 41 for 

additional information on how to make this determination. You can 

perform this process while the DS4000 Storage Subsystem is 

processing I/O from or to the host server. However, because the drive 

loops are interrupted momentarily during the addition process, schedule 

additions to occur during time periods of low I/O between the DS4000 

Storage Subsystem and host servers. 

Note:  Though there are no restrictions against cabling EXP100 and 

EXP700 storage expansion units together, for ease of future 

maintenance and possible problem troubleshooting, IBM 

recommends that you group or plan your configuration to allow 

for grouping of the drive expansion enclosures by type in a 

DS4000 Storage Subsystem redundant drive loop, if possible.
Review the readme and the IBM TotalStorage DS4000 Storage 

Manager installation and support guide associated with the operating 

system environment of the host servers that connect to the DS4000 

Storage Subsystem for any additional restrictions or required 

preparation tasks specific to your particular operating system 

environment. You will find the IBM TotalStorage DS4000 Storage 

Manager installation and support guides at: 

www-1.ibm.com/servers/storage/support/disk/ 

Verify that the DS4000 Storage Subsystem support the DS4000 drive 

storage expansion enclosures that you trying to add. 

__ Step 2.   If the new storage expansion enclosure is not the same type as the 

existing storage expansion enclosures (some or all) see “Intermixing 

storage expansion enclosures” on page 3 for intermix information.

Note:  You must group like DS4000 storage expansion enclosure types 

in adjacent positions on the Fibre Channel loop when they are 

intermixed in a DS4000 Storage Subsystem redundant drive loop 

configuration. 

__ Step 3.   Unpack and mount any additional storage expansion enclosures in the 

rack using the mounting hardware supplied with each storage 

expansion enclosure. 

 Important:: 

 Do not fully insert hard drives into the enclosures at this time. Keep 

them unlatched and no less than ½-inch away from their full insertion 

points in the drive slots. 

__ Step 4.   Set the enclosure ID of the additional storage expansion enclosures. 

Each drive enclosure in the DS4000 Storage Subsystem drive loop 
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must have a unique drive enclosure ID. In a EXP500 storage expansion 

enclosure, there is an enclosure ID switch mounted on each of two 

ESM canisters. Set each ESM canister’s enclosure ID switch in the 

EXP500 drive enclosure to the same unique number in the drive loop. 

In EXP100, EXP700, and EXP710 storage expansion enclosures, there 

is only one enclosure ID switch, which is mounted between the power 

supplies. See the appropriate DS4000 storage expansion unit 

installation and user’s guide for additional information. Figure 21 

illustrates the location of enclosure ID switches on the EXP100, 

EXP700, EXP710, and EXP500 storage enclosures.
 

If the DS4000 Storage Subsystem to which the storage expansion 

enclosure will attach is either a FAStT200 or DS4300, the enclosure IDs 

of additional storage expansion enclosures must differ from the 

FAStT200 or DS4300 Storage Subsystem enclosure IDs, which are 

normally set to “0” at the factory. 

__ Step 5.   Verify that the EXP700 Storage Expansion Unit speed switch is set to 

the correct drive loop speed. 

Note:  If a fibre channel enclosure speed switch was originally set to 1 

Gbps, do not automatically set it to 2 Gbps unless you are sure 

that each fibre channel hard drive that it now contains is capable 

of 2 Gbps operation and that you have installed the latest 

firmware enabling their operation in a 2 Gbps fibre channel 

environment.

Activity 2: Cabling new storage expansion units 

To complete addition of DS4000 storage expansion enclosures, cable the new 

storage expansion enclosures to the end of the functioning storage expansion 

enclosure drive loop to which you are migrating them. Add only one enclosure at a 

time to a functioning drive loop if you intend to attach multiple storage expansion 

enclosures. 

It is possible to connect new storage expansion enclosures at either end of a 

functioning storage expansion enclosure drive loop. 

Enclosure FC
speed switch Enclosure ID

switch

DS4000 EXP500

DS4000 EXP710

m
ig

0
0

0
0

2

Enclosure ID
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Figure 21. EXP100, EXP500, EXP700, and EXP710 enclosure ID and speed switches
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The two options are: 

1.   The beginning, closest to the controller (at the top, directly attached to controller 

A) as described in Connecting new storage expansion units at the beginning 

(top) of a drive loop 

2.   The end, furthest from the controller (at the bottom, directly attached to 

controller B) as described in Connecting new storage expansion units at the end 

(bottom) of a drive loop

Of the two options, IBM recommends only option 2, connection to the end (at the 

bottom) of a functioning storage expansion enclosure drive loop, directly attached to 

controller B. This is recommended because if the existing DS4000 Storage 

Subsystem configuration is not planned for cabling in new storage expansion 

enclosures at the top of the drive loop, cluttered or entangle fibre channel drive loop 

cabling may hinder drive loop troubleshooting or cause fibre channel cabling errors. 

With this in mind, and depending on your requirements, however, follow either of 

the instruction sets at “Connecting new storage expansion units at the end (bottom) 

of a drive loop” or “Connecting new storage expansion units at the beginning (top) 

of a drive loop” on page 66. 

Depending on your DS4000 Storage Subsystem configuration, there might be 

unused drive ports that you can connect the new drive expansion enclosures to the 

DS4000 Storage Subsystem controllers. Use the appropriate information in your 

DS4000 installation, User’s, and Maintenance Guide to attach the drive expansion 

enclosures to the DS4000 storage subsystem. 

If your DS4000 Storage Subsystem (such as DS4400 or DS4500) has drive 

minihubs, do not use more than one port per drive minihub. Always leave one of the 

two drive ports empty in each drive minihub. After you connect the drive expansion 

enclosures to the DS4000 controller, see “Activity 3: Disabling DS4000 Storage 

Subsystem drive migration settings” on page 70. 

Connecting new storage expansion units at the end (bottom) of a drive 

loop 

The cabling instructions illustrated in Figure 22 on page 64, Figure 23 on page 65, 

and Figure 24 on page 66 describe cabling a DS4000 EXP700 Storage Expansion 

Enclosure to the end (bottom) of a redundant drive loop of a functioning DS4300 

Storage Subsystem (model 60X or 60U). IBM recommends that you add storage 

expansion enclosures to an existing drive loops only in this manner. See “DS4000 

Storage Subsystem drive loop schemes” on page 21. 

__ Step 1.   Insert the small form-factor pluggables (SFPs) or gigabit interface 

converters (GBICs) into only those ports you intend to use. Do not 

leave GBICs or SFPs inserted into port slots without connecting them to 

other ports using cables. 

__ Step 2.   Extend one of the drive loops (that is, drive loop A) in a DS4000 

Storage Subsystem redundant drive loop pair by connecting the OUT 

port of the last storage expansion enclosure to the IN port of the new 

storage expansion enclosure as shown in Figure 22 on page 64. 

Warning: Carefully reconfigure only one drive loop at a time, making 

sure that the drive loop that you modify is properly connected and in 

optimal state before you attempt to reconfigure another drive loop. 

Take this precaution to prevent the arrays from being inadvertently 

failed by the DS4000 Storage Subsystem controllers. This happens 

when two or more drives in the arrays cannot be reached through either 

drive loop in the redundant drive loop pair. 
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__ Step 3.   Power on the newly added storage expansion enclosure unit. 

__ Step 4.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop A, now extended to the new storage expansion enclosure, 

are not lit. Using the DS4000 Storage Manager Client Subsystem 

Management window, verify that the new storage expansion enclosure 

is added and displayed in the Logical/Physical view of the window. 

Correct any errors before proceeding to step 5. For port bypass: 

__ a.   Verify that the SFPs and GBICs or fibre cables are in good 

condition. 

__ b.   Remove and reinsert SFPs, GBICs and fibre cables. 

__ c.   Ensure that the new drive expansion enclosure speed switch is 

set to the same speed as the existing drive expansion 

enclosures and the DS4000 Storage Subsystem speed setting. 

__ d.   Verify that the ESM is good by physically removing and 

swapping it with the other ESM in the same drive expansion 

enclosure. For enclosure ID conflict, set the drive expansion 

enclosure ID switch to values unique from the current settings in 

the existing drive expansion enclosures and storage server.

Contact the IBM Help Center in your geography for assistance if the 

problems persist. 

__ Step 5.   In the other drive loop (that is, drive loop B) in a DS4000 Storage 

Subsystem redundant drive loop pair, remove the connection from the 

DS4000 Storage Subsystem drive loop port to the OUT port of the last 

storage expansion enclosure and connect it to the OUT port of the new 

drive enclosure as shown in Figure 23 on page 65. 

__ Step 6.   Wait a few seconds; verify that the port bypass LEDs of the two ports in 

the connection between the DS4000 Storage Subsystem drive loop port 

and the OUT port of the new drive enclosure are not lit. Using the 

DS4000 Storage Manager Client Subsystem Management window, 

verify that the new drive enclosure does not indicate the drive 

enclosure lost redundancy path error. See the preceding step 4 for 

possible corrective actions, if needed. 

Note:  The existing storage expansion enclosures will be shown with 

drive enclosure lost redundancy path errors until you make 

the fibre channel cabling connection described in step 7. 

__ Step 7.   In drive loop B, cable the new drive enclosure’s IN port to the OUT port 

of the last enclosure in the already functioning storage expansion 

enclosure drive loop as shown in Figure 24 on page 66. 

__ Step 8.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop B to which you have added a new connection are not lit. 

Using the DS4000 Storage Manager Client Subsystem Management 

window, verify that all of the drive enclosures in the DS4000 redundant 

drive loop pair to which the new enclosure was added does not report 

the drive enclosure lost redundancy path error.
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Figure 22. Cabling a single drive enclosure to the end of a functioning drive loop (step 1 of 3)
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Connecting new storage expansion units at the beginning (top) of a 

drive loop 

It is possible to add new storage expansion enclosures to either the beginning (top) 

or end (bottom) of a functioning storage expansion enclosure drive loop. The 

cabling instructions illustrated in Figure 25 on page 68, Figure 26 on page 69, and 

Figure 27 on page 70 describe cabling a DS4000 EXP700 Storage Expansion 

Enclosure to the beginning (top) of a redundant drive loop of a functioning DS4300 

Storage Subsystem (model 60X or 60U). IBM recommends that you refrain from 

adding storage expansion enclosures in this manner, especially if there is 

insufficient rack space to allow the methodical, uncluttered, and uniform fibre 

channel cabling of such new enclosures. Without proper planning, disadvantages of 

adding expansion units in this manner include cable management issues that 

contribute to avoidable troubleshooting difficulties. See Figure 30 on page 74 for the 

diagram of a properly planned new expansion enclosure addition at the beginning 

(top) of a functioning storage expansion enclosure drive loop. 
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Figure 24. Cabling a single drive enclosure to the end of a functioning drive loop (step 3 of 3)
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The general cabling scheme for DS4000 external drive enclosures is described in 

the IBM TotalStorage DS4000 Fibre Channel Cabling Guide available at: 

www-3.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-4KELS5 

See also “DS4000 Storage Subsystem drive loop schemes” on page 21. 

__ Step 1.   Insert the small form-factor pluggables (SFPs) or gigabit interface 

converters (GBICs) into only those ports you intend to use. Do not 

leave GBICs or SFPs inserted into port slots without connecting them to 

other ports using cables. 

__ Step 2.   Extend one of the drive loops (that is, drive loop B) in a DS4000 

Storage Subsystem redundant drive loop pair by connecting the IN port 

of the first (existing) storage expansion enclosure to the OUT port of the 

new storage expansion enclosure as shown in Figure 25 on page 68. 

Warning: Carefully reconfigure only one drive loop at a time, making 

sure that the drive loop that you modify is properly connected and in 

optimal state before you attempt to reconfigure another drive loop. 

Take this precaution to prevent the arrays from being inadvertently 

failed by the DS4000 Storage Subsystem controllers. This happens 

when two or more drives in the arrays cannot be reached through either 

drive loop in the redundant drive loop pair. 

__ Step 3.   Power on the newly added storage expansion enclosure unit. 

__ Step 4.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop B, now extended to the new storage expansion enclosure, 

are not lit. Using the DS4000 Storage Manager Client Subsystem 

Management window, verify that the new storage expansion enclosure 

is added and displayed in the Logical/Physical view of the window. 

Correct any errors before proceeding to step 5. For port bypass: 

__ a.   Verify that the SFPs and GBICs or fibre cables are in good 

condition. 

__ b.   Remove and reinsert SFPs, GBICs and fibre cables. 

__ c.   Ensure that the new drive expansion enclosure speed switch is 

set to the same speed as the existing drive expansion 

enclosures and the DS4000 Storage Subsystem speed setting. 

__ d.   Verify that the ESM is good by physically removing and 

swapping it with the other ESM in the same drive expansion 

enclosure. For enclosure ID conflict, set the drive expansion 

enclosure ID switch to values unique from the current settings in 

the existing drive expansion enclosures and storage server.

Contact the IBM Help Center in your geography for assistance if the 

problems persist. 

__ Step 5.   In drive loop A, remove the connection from the DS4000 Storage 

Subsystem drive loop port to the IN port of the first storage expansion 

enclosure and connect it to the IN port of the new drive enclosure as 

shown in Figure 26 on page 69. 

__ Step 6.   Wait a few seconds; verify that the port bypass LEDs of the two ports in 

the connection between the DS4000 Storage Subsystem drive loop port 

and the IN port of the new drive enclosure are not lit. Using the DS4000 

Storage Manager Client Subsystem Management window, verify that 

the new drive enclosure does not indicate the drive enclosure lost 

redundancy path error. See the preceding step 4 for possible corrective 

actions, if needed. 
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__ Step 7.   In drive loop A, cable the new drive enclosure’s OUT port to the IN port 

of the first enclosure in the already functioning storage expansion 

enclosure drive loop as shown in Figure 27 on page 70. 

__ Step 8.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop A to which you have added a new connection are not lit. 

Using the DS4000 Storage Manager Client Subsystem Management 

window, verify that all of the drive enclosures in the DS4000 redundant 

drive loop pair to which the new enclosure was added does not report 

the drive enclosure lost redundancy path error.
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Figure 25. Cabling a single drive enclosure to the beginning of a functioning drive loop (step 

1 of 3)
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Activity 3: Disabling DS4000 Storage Subsystem drive migration 

settings 

When you have completed cabling the new storage expansion enclosures, disable 

DS4000 Storage Subsystem drive migration settings as follows: 

__ Step 1.   Open the Storage Manager Client program Enterprise Management 

window. 

__ Step 2.   Right-click on the name of the DS4000 Storage Subsystem to which 

you want to add drives, and select Execute Script. 

__ Step 3.   A script editor window opens. Click File → Load Script. 

__ Step 4.   A Load Script file selection window opens. Locate and select the 

DisableDriveMigration.scr file and click OK. The file 

DisableDriveMigration.scr file is normally in the SCRIPTS directory of the 

IBM DS4000 Storage Manager Installation CD. This file is used to reset 

the DS4000 Storage Subsystem setting, in order to treat all 
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Figure 27. Cabling a single drive enclosure to the beginning of a functioning drive loop (step 

3 of 3)
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newly-discovered hard drives as “new” drives, and to ignore any 

configuration information that might exist in the new hard drives. 

Figure 15 on page 49 contains the DisableDriveMigration.scr file listing. 

__ Step 5.   Click Tools → Verify and Execute to run the script. 

__ Step 6.   When the script execution completes, reset both DS4000 controllers to 

make the disable drive migration settings effective. If you used the 

DisableDriveMigration.scr file described in this document in Figure 15 

on page 49, you do not need to perform this step because the last two 

commands in the script file automatically reset the controllers. To reset 

the controllers, open the Storage Subsystem Management window and 

alternately (one at a time) reset each controller by clicking Advanced → 

Reset Controller and following the instructions in the Reset Controller 

window when it opens.

Activity 4: Inserting drives and cabling additional storage expansion 

units 

After you have disabled DS4000 Storage Subsystem drive migration settings, insert 

drives and connect additional storage expansion enclosures to complete the 

installation process as follows: 

__ Step 1.   Insert the appropriate drives into empty drive slots in the new enclosure 

in pairs (two at a time). Wait (up to 5 minutes) until the inserted drive 

pair fully spins up and displays in the DS4000 Storage Subsystem 

Management window before inserting the next drive pair. 

__ Step 2.   To connect additional storage expansion enclosures to the functioning 

drive loop pair, perform Activity 1: Preliminary activities step 3 on page 

60 through step 1 on page 62, and Activity 2: Cabling new storage 

expansion units steps as follows: 

v   If you are connecting additional storage expansion enclosures to the 

end (bottom) of a drive loop, complete step 2 on page 62 through 

step 7 on page 63, and step 1 (immediately preceding this step) for 

each additional storage expansion enclosure that you intend to add. 

(See Figure 28 on page 72.) 

v   If you are connecting additional storage expansion enclosures to the 

beginning (top) of a drive loop, complete step 2 on page 67 through 

step 7 on page 68, and step 1 (immediately preceding this step) for 

each additional storage expansion enclosure that you intend to add. 

(See Figure 29 on page 73.) If you are willing to plan your connection 

of additional storage expansion enclosures to the beginning (top) of a 

drive loop, see Figure 30 on page 74 for alternate cabling 

instructions. 

When you have completed adding enclosures, proceed to Activity 5: 

Re-enabling drive migration settings step1 on page 74 to re-enable the 

drive migration settings.
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Activity 5: Re-enabling drive migration settings 

If you performed steps 1 on page 70 through 6 on page 71 of Activity 3: Disabling 

DS4000 Storage Subsystem drive migration settings to disable DS4000 Storage 

Subsystem drive migration settings, perform the following steps 1 through 6 on 

page 75 to re-enable the drive migration settings. If you should ever momentarily 

remove a drive from the DS4000 Storage Subsystem, the storage subsystem clears 

its configuration data when it later recognize it. When this happens, the drive 

displays as unconfigured. 

Attention: In order to prevent data loss, set the DS4000 Storage Subsystem drive 

migration setting to enable after you complete the hard drive addition process. 

__ Step 1.   Open the Storage Manager Client program Enterprise Management 

window. 

__ Step 2.   Right-click on the name of the DS4000 Storage Subsystem to which 

you want to add drives and click Execute Script. 

__ Step 3.   A script editor window opens. Click File → Load Script. 

d
s
h
0
0
0
2
9

Drive loop
B

DS4300 Storage Server

New EXP700
enclosures
to be added

DS4000 EXP700

DS4000 EXP700

DS4000 EXP700

a

b

c

Existing DS4300
Storage Server
configuration

d

In order shown (1-6), make
or change connections to add

two new drive enclosures
( and ) to an existing
fibre channel drive loop

c d

Drive loop
A

6 4

5

3 1

2

DS4000 EXP700

  

Figure 30. Recommended connection: Planned cabling of additional drive enclosures to the 

beginning of a functioning drive loop
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__ Step 4.   A Load Script file selection window opens. Locate and select the 

EnableDriveMigration.scr file and click OK. The file 

EnableDriveMigration.scr file is normally in the SCRIPTS directory of the 

IBM DS4000 Storage Manager Installation CD. Use this file to reset the 

DS4000 Storage Subsystem setting in order to check for any 

configuration data that might exist on the newly discovered hard drives. 

__ Step 5.   Click Tools → Verify and Execute to run the script. 

__ Step 6.   When the script execution completes, reset both DS4000 controllers to 

make the setting effective. 

If you use the EnableDriveMigration.scr script associated with this 

document and described in Figure 14 on page 48, it is not necessary 

for you to perform this step because the last two commands in that 

script file automatically reset the controllers. To reset the controllers, 

open the Storage Subsystem Management window and alternately (one 

at a time) reset each controller by clicking Advanced → Reset 

Controller and following the instructions in the Reset Controller window 

when it opens. 

__ Step 7.   Verify (and update, if needed) the DS4000 Storage Expansion 

Enclosure ESM firmware and drive firmware with the latest version from 

the following IBM DS4000 support web site. 

www-1.ibm.com/servers/storage/support/disk/ 

Result: The newly added drives are now ready for you to configure and map to 

host servers. 

Note:  Listings of the EnableDriveMigration.scr and DisableDriveMigration.scr 

files are found in Figure 14 on page 48 and Figure 15 on page 49.
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Chapter  6.  Migrating  expansion  units  containing  hard  drives  

Note:  When migrating hard drives from multiple DS4000 Storage Subsystems to a 

single DS4000 Storage Subsystem, move all of the hard drives from the first 

DS4000 Storage Subsystem as an independent “set” to the destination 

DS4000 Storage Subsystem. Before moving hard drives as a set from 

subsequent DS4000 Storage Subsystems, ensure that all of the hard drives 

from the previous set have been successfully transferred to the destination 

DS4000 Storage Subsystem. If you do not transfer hard drives as “sets” to 

the destination DS4000 Storage Subsystem, the newly relocated 

arrays/logical drives that are defined in these drives might not appear in the 

Subsystem Management window. 

While migrating a fibre channel or SATA hard drive to either a controller or a drive 

expansion enclosure, observe these important rules: 

v   Observe proper ESD procedures when handling electronic equipment. See 

“Handling static-sensitive devices” on page 44 for additional information. 

v   Never alter the physical configuration of a DS4000 Storage Subsystem while it is 

powered off unless you are instructed to do so as part of DS4000 configuration 

procedure. Specifically, never attach storage components to or remove storage 

components from a configured DS4000 Storage Subsystem while it is powered 

off. 

v   Use this procedure to preserve the configuration and user data in one or more 

fibre channel hard drives that you will migrate to a functioning DS4000 Storage 

Subsystem configuration. Do not use this procedure if you are unsure of the 

quality of the data on the hard drives. Import of incorrect configuration data from 

hard drives could cause a DS4000 Storage Subsystem failure.

Use this procedure to migrate one or more DS4000 storage expansion enclosures 

containing hard drives which themselves contain configuration data from a 

functioning DS4000 Storage Subsystem configuration to another DS4000 Storage 

Subsystem configuration. 

Attention: Make additions to the DS4000 Storage Subsystem only while it is 

powered on and in optimal state. See “Bringing storage subsystems and drive 

loops into optimal state” on page 41 for additional information on how to make this 

determination. You can complete this process while the DS4000 Storage Subsystem 

is receiving I/O from the host server. However, because the drive loops are 

interrupted momentarily during the addition process, schedule the addition to occur 

during time periods of low I/O between the DS4000 Storage Subsystems and host 

servers. 

Review the readme and the IBM TotalStorage DS4000 Storage Manager installation 

and support guides associated with the operating system environment of the host 

servers that connect to the DS4000 Storage Subsystem for information about any 

operating system-specific restrictions in addition to those detailed in this document. 

You will also find preliminary tasks that you may be required to complete detailed in 

that documentation. IBM TotalStorage DS4000 Storage Manager installation and 

support guides are located at the following Web site: 

www-1.ibm.com/servers/storage/support/disk/ 
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Tip: Before proceeding with the migration procedure, review and perform the steps 

outlined in Chapter 2, “Prerequisites to adding capacity and hard drive migration,” 

on page 35. 

The procedure for migrating a new DS4000 storage expansion enclosure is as 

follows: 

Activity 1: Preliminary activities 

 Important:  

 Before you attempt to complete the drive migration procedure, review the 

information provided in Chapter 1 and perform the steps documented in Chapter 2, 

“Prerequisites to adding capacity and hard drive migration,” on page 35. 

 Before disconnecting any storage expansion enclosures from a DS4000 Storage 

Subsystem, to ensure a successful migration of your drives to the DS4000 Storage 

Subsystem, perform the following steps: 

__ Step  1.   If the migrated storage expansion enclosure is not the same type as 

some or all of the existing storage expansion enclosures, review 

“Intermixing storage expansion enclosures” on page 3.

Note:  You must group like DS4000 storage expansion enclosure 

types in adjacent positions on the Fibre Channel loop when 

they are intermixed in a DS4000 Storage Subsystem redundant 

drive loop configuration. 

__ Step  2.   Verify that both the functioning source and the destination DS4000 

Storage Subsystem’s controller firmware and NVSRAM are at the 

levels recommended in Table 22 on page 37. 

__ Step  3.   Verify that the firmware of the ESMs in the storage expansion 

enclosures that you plan to migrate are at the levels recommended in 

Table 23 on page 38. 

__ Step  4.   Verify that the firmware of the ESMs in the storage expansion 

enclosures attached to the DS4000 Storage Subsystem to which you 

will migrate your drives is at the levels recommended in Table 23 on 

page 38. 

__ Step  5.   If you migrate storage expansion enclosures from a 1 Gbps fibre 

channel environment to a 2 Gbps fibre channel environment, verify 

that the fibre channel hard drives that you plan to migrate are each 

capable of 2 Gbps operation and that you have installed the latest 

firmware enabling them to work properly in a 2 Gbps fibre-channel 

environment. 

__ Step  6.   Verify that the names of the logical drives that are created using the 

hard drives in the migrated storage expansion enclosures are unique 

in the DS4000 Storage Subsystem to which these storage expansion 

enclosures will migrate. If they are not unique, make any necessary 

changes. 

__ Step  7.   If you migrate the drives to a single controller DS4000 Storage 

Subsystem (for example, DS4300 Storage Subsystem, model 6LU or 

6LX), change the logical drive’s preferred owner to Controller A using 

the DS4000 Storage Manager Client program before taking it offline 

and removing it from the DS4000 Storage Subsystem. To set 

Controller A as the logical drive preferred owner, right-click the logical 

 

78 Adding and Migrating Drives and Expansion Enclosures to DS4000 Storage Servers

|

|
|
|

|
|
|
|



drive entry in the Subsystem Management window and select Change 

→ Ownership/Preferred Path → Controller A. 

__ Step  8.   In addition to array configuration information, any storage partitioning 

configuration data that may reside on drives you plan to migrate will 

migrate with those drives when installed on another DS4000 Storage 

Subsystem. For this reason, take the following precautions to facilitate 

the migration process and prevent problems in storage partitioning 

configuration data migration. 

a.   If a DS4000 storage partitioning premium feature has been 

enabled both on a drive’s original and destination DS4000 Storage 

Subsystems, ensure that the defined host ports, hosts, and host 

group names are unique to each DS4000 Storage Subsystem 

involved in the migration. 

b.   If you must use identical names on both DS4000 Storage 

Subsystems, make the names unique before you perform the drive 

migration. 

If necessary, customize the storage partitioning information on the 

DS4000 Storage Subsystem to which you have migrated the drives 

after you complete the migration. 

__ Step  9.   Delete any flashcopies of logical drives defined in the hard drives that 

you plan to migrate. 

__ Step 10.   Remove any remote mirror relationships that involve the logical drives 

defined on the drives that you plan to migrate.

Activity 2: Preparing and backing up the drives 

__ Step 1.   If the arrays and logical drives involved are not in optimal state, 

perform the steps necessary to bring these arrays and logical drives to 

their optimal state before attempting migration. See “Bringing storage 

subsystems and drive loops into optimal state” on page 41 for additional 

information on how to make this determination. 

__ Step 2.   If the drive enclosures that you plan to migrate are not in optimal state, 

perform the steps necessary to bring them to their optimal state before 

attempting migration. See “Bringing storage subsystems and drive loops 

into optimal state” on page 41 for additional information on how to make 

this determination. 

__ Step 3.   Perform a backup of the logical drives defined in the storage expansion 

enclosures that you plan to migrate. 

__ Step 4.   Monitor the DS4000 Storage Subsystem event log for any errors in the 

drive loop or its components for several days before migrating storage 

expansion enclosures. 

__ Step 5.   Stop all programs, services or processes in the host servers that 

access the logical drives defined in the migrated hard drives. Ensure 

that there are not any running background programs, services or 

processes that write data to the logical drives. (For example, Microsoft 

MSCS service periodically writes to the “Quorum” disk.) 

__ Step 6.   Unmount the file systems to flush I/O from the server cache to disks. 

Notes:  

a.   In a Microsoft Windows environment, remove the drive letter or the 

mount points of the mapped LUNs instead of unmounting the file 

systems. 
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b.   Refer to the documentation associated with your particular operating 

system for detailed information regarding the Unmount procedure.

__ Step 7.   Save the DS4000 Storage Subsystem profile of the functioning DS4000 

Storage Subsystem configuration to which the migration will occur in a 

location other than that of the logical drives you plan to migrate. 

__ Step 8.   Place the arrays defined in the storage expansion enclosures that you 

plan to migrate in offline state. In the Storage Subsystem 

Management window, right-click on the name of the array and click 

Place → Offline.

Activity 3: Shutting down and moving the storage expansion unit 

__ Step 1.   Because removing a storage expansion enclosure from a functioning 

DS4000 Storage Subsystem will disrupt its drive loops, shutdown the 

functioning destination DS4000 Storage Subsystem while you remove 

its storage expansion enclosures for reconfiguration. If you cannot 

shutdown the DS4000 Storage Subsystem, carefully reconfigure only 

one drive loop, making sure that the drive loop that you modify is 

connected correctly and in optimal state before you attempt to 

reconfigure the other drive loop. For additional information on making 

this determination, see “Bringing storage subsystems and drive loops 

into optimal state” on page 41. 

Take this precaution to prevent the arrays from being inadvertently 

failed by the DS4000 Storage Subsystem controllers because two or 

more drives in the arrays cannot be reached through either drive loop in 

the redundant drive loop pair. 

Perform the following steps to verify that the drive loops are in optimal 

state: 

__ Step a.   Physically trace the actual cable connections making sure 

that connections are properly modified and that the cable 

connectors are firmly inserted into the SFPs or GBICs. 

__ Step b.   Verify that the following LEDs are not lit or briefly flashed in 

the modified drive loop: 

v   ESM Fault 

v   port bypass 

v   ID conflict

__ Step c.   Verify that the controller drive loop LED remains lit. If the 

controller drive loop LED becomes unlit momentary, there 

are problems in the drive loop and the Loop Initialization 

Primitives (LIPs) are generated by the DS4000 Storage 

Subsystem controller. 

__ Step d.   In the DS4000 Storage Manager Client Subsystem 

Management window, verify that there are no loss of ESM 

path redundancy errors in the storage expansion enclosures 

that are not migrated. 

Do not modify the second drive loop in the redundant drive 

loop pair until you are sure that the first modified drive loop 

is operating optimally.

__ Step 2.   Power down the storage expansion enclosures and move them to the 

DS4000 Storage Subsystem to which you plan to migrate them. 

Notes: 
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v   A storage expansion enclosure with 14 drives weighs up to 100 lbs. 

(45 kg). If necessary, remove the drives and other storage expansion 

enclosure components to reduce the weight of the unit for easier 

handling. Mark each drive before removing it in order to return it to 

the same drive slot when you reassemble the components at the 

destination location. 

v   Move drives only in a horizontal position using an appropriate ESD 

bag or container and moving equipment that prevents shock to the 

drives during transit. Never stack drives.

Activity 4: Installing and setting storage expansion unit IDs and 

speeds 

__ Step 1.   When the storage expansion enclosures and drives are at the location 

of the DS4000 Storage Subsystem to which they will be migrated, 

install them into the rack. If the drives were removed during transit, 

return them to the slots from which they were removed, unlatched and 

no less than ½-inch away from their full insertion points in the drive 

slots. If the drives were not removed, unlatch and pull them out no less 

than ½-inch away from their full insertion points in the drive slots. 

__ Step 2.   See Figure 21 on page 61 for an illustration of how to set the enclosure 

ID of the storage expansion enclosures. Each drive enclosure in the 

DS4000 Storage Subsystem drive loop must have a unique drive 

enclosure ID. In a EXP500 Storage Expansion Unit, there is an 

enclosure ID switch mounted on each of two ESM canisters. Set each 

ESM canister’s enclosure ID switch in the EXP500 drive enclosure to 

the same unique number in the drive loop. In the EXP100, EXP700 and 

EXP710 storage expansion enclosures, there is only enclosure ID 

switch, which is mounted between the power supplies. To access the 

appropriate DS4000 storage expansion unit installation and user’s guide 

for additional information, use the following Web link: 

www.storage.ibm.com/disk/fastt/index.html 

 Important: 

 If the DS4000 Storage Subsystem to which you will attach migrating 

hard drives is either a FAStT200 or DS4300 (model 60X or 60U), the 

enclosure IDs of additional storage expansion enclosures must differ 

from the FAStT200 or DS4300 Storage Subsystem’s enclosure IDs. 

These IDs are normally set to “0” at the factory. 

__ Step 3.   Verify that you set the enclosure speed switch of the DS4400 to the 

correct drive loop speed. 

If the enclosure speed switch was originally set to 1 Gbps, do not 

automatically set it to 2 Gbps unless you are sure that each fibre 

channel hard drive it now contains is capable of 2 Gbps operation and 

that you have installed the latest firmware enabling their operation in a 

2 Gbps fibre-channel environment.

Activity 5: Cabling, powering on, and verifying storage expansion unit 

operation 

It is possible to connect new storage expansion enclosures at either end of a 

functioning storage expansion enclosure drive loop. The two options are: 
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1.   the beginning, closest to the controller (at the top, directly attached to controller 

A) as described in Connecting new storage expansion units at the beginning 

(top) of a drive loop 

2.   the end, furthest from the controller (at the bottom, directly attached to controller 

B) as described in Connecting new storage expansion units at the end (bottom) 

of a drive loop

Of the two options, IBM recommends only option 2, connection to the end (at the 

bottom) of a functioning storage expansion enclosure drive loop, directly attached to 

controller B. This is recommended because if the existing DS4000 Storage 

Subsystem configuration is not planned for cabling in new storage expansion 

enclosures at the top of the drive loop, cluttered or entangle fibre channel drive loop 

cabling may hinder drive loop troubleshooting or cause fibre channel cabling errors. 

With this in mind, and depending on your requirements, however, follow either of 

the instruction sets at “Connecting new storage expansion units at the end (bottom) 

of a drive loop” or “Connecting new storage expansion units at the beginning (top) 

of a drive loop” on page 86. 

Depending on your DS4000 Storage Subsystem configuration, there might be 

unused drive ports that you can connect the new drive expansion enclosures to the 

DS4000 Storage Subsystem controllers. Use the appropriate information in your 

DS4000 installation, User’s, and Maintenance Guide to attach the drive expansion 

enclosures to the DS4000 storage subsystem. 

If your DS4000 Storage Subsystem (such as DS4400 or DS4500) has drive 

minihubs, do not use more than one port per drive minihub. Always leave one of the 

two drive ports empty in each drive minihub. After you connect the drive expansion 

enclosures to the DS4000 controller, see “Activity 6: Inserting hard drives and 

placing logical drives online” on page 90. 

Connecting new storage expansion units at the end (bottom) of a drive 

loop 

The cabling instructions illustrated in Figure 31 on page 84, Figure 32 on page 85, 

and Figure 33 on page 86 describe cabling a DS4000 EXP700 Storage Expansion 

Enclosure to the end (bottom) of a redundant drive loop of a functioning DS4300 

Storage Subsystem (model 60X or 60U). Again, IBM recommends that you add 

storage expansion enclosures to an existing drive loops only in this manner. 

See also “DS4000 Storage Subsystem drive loop schemes” on page 21. 

__ Step 1.   Insert the small form-factor pluggables (SFPs) or gigabit interface 

converters (GBICs) into only those ports you intend to use. Do not 

leave GBICs or SFPs inserted into port slots without connecting them to 

other ports using cables. 

__ Step 2.   Extend one of the drive loops (that is, drive loop A) in a DS4000 

Storage Subsystem redundant drive loop pair by connecting the OUT 

port of the last storage expansion enclosure to the IN port of the new 

storage expansion enclosure as shown in Figure 31 on page 84. 

Warning: Carefully reconfigure only one drive loop at a time, making 

sure that the drive loop that you modify is properly connected and in 

optimal state before you attempt to reconfigure another drive loop. 

Take this precaution to prevent the arrays from being inadvertently 

failed by the DS4000 Storage Subsystem controllers. This happens 

when two or more drives in the arrays cannot be reached through either 

drive loop in the redundant drive loop pair. 
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__ Step 3.   Power on the newly added storage expansion enclosure unit. 

__ Step 4.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop A, now extended to the new storage expansion enclosure, 

are not lit. Using the DS4000 Storage Manager Client Subsystem 

Management window, verify that the new storage expansion enclosure 

is added and displayed in the Logical/Physical view of the window. 

Correct any errors before proceeding to step 5. For port bypass: 

__ a.   Verify that the SFPs and GBICs or fibre cables are in good 

condition. 

__ b.   Remove and reinsert SFPs, GBICs and fibre cables. 

__ c.   Make sure the new drive expansion enclosure speed switch is 

set to the same speed as the existing drive expansion 

enclosures and the DS4000 Storage Subsystem speed setting. 

__ d.   Verify that the ESM is good by physically removing and 

swapping it with the other ESM in the same drive expansion 

enclosure. For enclosure ID conflict, set the drive expansion 

enclosure ID switch to values unique from the current settings in 

the existing drive expansion enclosures and storage server.

Call the IBM Help Center in your geography for assistance if the 

problems persist. 

__ Step 5.   In the other drive loop (that is, drive loop B) in a DS4000 Storage 

Subsystem redundant drive loop pair, remove the connection from the 

storage subsystem drive loop port to the OUT port of the last storage 

expansion enclosure and connect it to the OUT port of the new drive 

enclosure as shown in Figure 32 on page 85. 

__ Step 6.   Wait a few seconds; verify that the port bypass LEDs of the two ports in 

the connection between the storage subsystem drive loop port and the 

OUT port of the new drive enclosure are not lit. Using the DS4000 

Storage Manager Client Subsystem Management window, verify that 

the new drive enclosure does not indicate the drive enclosure lost 

redundancy path error. See the preceding step 4 for possible corrective 

actions, if needed.

Note:  The existing storage expansion enclosures will be shown with 

drive enclosure lost redundancy path errors until you 

establish the fibre channel cabling connection described in step 

7. 

__ Step 7.   In drive loop B, cable the new drive enclosure’s IN port to the OUT port 

of the last enclosure in the already functioning storage expansion 

enclosure drive loop as shown in Figure 33 on page 86. 

__ Step 8.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop B to which you have added a new connection are not lit. 

Using the DS4000 Storage Manager Client Subsystem Management 

window, verify that all of the drive enclosures in the DS4000 redundant 

drive loop pair to which the new enclosure was added does not report 

the drive enclosure lost redundancy path error.
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Connecting new storage expansion units at the beginning (top) of a 

drive loop 

It is possible to add new storage expansion enclosures to either the beginning (top) 

or end (bottom) of a functioning storage expansion enclosure drive loop. The 

cabling instructions illustrated in Figure 34 on page 88, Figure 35 on page 89, and 

Figure 36 on page 90 describe cabling a DS4000 EXP700 Storage Expansion 

Enclosure to the beginning (top) of a redundant drive loop of a functioning DS4300 

Storage Subsystem (model 60X or 60U). IBM does not recommend that you add 

storage expansion enclosures in this manner, especially if there is insufficient rack 

space to allow the methodical, uncluttered, and uniform fibre channel cabling of 

such new enclosures. Without proper planning, disadvantages of adding expansion 

units in this manner include cable management issues that contribute to avoidable 

troubleshooting difficulties. (For the diagram of a properly planned addition of a new 

expansion enclosure at the beginning (top) of a functioning storage expansion 

enclosure drive loop, see Figure 30 on page 74.) 
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Figure 33. Cabling a single drive enclosure to the end of a functioning drive loop (step 3 of 3)
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See “DS4000 Storage Subsystem drive loop schemes” on page 21. 

__ Step 1.   Insert the small form-factor pluggables (SFPs) or gigabit interface 

converters (GBICs) into only those ports you intend to use. Do not 

leave GBICs or SFPs inserted into port slots without connecting them to 

other ports using cables. 

__ Step 2.   Extend one of the drive loops (that is, drive loop B) in a DS4000 

Storage Subsystem redundant drive loop pair by connecting the IN port 

of the first (existing) storage expansion enclosure to the OUT port of the 

new storage expansion enclosure as shown in Figure 34 on page 88. 

Warning: Carefully reconfigure only one drive loop at a time, making 

sure that the drive loop that you modify is properly connected and in 

optimal state before you attempt to reconfigure another drive loop. 

Take this precaution to prevent the arrays from being inadvertently 

failed by the DS4000 Storage Subsystem controllers. This happens 

when two or more drives in the arrays cannot be reached through either 

drive loop in the redundant drive loop pair. 

__ Step 3.   Power on the newly added storage expansion enclosure unit. 

__ Step 4.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop B, now extended to the new storage expansion enclosure, 

are not lit. Using the DS4000 Storage Manager Client Subsystem 

Management window, verify that the new storage expansion enclosure 

is added and displayed in the Logical/Physical view of the window. 

Correct any errors before proceeding to step 5. For port bypass: 

__ a.   Verify that the SFPs and GBICs or fibre cables are in good 

condition. 

__ b.   Remove and reinsert SFPs, GBICs and fibre cables. 

__ c.   Ensure that the new drive expansion enclosure speed switch is 

set to the same speed as the existing drive expansion 

enclosures and the DS4000 Storage Subsystem speed setting. 

__ d.   Verify that the ESM is good by physically removing and 

swapping it with the other ESM in the same drive expansion 

enclosure. For enclosure ID conflict, set the drive expansion 

enclosure ID switch to values unique from the current settings in 

the existing drive expansion enclosures and storage server.

Call the IBM Help Center in your geography for assistance if the 

problems persist. 

__ Step 5.   In the other drive loop (that is, drive loop A) in a DS4000 Storage 

Subsystem redundant drive loop pair, remove the connection from the 

DS4000 Storage Subsystem drive loop port to the IN port of the first 

storage expansion enclosure and connect it to the IN port of the new 

drive enclosure as shown in Figure 35 on page 89. 

__ Step 6.   Wait a few seconds; verify that the port bypass LEDs of the two ports in 

the connection between the storage subsystem drive loop port and the 

IN port of the new drive enclosure are not lit. Using the DS4000 

Storage Manager Client Subsystem Management window, verify that 

the new drive enclosure does not indicate the drive enclosure lost 

redundancy path error. See the preceding step 4 for possible corrective 

actions, if needed. Until you establish the fibre channel cabling 

connection described in step 7 on page 88, the existing storage 

expansion enclosures will appear in the Storage Manager Client 

Subsystem Management window with drive enclosure lost 

redundancy path errors. 
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__ Step 7.   In drive loop A, cable the new drive enclosure’s OUT port to the IN port 

of the first enclosure in the already functioning storage expansion 

enclosure drive loop as shown in Figure 36 on page 90. 

__ Step 8.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop A to which you have added a new connection are not lit. 

Using the DS4000 Storage Manager Client Subsystem Management 

window, verify that all of the drive enclosures in the DS4000 redundant 

drive loop pair to which the new enclosure was added does not report 

the drive enclosure lost redundancy path error.
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Figure 34. Cabling a single drive enclosure to the beginning of a functioning drive loop (step 

1 of 3)
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Figure 35. Cabling a single drive enclosure to the beginning of a functioning drive loop (step 

2 of 3)
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Activity 6: Inserting hard drives and placing logical drives online 

Note:  When migrating hard drives from multiple DS4000 Storage Subsystems to a 

single DS4000 Storage Subsystem, move all of the hard drives from the first 

DS4000 Storage Subsystem as an independent “set” to the destination 

DS4000 Storage Subsystem. Before moving hard drives as a set from 

subsequent DS4000 Storage Subsystems, ensure that all of the hard drives 

from the previous set have been successfully transferred to the destination 

DS4000 Storage Subsystem. If you do not transfer hard drives as “sets” to 

the destination DS4000 Storage Subsystem, the newly relocated array may 

not appear in the Subsystem Management window. 

__ Step 1.   Insert the drives into the empty drive slots in the new enclosure in pairs. 

Wait (up to 5 minutes) until each drive pair has fully spun up and 

displayed in the DS4000 Storage Subsystem Management window 

before inserting the next drive pair. 

__ Step 2.   For each additional enclosure that you intend to migrate to the 

functioning drive loop pair, perform Activity 4: Installing and setting 

d
s
h
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2
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New EXP700 enclosures
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drive expansion enclosure c

d
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Figure 36. Cabling a single drive enclosure to the beginning of a functioning drive loop (step 

3 of 3)
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storage expansion unit IDs and speeds step 1 on page 81 through step 

3 on page 81, Activity 5: Cabling, powering on, and verifying storage 

expansion unit operation step 1 on page 82 through step 4 on page 83, 

and step 1 on page 90 of this activity. (See Figure 28 on page 72.) 

When you have completed adding enclosures, proceed to step 3. 

__ Step 3.   As the DS4000 Storage Subsystem recognizes the drives, it reads and 

displays the array and logical drive information on the drives in the 

Logical/Physical view of the DS4000 Storage Subsystem Management 

window. The storage subsystem places the array in offline state until it 

recognizes that you have inserted all of the drives that comprise the 

array. 

__ Step 4.   Once you insert all of the drives and the DS4000 Storage Subsystem 

recognizes them, change the state of the arrays or logical drives to the 

online state by right-clicking on the array name in the Storage 

Subsystem window and clicking Place → Online. 

If any of the following conditions persist, contact the IBM Help Center in 

your geography for assistance. 

v   The empty drive slot icon ( 

  

) displayed for the drive slot into which 

you inserted the migrating drive. 

v   The Failed unconfigured drive icon ( 

  

) or the Failed configured 

drive icon ( 

  

) displayed for the drive slot into which you inserted 

the migrating drive. 

v   Array configuration data on the drives you have added is incomplete. 

v   You cannot bring the array online.

Attention: Do not initialize a drive that you want to keep (by 

right-clicking its icon and selecting Initialize from the pull-down menu) if 

it contains configuration or user data. Initializing any of the drives in a 

defined array causes all hard drives that comprise an array to return to 

the Unconfigured Capacity storage pool, deleting their array definitions 

from the DS4000 Storage Subsystem configuration. The user data on 

such drives is lost. 

Result: Once the arrays are online, they are ready for you to configure 

and map to host servers. You might also then recreate flashcopies and 

remote mirror relationships. 

__ Step 5.   Use the DS4000 Storage Manager program to view the storage 

partitioning definitions and make any necessary corrections. 

__ Step 6.   The DS4000 Storage Subsystem that the drives are migrated from will 

display the logical drives that are defined in these drives as “missing 

LUNs.” In order to remove these “missing LUNs” entries, right-click on 

each entry and select Delete from the pull-down menu.
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Chapter  7.  Upgrading  a storage  subsystem  in  a functioning  

configuration  

Note:  When migrating hard drives from multiple DS4000 Storage Subsystems to a 

single DS4000 Storage Subsystem, move all of the hard drives from the first 

DS4000 Storage Subsystem as an independent ’set’ to the destination 

DS4000 Storage Subsystem. Before moving hard drives as a ’set’ from 

subsequent DS4000 Storage Subsystems, ensure that all of the hard drives 

from the previous ’set’ have been successfully transferred to the destination 

DS4000 Storage Subsystem. If you do not transfer hard drives as ’sets’ to 

the destination DS4000 Storage Subsystem, the newly relocated 

arrays/logical drives that are defined in these drives might not appear in the 

Subsystem Management window. 

This procedure details the steps that are required to upgrade a DS4000 Storage 

Subsystem in a functioning DS4000 configuration. Where either an identical or 

newer DS4000 Storage Subsystem model is involved, this upgrade involves only 

the replacement of the DS4000 storage controller to be upgraded. DS4000 storage 

expansion enclosures that had been attached to drives containing configuration 

data will be connected to the new DS4000 Storage Subsystem. The upgraded 

(original) DS4000 Storage Subsystem being replaced will be either scrapped or 

returned to operation (redeployed) at a later date with new drives and/or new 

storage expansion enclosures. 

Table 24 on page 95 associates each DS4000 Storage Subsystem with its 

supported replacements. 

 Important:  

 IBM Support is available to supply assistance and guidance to those who choose to 

upgrade a DS4000 Storage Subsystem. 

Preliminary considerations: Storage Subsystem upgrade 

While upgrading a DS4000 Storage Subsystem in a functioning configuration, 

remain aware of these important considerations: 

v   Observe proper ESD handling procedures when handling electronic equipment. 

See “Handling static-sensitive devices” on page 44 for additional information. 

v   IBM assigns premium feature entitlements only to specific DS4000 Storage 

Subsystems. In order to enable premium features in a replacement DS4000 

Storage Subsystem configuration that had been enabled in an original DS4000 

Storage Subsystem configuration, you must purchase appropriate entitlements for 

the replacement DS4000 Storage Subsystem. In addition, IBM assigns host kits 

only to specific DS4000 Storage Subsystems. You must also purchase the 

appropriate host kits for new DS4000 Storage Subsystems. 

v   See the appropriate DS4000 Storage Controller’s Installation and User’s Guide 

for information on the proper power on and power off sequences.

Note:  The remainder of this topic pertains to the original DS4000 Storage 

Subsystem that is designated for replacement as either the original or old 

DS4000 Storage Subsystem. 

This task requires that you shut down the DS4000 Storage Subsystem 

configuration. In addition, after the upgrade, premium features previously enabled in 
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the original DS4000 Storage Subsystem along with the enable-by-default premium 

features in the new DS4000 Storage Subsystem will automatically be placed in 

Out-of-Compliance state. Full data availability is retained, but you must generate 

new premium feature SAFE keys in order to re-enable premium features. Because 

IBM assigns premium feature entitlements only to specific DS4000 Storage 

Subsystems, you must purchase the appropriate entitlement for the new DS4000 

Storage Subsystem. You can generate new SAFE keys by contacting the IBM Help 

Center in your geography. Be sure to have the necessary proof of purchase. 

Alternately, you can also generate new SAFE keys by using instructions located at 

the following Web site: 

www.storage.ibm.com/pfeatures.html/ 

The new DS4000 Storage Subsystem controller identifies itself using a new 

Worldwide Name (WWN) that is different from the WWN used by the original 

DS4000 Storage Subsystem controller. For this reason, additional tasks might be 

required after the upgrade for any host applications or drivers that rely on the 

WWNs to identify logical drives defined in a given DS4000 Storage Subsystem. See 

your application program’s documentation, your driver’s user guide, or related 

documentation for detailed instructions on how to update the WWN of the DS4000 

Storage Subsystem in the application or driver. Additionally, review the readme file 

and the related IBM TotalStorage DS4000 Storage Manager Installation and 

Support Guide for information about any preparation tasks required in addition or 

operating system-specific restrictions. IBM TotalStorage DS4000 Storage Manager 

Installation and Support Guides are located at the following Web site: 

www.ibm.com/servers/storage/support/disk/ 

 Attention:  Depending on your existing DS4000 Storage Subsystem configuration, 

you might not be able to migrate all of your drives and storage expansion 

enclosures to a new DS4000 Storage Subsystem configuration. For example, you 

cannot migrate 1 Gbps EXP500 drive expansion enclosures from a FAStT500 

Storage Subsystem to a DS4300 Storage Subsystem or you cannot migrate a 

EXP700 drive expansion enclosures to the DS4800 Storage Subsystem before 

upgrading them to EXP710 drive expansion enclosures first. See Table 11 on page 

4 and Table 24 on page 95 for additional information on DS4000 Storage 

Subsystem and storage expansion enclosure compatibility. 

Contact your IBM technical support representative if you have questions regarding 

the compatibility of drives and drive expansion enclosures in an existing DS4000 

Storage Subsystem configuration with a new DS4000 Storage Subsystem 

configuration. 

If you are planning to consolidate drive expansion enclosures from multiple DS4000 

Storage Subsystem configurations into a single configuration with a new DS4000 

Storage Subsystem, perform the DS4000 Storage Subsystem replacement using 

drive expansion enclosures (and drives) from a given DS4000 Storage Subsystem 

configuration first. After the DS4000 Storage Subsystem migration has been 

successfully completed, use the procedure describe in Chapter 6 to migrate the 

drive expansion enclosures from the rest of the DS4000 Storage Subsystem 

configurations to the new DS4000 Storage Subsystem. 

Table 24 on page 95 associates each DS4000 Storage Subsystem with its 

supported replacements. Select View → Rotate View → Clockwise to optimize the 

appearance of this chart.
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Preliminary considerations: Firmware behavior during subsystem 

upgrade 

This section describes technical considerations regarding basic DS4000 Storage 

Subsystem controller firmware behavior during a DS4000 Storage Subsystem 

upgrade. It covers firmware behavior during system upgrade, where a new DS4000 

Storage Subsystem connects to functioning drives and storage expansion 

enclosures, as well as firmware behavior during system redeployment, where the 

original (old) DS4000 Storage Subsystem serves as a logically distinct entity, 

optionally, using some of the drives from the original system. 

DS4000 configuration behavior after upgrade and DS4000 Storage 

Subsystem replacement 

The new DS4000 Storage Subsystem that powers up in a functioning storage 

expansion enclosure configuration as part of the DS4000 Storage Subsystem 

upgrade process impacts the following areas of the DS4000 Storage Subsystem 

identification and premium features: 

1.   Worldwide Name (WWN): 

The worldwide names that were used by the original DS4000 Storage 

Subsystem prior to the upgrade are not returned when the upgrade is complete. 

Rather, the new DS4000 Storage Subsystem begins to advertise itself using 

WWNs that are based on an embedded unique identifier from its controller 

blades. This statement applies to both the port WWNs and the node WWNs. 

Consequently, any hosts that were aware of the logical drives in the original 

DS4000 Storage Subsystem based on the original DS4000 Storage 

Subsystem’s WWN values will likely be confused. The data volumes that 

resided behind the previously known WWNs now reside behind a seemingly 

new device with different WWNs. 

2.   Storage Array Identifier (SAI or SA Identifier): 

The storage array identifier, or SA Identifier, is the identification value used by 

the DS4000 Storage Manager host software (SMclient) to uniquely identify 

managed storage subsystems. The DS4000 Storage Manager SMclient program 

maintains SA Identifier records of previously discovered storage subsystems in 

the host resident file, which allows it to retain discovery information in a 

persistent fashion. This identifier is stored on DACstore, and persists across 

reboots, power cycles, and so on. The new DS4000 Storage Subsystem that 

powers up in a functioning storage expansion enclosure configuration as part of 

the DS4000 Storage Subsystem upgrade process continues to use the SA 

Identifier of the original DS4000 Storage Subsystem. 

3.   SAFE Premium Feature Identifier (SAFE ID) and Premium Feature Enable 

Status: 

The new DS4000 Storage Subsystem retains the SAFE ID of the original 

DS4000 Storage Subsystem. It also retains all of the features previously 

enabled on the original DS4000 Storage Subsystem. The feature states, 

however, are set to the Out-of-Compliance state. As a result, the system sends 

alert notices and establishes a Needs Attention condition. Also, any features 

that are marked in the new controller’s NVSRAM for automatic enablement are 

enabled, though their feature states are also set to Out-of-Compliance. You 

must re-enable the premium features by using premium feature SAFE key files. 

Because IBM assigns premium feature entitlements only to specific DS4000 

Storage Subsystems, you must purchase the appropriate entitlements for the 

new DS4000 Storage Subsystem to enable all of the premium features 

previously enabled on the original DS4000 Storage Subsystem.
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Redeployed DS4000 configuration behavior in an original (replaced) 

DS4000 Storage Subsystem 

 Important:  

 IBM Support is available to supply assistance and guidance to those who choose to 

redeploy a replaced DS4000 Storage Subsystem. 

 When you redeploy DS4000 Storage Subsystem hardware in another DS4000 

Storage Subsystem’s configuration, identification and premium features of the 

redeployed system behave somewhat differently from information described in 

“DS4000 configuration behavior after upgrade and DS4000 Storage Subsystem 

replacement” on page 97. This section describes those relevant behavioral 

differences. 

v   Worldwide Name (WWN): 

The worldwide names that were used by the original DS4000 Storage Subsystem 

are retained on the redeployed system. These values are based on an 

embedded unique identifier from the original DS4000 Storage Subsystem 

controller blades, and are stored in the NVSRAM on each controller board within 

the controller blade. Assuming that both controllers remain fully optimal after the 

redeployment, they recognize the stored value and continue to use it. 

Consequently, any hosts that were aware of the original DS4000 Storage 

Subsystem, based on its WWN values, will likely be confused. The logical drives 

that used to reside behind the previously-known WWNs no longer reside there, 

because they are now part of the new DS4000 Storage Subsystem, which has a 

different WWN. 

v   Storage Array Identifier or SA Identifier: 

If you return one or more drives that were originally moved from a DS4000 

Storage Subsystem back to the original DS4000 Storage Subsystem 

configuration before it is redeployed, it is possible that the SA Identifier that was 

used on the original DS4000 Storage Subsystem system will also be reused in 

the redeployed DS4000 Storage Subsystem configuration. Whether this occurs 

depends on the specific selection of transported drives. If certain conditions are 

met, however, the redeployed unit adopts the same SA Identifier that was 

retained by the new DS4000 Storage Subsystem. Otherwise, or in cases in which 

only new drives are used in the redeployed configuration, the redeployed 

DS4000 Storage Subsystem generates a new (and unique) SA Identifier that 

does not conflict with the one that was retained by the upgraded unit. 

If both the new and the redeployed DS4000 Storage Subsystem have the same 

SA Identifier, serious problems will result when you start the DS4000 Storage 

Manager SMclient program. Since there will be two DS4000 Storage Subsystems 

with the same SA Identifier, the DS4000 Storage Manager SMclient program will 

respond by arbitrarily selecting either the new or the redeployed DS4000 Storage 

Subsystem. The storage subsystem that the DS4000 Storage Manager SMclient 

program arbitrarily selects will be manageable, and the other storage subsystem 

will be unmanageable. 

v   SAFE Premium Feature Identifier (SAFE ID) 

Premium Feature Enable status: 

If you return any drives from an original DS4000 Storage Subsystem, along with 

the original DS4000 Storage Subsystem controllers, to a redeployed DS4000 

configuration, the SAFE ID of the original DS4000 Storage Subsystem will be 

retained, and all enabled features will remain fully enabled and compliant. 
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If you do not move any drives from an original DS4000 Storage Subsystem, it 

generates a new SAFE ID when redeployed, enabling none of the premium 

features from the original system. This new SAFE ID prevents the system from 

using any previously-acquired SAFE key files and re-enabling any premium 

features. In cases where the original DS4000 Storage Subsystem was pre-loaded 

with NVSRAM codes to enable certain premium features, NVSRAM codes are 

cleared from the DS4000 Storage Subsystem when redeployed and powered on 

for the first time. Therefore, premium features that were enabled as standard 

features do not reactivate on the redeployed system. The system retains full data 

availability, but you must generate new premium feature SAFE keys in order to 

re-enable premium features. You can generate new SAFE keys by contacting the 

IBM Help Center in your geography. Be sure to have the necessary proof of 

purchase. Alternately, you can also generate new SAFE keys by using 

instructions located at the following Web site: 

www.storage.ibm.com/pfeatures.html/ 

v   Controller IP addresses: 

When the DS4000 Storage Subsystem controllers were assigned static IP 

addresses, the IP addresses were stored in the NVSRAM of the controller board 

as well as the DACstore on the disks. If the new (replacement) DS4000 Storage 

Subsystem controllers were assigned the same IP addresses as the original 

(replaced) DS4000 Storage Subsystem controllers, network problem will arise 

when the original (replaced) DS4000 Storage Subsystem is eventually 

redeployed. The problem will occur because two devices have the same IP 

address in the Ethernet network. The best practice is to assign new unique IP 

addresses to new (replacement) DS4000 Storage Subsystem controllers instead 

of using the same IP addresses as the DS4000 controllers that they replace.

Upgrading storage subsystems in functioning DS4000 configurations 

Before you perform the following upgrade procedure, review and perform the steps 

detailed in Chapter 2, “Prerequisites to adding capacity and hard drive migration,” 

on page 35. 

Complete the following activities to upgrade your DS4000 Storage Subsystem: 

Activity 1: Preliminary activities 

Perform the following steps before you disconnect storage expansion enclosures 

from an original DS4000 Storage Subsystem that is being replaced to ensure a 

successful DS4000 Storage Subsystem upgrade. 

__ Step  1.   Verify that the original DS4000 Storage Subsystem’s controller 

firmware and NVSRAM are at the levels shown in Table 22 on page 

37. 

__ Step  2.   Verify that the firmware of the ESMs in the storage expansion 

enclosures is at the levels shown in Table 23 on page 38. 

__ Step  3.   Disable or delete any flashcopies of the logical drives. 

__ Step  4.   Delete any remote mirror relationships. 

__ Step  5.   If the arrays (logical drives) are not in optimal state, perform the steps 

necessary to bring the arrays (logical drives) into their optimal state 

before you attempt their migration. See the DS4000 Problem 

Determination Guide associated with your particular DS4000 hardware 

model or “Bringing storage subsystems and drive loops into optimal 

state” on page 41 for additional information on how to make this 

determination. 
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__ Step  6.   If the drive enclosures are not in optimal state, perform the steps 

necessary to bring them to optimal state before attempting migration. 

Perform the following steps to verify that the drive loops are in optimal 

state: 

__ Step a.   Physically trace the actual cable connections making sure 

that connections are properly modified and that the cable 

connectors are firmly inserted into the SFPs or GBICs. 

__ Step b.   Verify that the following LEDs are not lit or briefly flashed 

in the modified drive loop: 

v   ESM fault 

v   port bypass 

v   ID conflict

__ Step c.   Verify that the controller drive loop LED remains lit. If the 

controller drive loop LED becomes unlit momentary, there 

are problems in the drive loop and the LIPs are generated 

by the DS4000 Storage Subsystem controller. 

__ Step d.   In the DS4000 Storage Manager Client Subsystem 

Management window, verify that there are no loss of ESM 

path redundancy errors in the drives expansion enclosures 

that are not migrated. 

Do not modify the second drive loop in a redundant drive 

loop pair until you are sure that the first modified drive 

loop is operating optimally. See the DS4000 Problem 

Determination Guide associated with your particular 

DS4000 hardware model or “Bringing storage subsystems 

and drive loops into optimal state” on page 41 for 

additional information on how to make this determination.

__ Step  7.   Perform a full backup of the original DS4000 Storage Subsystem and 

schedule it for down time. This is necessary because you must power 

down the DS4000 Storage Subsystem configuration during the 

upgrade procedure. 

__ Step  8.   Save the DS4000 Storage Subsystem profile of the original DS4000 

Storage Subsystem configuration in a location other than that in which 

the logical drives are defined in the original DS4000 Storage 

Subsystem configuration. 

__ Step  9.   Stop all programs, services or processes in the host servers that 

access the logical drives defined in the migrated hard drives. Ensure 

that there are not any running background programs, services or 

processes that write data to the logical drives. (For example, Microsoft 

MSCS service periodically writes to the “Quorum” disk.) 

__ Step 10.   Unmount the file systems to flush I/O from the server cache to disks. 

Notes:  

a.   In a Microsoft Windows environment, remove the drive letter or the 

mount points of the mapped LUNs instead of unmounting the file 

systems. 

b.   Consult documentation associated with your particular operating 

system for detailed information regarding the Unmount procedure.

__ Step 11.   Place the arrays defined on the DS4000 Storage Subsystem in 

offline state. In the Storage Subsystem Management window, 

right-click on the name of the array and select Place → Offline. 
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__ Step 12.   Retrieve proofs of purchase for both the original and new DS4000 

Storage Subsystems and for the additional premium feature 

entitlements on the new and original DS4000 Storage Subsystems. 

IBM support personnel will require this information to regenerate 

premium feature SAFE key files that were enabled in the original 

DS4000 Storage Subsystem for use on the new DS4000 Storage 

Subsystem.

Activity 2: Powering off the original DS4000 Storage Subsystem 

Power down the original DS4000 Storage Subsystem and remove it from the 

DS4000 configuration. Do not redeploy this DS4000 Storage Subsystem in the 

same management domain as its upgrade (replacement) DS4000 Storage 

Subsystem until you regenerate its SA identifier using the instructions in 

“Redeploying the original (replaced) DS4000 Storage Subsystem” on page 103.

Note:  See the appropriate DS4000 Storage Controller’s Installation and User’s 

Guide for details on the correct power off sequence. 

Activity 3: Installing new DS4000 Storage Subsystems and setting 

minihub speed 

Install the new DS4000 Storage Subsystem. For DS4400 and DS4500 storage 

servers, set the drive minihub speed switch to the speed of the storage expansion 

enclosure ports to which they are connected. 

Note:  The DS4300 drive loop port operates only at 2 Gbps. If you migrate storage 

expansion enclosures from a 1 Gbps fibre channel environment to a 2 Gbps 

fibre channel environment, do not automatically change the storage 

expansion enclosure speed settings from 1 Gbps to 2 Gbps. Before you do, 

verify that each fibre channel drive involved is capable of 2 Gbps operation 

and that you have installed the latest firmware enabling them to work 

properly in a 2 Gbps fibre channel environment. 

 Important:  

 If the new DS4000 Storage Subsystem is either a FAStT200 or DS4300 Storage 

Subsystem, set the FAStT200 or DS4300 enclosure ID to a value unique from other 

EXP storage expansion enclosures in the fibre channel drive loop. These IDs are 

normally set to “0” at the factory. 

Activity 4: Making connections 

Insert the SFPs or GBICs into the DS4000 Storage Subsystem drive port slots and 

make the connections from the DS4000 Storage Subsystem to the storage 

expansion enclosures. For detailed information, see the appropriate DS4000 

Storage Controller’s Installation and User Guide. 

Ensure that all of the DS4000 storage expansion enclosures are set to the correct 

fibre channel speed for the drive loop of the new DS4000 Storage Subsystem. 

Activity 5: Powering on the expansion unit and setting IP addresses 

__ Step 1.   Verify that all of the storage expansion enclosures are powered on and 

in optimal state by examining the expansion enclosure LED states. 

Then, power on the new DS4000 Storage Subsystem. Using the 

DS4000 Storage Manager client program, verify that the DS4000 

Storage Subsystem is operational and that all of the drives are 
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recognized and in optimal state. See the DS4000 Problem 

Determination Guide associated with your particular DS4000 hardware 

model or “Bringing storage subsystems and drive loops into optimal 

state” on page 41 for additional information on how to make this 

determination.

Notes:  

a.   Your storage subsystem will identify the new DS4000 Storage 

Subsystem as the machine type it replaced until you download the 

appropriate NVSRAM file for the new storage subsystem. For 

example, if you replace a FAStT500 with a DS4500, the DS4500 will 

be reported as a FAStT500 until you download the appropriate 

NVSRAM file for the DS4500. 

b.   See the appropriate DS4000 Storage Controller’s Installation and 

User Guide for information on the proper power on sequence.

__ Step 2.   If the new DS4000 Storage Subsystem is managed out-of-band, 

perform the steps for setting the IP addresses for new DS4000 Storage 

Subsystem controllers defined in the IBM TotalStorage DS4000 Storage 

Manager Installation and Support Guide associated with your operating 

system environment. DS4000 Storage Manager Installation and Support 

Guides are located at the following Web site: 

www.ibm.com/servers/storage/support/disk/

Changing DS4000 Storage Subsystem IP addresses 

__ Step  1.   Open the Storage Manager client program’s Enterprise Management 

window.

Note:  The new DS4000 Storage Subsystem will have the same IP 

addresses as the DS4000 Storage Subsystem previously 

removed. 

__ Step  2.   Select the entry of the DS4000 Storage Subsystem that you want to 

manage. 

__ Step  3.   Right click and select Manage Device from the pop-up menu. The 

DS4000 Storage Manager Client Subsystem Management window 

opens. 

__ Step  4.   In the Logical/Physical view of the window, select Controller → 

Change → Network Configuration. The Change Network 

Configuration window opens. 

__ Step  5.   Select the Slot A tab. 

__ Step  6.   Select the radio button labeled Specify Configuration Setting. 

__ Step  7.   Type in the new IP address, subnet mask, and gateway information. 

__ Step  8.   Click OK. 

__ Step  9.   Select the Slot B tab. 

__ Step 10.   Select the radio button labeled Specify Configuration Setting. 

__ Step 11.   Type in the new IP address, subnet mask, and gateway information. 

__ Step 12.   Click OK to enable the IP address changes. 

__ Step 13.   Close the DS4000 Storage Manager Client Subsystem Management 

window. 

__ Step 14.   Select the entry of the DS4000 Storage Subsystem whose IP address 

you just changed. Right click. 

__ Step 15.   Select Remove Device from the pop-up menu. 

__ Step 16.   Click Yes to confirm removal of each device. 
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__ Step 17.   Select Edit → Add Device. The Add Device window opens. 

__ Step 18.   Type in the name or new IP address of controller A and close the 

window. 

__ Step 19.   Type in the name or new IP address of controller B and close the 

window.

Activity 6: Downloading firmware and NVSRAM and returning arrays 

online 

__ Step 1.   Use the DS4000 Storage Manager client program to download the 

firmware and the NVSRAM for the new DS4000 Storage Subsystem. 

__ Step 2.   Return the offline arrays to online state by right-clicking on the array 

and selecting Place → Online. If any of the following conditions persist, 

contact the IBM Help Center in your geography for assistance: 

v   The empty drive slot icon ( 

  

) displayed for the drive slot into which 

you inserted the migrating drive. 

v   The Failed unconfigured drive icon ( 

  

) or the Failed configured 

drive icon ( 

  

) displayed for the drive slot into which you inserted 

the migrating drive. 

v   Array configuration data on the drives you have added is incomplete. 

v   You cannot bring the array online.

Activity 7: Generating and applying premium feature SAFE key files 

Generate the new premium feature SAFE key files using the new DS4000 Storage 

Subsystem Feature Enable Identifier. Apply premium feature SAFE keys to remove 

Out-of-Compliance errors on enabled premium features. 

Result: You are now able to recreate flashcopies and remote mirror relationships, if 

required. 

Redeploying the original (replaced) DS4000 Storage Subsystem 

As a safety measure, force generation of a new SA Identifier when you redeploy an 

original (replaced) DS4000 Storage Subsystem. Use the controller shell commands 

to generate a new SA Identifier. To gain access to the controller shell, you will 

require a null modem cable and a terminal emulation program that is capable of 

sending a BREAK signal. The setting for the terminal emulation session is 8-N-1 (8 

data bits, no parity bit and 1 stop bit). Once you enter the controller shell, use the 

following command sequence to force the controller to generate a new SA Identifier: 

ld </Debug 

symbolGenerateNewSAIdentifier 

Note:  It is necessary for you to run this command sequence on only one controller.
Then, reset both DS4000 Storage Subsystem controllers and proceed with the 

normal DS4000 Storage Subsystem installation and configuration process. 

Accessing the DS4000 Storage Subsystem controller shell 

The following steps describe how to access the DS4000 Storage Subsystem 

controller shell using the terminal emulation program of your choice. One example 
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of such a terminal emulation program for which IBM neither makes nor implies a 

warranty, HyperTerminal, Private Edition; version 6.3 or higher, is available for your 

consideration at the following Web site: 

www.hilgraeve.com 

A generic version of steps involved in accessing the DS4000 Storage Subsystem 

controller shell using the terminal emulation program of your choice follows: 

__ Step  1.   Stop all I/O on the DS4000 Storage Subsystem. 

__ Step  2.   Connect a null modem serial cable from one of the DS4000 Storage 

Subsystem controller communications (COM) ports to a system with 

an available terminal emulator. 

__ Step  3.   Open the terminal emulation program of your choice, such as the 

HyperTerminal, Private Edition program and from the menu bar, click 

File → Properties → Configure. Establish the following property 

settings: 

v   Bits per second: 57600 

v   Data bits: 8 

v   Parity: None 

v   Stop Bit: 1 

v   Flow Control: None

__ Step  4.   Connect to the DS4000 Storage Subsystem controller shell by sending 

a BREAK signal. (If you are using the HyperTerminal, Private Edition 

program, press the Ctrl and BREAK keys simultaneously to send the 

BREAK signal.) 

__ Step  5.   Repeat step 4 until the following message displays: 

“Press the space bar for baud rate within 5 seconds.” 

__ Step  6.   Press the space bar within the time limit to establish the correct baud 

rate setting. 

__ Step  7.   Send another BREAK signal. The following message is displayed: 

“Press within 5 seconds: ESC for SHELL, BREAK for baud rate.” 

__ Step  8.   Press the ESC key within the time limit to access the controller shell. 

__ Step  9.   When prompted, type the following password: 

infiniti 

__ Step 10.   You are now accessing the DS4000 Storage Subsystem controller 

shell. 

 Important: 

 Be careful when entering commands in the DS4000 Storage 

Subsystem controller shell. Improper use of DS4000 Storage 

Subsystem controller shell commands could result in loss of 

configuration data.
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Notices  

This publication was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in 

other countries. Consult your local IBM representative for information on the 

products and services currently available in your area. Any reference to an IBM 

product, program, or service is not intended to state or imply that only that IBM 

product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe any IBM intellectual property right may be 

used instead. However, it is the user’s responsibility to evaluate and verify the 

operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 

described in this document. The furnishing of this document does not give you any 

license to these patents. You can send license inquiries, in writing, to: 

   IBM Director of Licensing 

   IBM Corporation 

   North Castle Drive 

   Armonk, NY 10504-1785 

   U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 

PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS 

OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 

OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 

PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or 

implied warranties in certain transactions, therefore, this statement may not apply to 

you. 

This information could include technical inaccuracies or typographical errors. 

Changes are periodically made to the information herein; these changes will be 

incorporated in new editions of the publication. IBM may make improvements and/or 

changes in the product(s) and/or the program(s) described in this publication at any 

time without notice. 

Any references in this publication to non-IBM Web sites are provided for 

convenience only and do not in any manner serve as an endorsement of those 

Web sites. The materials at those Web sites are not part of the materials for this 

IBM product, and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes 

appropriate without incurring any obligation to you. 

Trademarks  

The following terms are trademarks of International Business Machines Corporation 

in the United States, other countries, or both: 

 FlashCopy Netfinity 

IBM ServerProven® 

IBMLink TotalStorage
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Intel® is a trademark of Intel Corporation in the United States, other countries, or 

both. 

Java™ and all Java-based trademarks and logos are trademarks or registered 

trademarks of Sun Microsystems, Inc. in the United States, other countries, or both. 

Other company, product, or service names may be trademarks or service marks of 

others. 

Important notes 

Processor speeds indicate the internal clock speed of the microprocessor; other 

factors also affect application performance. 

CD-ROM drive speeds list the variable read rate. Actual speeds vary and are often 

less than the maximum possible. 

When referring to processor storage, real and virtual storage, or channel volume, 

KB stands for approximately 1000 bytes, MB stands for approximately 1 000 000 

bytes, and GB stands for approximately 1 000 000 000 bytes. 

When referring to hard disk drive capacity or communications volume, MB stands 

for 1 000 000 bytes, and GB stands for 1 000 000 000 bytes. Total user-accessible 

capacity may vary depending on operating environments. 

Maximum internal hard disk drive capacities assume the replacement of any 

standard hard disk drives and population of all hard disk drive bays with the largest 

currently supported drives available from IBM. 

Maximum memory may require replacement of the standard memory with an 

optional memory module. 

IBM makes no representation or warranties regarding non-IBM products and 

services that are ServerProven, including but not limited to the implied warranties of 

merchantability and fitness for a particular purpose. These products are offered and 

warranted solely by third parties. 

IBM makes no representations or warranties with respect to non-IBM products. 

Support (if any) for the non-IBM products is provided by the third party, not IBM. 

Some software may differ from its retail version (if available), and may not include 

user manuals or all program functionality. 

Electronic emission notices 

This section gives the electronic emission notices or statements for the United 

States and other countries or regions. 

Federal Communications Commission (FCC) statement 

Note: This equipment has been tested and found to comply with the limits for a 

Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 

designed to provide reasonable protection against harmful interference when the 

equipment is operated in a commercial environment. This equipment generates, 

uses, and can radiate radio frequency energy and, if not installed and used in 

accordance with the instruction manual, may cause harmful interference to radio 
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communications. Operation of this equipment in a residential area is likely to cause 

harmful interference, in which case the user will be required to correct the 

interference at his own expense. 

Properly shielded and grounded cables and connectors must be used in order to 

meet FCC emission limits. Properly shielded and grounded cables and connectors 

must be used in order to meet FCC emission limits.IBM is not responsible for any 

radio or television interference caused by using other than recommended cables 

and connectors or by using other than recommended cables and connectors or by 

unauthorized changes or modifications to this equipment. Unauthorized changes or 

modifications could void the user’s authority to operate the equipment. 

This device complies with Part 15 of the FCC Rules. Operation is subject to the 

following two conditions: (1) this device may not cause harmful interference, and (2) 

this device must accept any interference received, including interference that may 

cause undesired operation. 

Chinese class A compliance statement 

Attention:  This is a class A statement. In a domestic environment, this product 

might cause radio interference in which case the user might be required to take 

adequate measures. 

  

 

Industry Canada Class A emission compliance statement 

This Class A digital apparatus complies with Canadian ICES-003. 

Avis de conformité à la réglementation d’Industrie Canada 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du 

Canada. 

Australia and New Zealand Class A statement 

Attention:  This is a Class A product. In a domestic environment this product may 

cause radio interference in which case the user may be required to take adequate 

measures. 

United Kingdom telecommunications safety requirement 

Notice to Customers 

This apparatus is approved under approval number NS/G/1234/J/100003 for indirect 

connection to public telecommunication systems in the United Kingdom. 

European Union EMC Directive conformance statement 

This product is in conformity with the protection requirements of EU Council 

Directive 89/336/EEC on the approximation of the laws of the Member States 

relating to electromagnetic compatibility. IBM cannot accept responsibility for any 
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failure to satisfy the protection requirements resulting from a nonrecommended 

modification of the product, including the fitting of non-IBM option cards. 

This product has been tested and found to comply with the limits for Class A 

Information Technology Equipment according to CISPR 22/European Standard EN 

55022. The limits for Class A equipment were derived for commercial and industrial 

environments to provide reasonable protection against interference with licensed 

communication equipment. 

 Attention:   This is a Class A product. In a domestic environment this product may 

cause radio interference in which case the user may be required to take adequate 

measures. 

Taiwan  Class A warning statement 

  

 

Japanese Voluntary  Control Council for Interference (VCCI) statement 
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Glossary  

This glossary provides definitions for the 

terminology and abbreviations used in IBM 

TotalStorage DS4000 publications. 

If you do not find the term you are looking for, see 

the IBM Glossary of Computing Terms located at 

the following Web site: 

www.ibm.com/ibm/terminology 

This glossary also includes terms and definitions 

from: 

v   Information Technology Vocabulary by 

Subcommittee 1, Joint Technical Committee 1, 

of the International Organization for 

Standardization and the International 

Electrotechnical Commission (ISO/IEC 

JTC1/SC1). Definitions are identified by the 

symbol (I) after the definition; definitions taken 

from draft international standards, committee 

drafts, and working papers by ISO/IEC 

JTC1/SC1 are identified by the symbol (T) after 

the definition, indicating that final agreement 

has not yet been reached among the 

participating National Bodies of SC1. 

v   IBM Glossary of Computing Terms. New York: 

McGraw-Hill, 1994.

The following cross-reference conventions are 

used in this glossary: 

See Refers you to (a) a term that is the 

expanded form of an abbreviation or 

acronym, or (b) a synonym or more 

preferred term. 

See also 

Refers you to a related term.

Abstract Windowing Toolkit (AWT).  A Java graphical 

user interface (GUI). 

accelerated graphics port (AGP).  A bus specification 

that gives low-cost 3D graphics cards faster access to 

main memory on personal computers than the usual 

peripheral component interconnect (PCI) bus. AGP 

reduces the overall cost of creating high-end graphics 

subsystems by using existing system memory. 

access volume.  A special logical drive that allows the 

host-agent to communicate with the controllers in the 

storage subsystem. 

adapter.  A printed circuit assembly that transmits user 

data input/output (I/O) between the internal bus of the 

host system and the external fibre-channel (FC) link and 

vice versa. Also called an I/O adapter, host adapter, or 

FC adapter. 

advanced technology (AT) bus architecture.  A bus 

standard for IBM compatibles. It extends the XT bus 

architecture to 16 bits and also allows for bus 

mastering, although only the first 16 MB of main 

memory are available for direct access. 

agent.  A server program that receives virtual 

connections from the network manager (the client 

program) in a Simple Network Management 

Protocol-Transmission Control Protocol/Internet Protocol 

(SNMP-TCP/IP) network-managing environment. 

AGP.   See accelerated graphics port. 

AL_PA.   See arbitrated loop physical address. 

arbitrated loop.  One of three existing fibre-channel 

topologies, in which 2 - 126 ports are interconnected 

serially in a single loop circuit. Access to the Fibre 

Channel-Arbitrated Loop (FC-AL) is controlled by an 

arbitration scheme. The FC-AL topology supports all 

classes of service and guarantees in-order delivery of 

FC frames when the originator and responder are on 

the same FC-AL. The default topology for the disk array 

is arbitrated loop. An arbitrated loop is sometimes 

referred to as a Stealth Mode. 

arbitrated loop physical address (AL_PA).  An 8-bit 

value that is used to uniquely identify an individual port 

within a loop. A loop can have one or more AL_PAs. 

array.  A collection of fibre-channel or SATA hard drives 

that are logically grouped together. All the drives in the 

array are assigned the same RAID level. An array is 

sometimes referred to as a ″RAID set.″ See also 

redundant array of independent disks (RAID), RAID 

level. 

asynchronous write mode.  In remote mirroring, an 

option that allows the primary controller to return a write 

I/O request completion to the host server before data 

has been successfully written by the secondary 

controller. See also synchronous write mode, remote 

mirroring, Global Copy,Global Mirroring. 

AT.  See advanced technology (AT) bus architecture. 

ATA.  See AT-attached. 

AT-attached.  Peripheral devices that are compatible 

with the original IBM AT computer standard in which 

signals on a 40-pin AT-attached (ATA) ribbon cable 

followed the timings and constraints of the Industry 

Standard Architecture (ISA) system bus on the IBM PC 

AT computer. Equivalent to integrated drive electronics 

(IDE). 
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auto-volume transfer/auto-disk transfer (AVT/ADT).  

A function that provides automatic failover in case of 

controller failure on a storage subsystem. 

AVT/ADT.   See auto-volume transfer/auto-disk transfer. 

AWT.  See Abstract Windowing Toolkit. 

basic input/output system (BIOS).  The personal 

computer code that controls basic hardware operations, 

such as interactions with diskette drives, hard disk 

drives, and the keyboard. 

BIOS.   See basic input/output system. 

BOOTP.   See bootstrap protocol. 

bootstrap protocol (BOOTP).  In Transmission Control 

Protocol/Internet Protocol (TCP/IP) networking, an 

alternative protocol by which a diskless machine can 

obtain its Internet Protocol (IP) address and such 

configuration information as IP addresses of various 

servers from a BOOTP server. 

bridge.  A storage area network (SAN) device that 

provides physical and transport conversion, such as 

fibre channel to small computer system interface (SCSI) 

bridge. 

bridge group.  A bridge and the collection of devices 

connected to it. 

broadcast.  The simultaneous transmission of data to 

more than one destination. 

cathode ray tube (CRT).  A display device in which 

controlled electron beams are used to display 

alphanumeric or graphical data on an 

electroluminescent screen. 

client.  A computer system or process that requests a 

service of another computer system or process that is 

typically referred to as a server. Multiple clients can 

share access to a common server. 

command.  A statement used to initiate an action or 

start a service. A command consists of the command 

name abbreviation, and its parameters and flags if 

applicable. A command can be issued by typing it on a 

command line or selecting it from a menu. 

community string.  The name of a community 

contained in each Simple Network Management 

Protocol (SNMP) message. 

concurrent download.  A method of downloading and 

installing firmware that does not require the user to stop 

I/O to the controllers during the process. 

CRC.   See cyclic redundancy check. 

CRT.  See cathode ray tube. 

CRU.   See customer replaceable unit. 

customer replaceable unit (CRU).  An assembly or 

part that a customer can replace in its entirety when any 

of its components fail. Contrast with field replaceable 

unit (FRU). 

cyclic redundancy check (CRC).   (1) A redundancy 

check in which the check key is generated by a cyclic 

algorithm. (2) An error detection technique performed at 

both the sending and receiving stations. 

dac.  See disk array controller. 

dar.  See disk array router. 

DASD.   See direct access storage device. 

data striping.  See striping. 

default host group.  A logical collection of discovered 

host ports, defined host computers, and defined host 

groups in the storage-partition topology that fulfill the 

following requirements: 

v   Are not involved in specific logical drive-to-LUN 

mappings 

v   Share access to logical drives with default logical 

drive-to-LUN mappings

device type.  Identifier used to place devices in the 

physical map, such as the switch, hub, or storage. 

DHCP.   See Dynamic Host Configuration Protocol. 

direct access storage device (DASD).   A device in 

which access time is effectively independent of the 

location of the data. Information is entered and retrieved 

without reference to previously accessed data. (For 

example, a disk drive is a DASD, in contrast with a tape 

drive, which stores data as a linear sequence.) DASDs 

include both fixed and removable storage devices. 

direct memory access (DMA).   The transfer of data 

between memory and an input/output (I/O) device 

without processor intervention. 

disk array controller (dac).  A disk array controller 

device that represents the two controllers of an array. 

See also disk array router. 

disk array router (dar).  A disk array router that 

represents an entire array, including current and 

deferred paths to all logical unit numbers (LUNs) (hdisks 

on AIX). See also disk array controller. 

DMA.   See direct memory access. 

domain.  The most significant byte in the node port 

(N_port) identifier for the fibre-channel (FC) device. It is 

not used in the fibre channel-small computer system 

interface (FC-SCSI) hardware path ID. It is required to 

be the same for all SCSI targets logically connected to 

an FC adapter. 

DRAM.   See dynamic random access memory. 
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Dynamic Host Configuration Protocol (DHCP).  A 

protocol defined by the Internet Engineering Task Force 

that is used for dynamically assigning Internet Protocol 

(IP) addresses to computers in a network. 

dynamic random access memory (DRAM).   A 

storage in which the cells require repetitive application 

of control signals to retain stored data. 

ECC.   See error correction coding. 

EEPROM.   See electrically erasable programmable 

read-only memory. 

EISA.  See Extended Industry Standard Architecture. 

electrically erasable programmable read-only 

memory (EEPROM).  A type of memory chip which can 

retain its contents without consistent electrical power. 

Unlike the PROM which can be programmed only once, 

the EEPROM can be erased electrically. Because it can 

only be reprogrammed a limited number of times before 

it wears out, it is appropriate for storing small amounts 

of data that are changed infrequently. 

electrostatic discharge (ESD).  The flow of current 

that results when objects that have a static charge 

come into close enough proximity to discharge. 

environmental service module (ESM) canister.  A 

component in a storage expansion enclosure that 

monitors the environmental condition of the components 

in that enclosure. Not all storage subsystems have ESM 

canisters. 

E_port.  See expansion port. 

error correction coding (ECC).  A method for 

encoding data so that transmission errors can be 

detected and corrected by examining the data on the 

receiving end. Most ECCs are characterized by the 

maximum number of errors they can detect and correct. 

ESD.  See electrostatic discharge. 

ESM canister.  See environmental service module 

canister. 

EXP.  See storage expansion enclosure. 

expansion port (E_port).  A port that connects the 

switches for two fabrics. 

Extended Industry Standard Architecture (EISA).  A 

bus standard for IBM compatibles that extends the 

Industry Standard Architecture (ISA) bus architecture to 

32 bits and allows more than one central processing 

unit (CPU) to share the bus. See also Industry Standard 

Architecture. 

fabric.  A Fibre Channel entity which interconnects and 

facilitates logins of N_ports attached to it. The fabric is 

responsible for routing frames between source and 

destination N_ports using address information in the 

frame header. A fabric can be as simple as a 

point-to-point channel between two N-ports, or as 

complex as a frame-routing switch that provides multiple 

and redundant internal pathways within the fabric 

between F_ports. 

fabric port (F_port).  In a fabric, an access point for 

connecting a user’s N_port. An F_port facilitates N_port 

logins to the fabric from nodes connected to the fabric. 

An F_port is addressable by the N_port connected to it. 

See also fabric. 

FAStT MSJ.  See FAStT Management Suite Java. 

FAStT Management Suite Java (FAStT MSJ).  A 

diagnostic and configuration utility that can be used on 

Linux, Microsoft Windows, and Novell NetWare host 

systems. In Linux, it is also used with the QLRemote 

agent to define preferred and non-preferred paths for 

logical drives. 

FC.  See fibre channel. 

FC-AL.  See arbitrated loop. 

feature enable identifier.  A unique identifier for the 

storage subsystem, which is used in the process of 

generating a premium feature key. See also premium 

feature key. 

fibre channel (FC).  A set of standards for a serial 

input/output (I/O) bus capable of transferring data 

between two ports at up to 100 Mbps, with standards 

proposals to go to higher speeds. FC supports 

point-to-point, arbitrated loop, and switched topologies. 

Fibre Channel-Arbitrated Loop (FC-AL).  See 

arbitrated loop. 

Fibre Channel Protocol (FCP) for small computer 

system interface (SCSI).  A high-level fibre-channel 

mapping layer (FC-4) that uses lower-level fibre-channel 

(FC-PH) services to transmit SCSI commands, data, 

and status information between a SCSI initiator and a 

SCSI target across the FC link by using FC frame and 

sequence formats. 

field replaceable unit (FRU).  An assembly that is 

replaced in its entirety when any one of its components 

fails. In some cases, a field replaceable unit might 

contain other field replaceable units. Contrast with 

customer replaceable unit (CRU). 

FlashCopy.  A premium feature for DS4000 that can 

make an instantaneous copy of the data in a volume. 

F_port.  See fabric port. 

FRU.  See field replaceable unit. 

GBIC.   See gigabit interface converter 

gigabit interface converter (GBIC).   A transceiver that 

performs serial, optical-to-electrical, and 
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electrical-to-optical signal conversions for high-speed 

networking. A GBIC can be hot swapped. See also 

small form-factor pluggable. 

Global Copy.  Refers to a remote logical drive mirror 

pair that is set up using asynchronous write mode 

without the write consistency group option. This is also 

referred to as ″Asynchronous Mirroring without 

Consistency Group.″ Global Copy does not ensure that 

write requests to multiple primary logical drives are 

carried out in the same order on the secondary logical 

drives as they are on the primary logical drives. If it is 

critical that writes to the primary logical drives are 

carried out in the same order in the appropriate 

secondary logical drives, Global Mirroring should be 

used instead of Global Copy. See also asynchronous 

write mode, Global Mirroring, remote mirroring, Metro 

Mirroring. 

Global Mirroring.  Refers to a remote logical drive 

mirror pair that is set up using asynchronous write mode 

with the write consistency group option. This is also 

referred to as ″Asynchronous Mirroring with Consistency 

Group.″ Global Mirroring ensures that write requests to 

multiple primary logical drives are carried out in the 

same order on the secondary logical drives as they are 

on the primary logical drives, preventing data on the 

secondary logical drives from becoming inconsistent 

with the data on the primary logical drives. See also 

asynchronous write mode, Global Copy, remote 

mirroring, Metro Mirroring. 

graphical user interface (GUI).  A type of computer 

interface that presents a visual metaphor of a real-world 

scene, often of a desktop, by combining high-resolution 

graphics, pointing devices, menu bars and other menus, 

overlapping windows, icons, and the object-action 

relationship. 

GUI.   See graphical user interface. 

HBA.   See host bus adapter. 

hdisk.  An AIX term representing a logical unit number 

(LUN) on an array. 

host.  A system that is directly attached to the storage 

subsystem through a fibre-channel input/output (I/O) 

path. This system is used to serve data (typically in the 

form of files) from the storage subsystem. A system can 

be both a storage management station and a host 

simultaneously. 

host bus adapter (HBA).   An interface between the 

fibre-channel network and a workstation or server. 

host computer.  See host. 

host group.  An entity in the storage partition topology 

that defines a logical collection of host computers that 

require shared access to one or more logical drives. 

host port.  Ports that physically reside on the host 

adapters and are automatically discovered by the 

DS4000 Storage Manager software. To give a host 

computer access to a partition, its associated host ports 

must be defined. 

hot swap.  To replace a hardware component without 

turning off the system. 

hub.  In a network, a point at which circuits are either 

connected or switched. For example, in a star network, 

the hub is the central node; in a star/ring network, it is 

the location of wiring concentrators. 

IBMSAN  driver.  The device driver that is used in a 

Novell NetWare environment to provide multipath 

input/output (I/O) support to the storage controller. 

IC.   See integrated circuit. 

IDE.  See integrated drive electronics. 

in-band.  Transmission of management protocol over 

the fibre-channel transport. 

Industry Standard Architecture (ISA).  Unofficial 

name for the bus architecture of the IBM PC/XT 

personal computer. This bus design included expansion 

slots for plugging in various adapter boards. Early 

versions had an 8-bit data path, later expanded to 16 

bits. The ″Extended Industry Standard Architecture″ 

(EISA) further expanded the data path to 32 bits. See 

also Extended Industry Standard Architecture. 

initial program load (IPL).  The initialization procedure 

that causes an operating system to commence 

operation. Also referred to as a system restart, system 

startup, and boot. 

integrated circuit (IC).  A microelectronic 

semiconductor device that consists of many 

interconnected transistors and other components. ICs 

are constructed on a small rectangle cut from a silicon 

crystal or other semiconductor material. The small size 

of these circuits allows high speed, low power 

dissipation, and reduced manufacturing cost compared 

with board-level integration. Also known as a chip. 

integrated drive electronics (IDE).  A disk drive 

interface based on the 16-bit IBM personal computer 

Industry Standard Architecture (ISA) in which the 

controller electronics reside on the drive itself, 

eliminating the need for a separate adapter card. Also 

known as an Advanced Technology Attachment 

Interface (ATA). 

Internet Protocol (IP).  A protocol that routes data 

through a network or interconnected networks. IP acts 

as an intermediary between the higher protocol layers 

and the physical network. 
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Internet Protocol (IP) address.  The unique 32-bit 

address that specifies the location of each device or 

workstation on the Internet. For example, 9.67.97.103 is 

an IP address. 

interrupt request (IRQ).  A type of input found on 

many processors that causes the processor to suspend 

normal processing temporarily and start running an 

interrupt handler routine. Some processors have several 

interrupt request inputs that allow different priority 

interrupts. 

IP.  See Internet Protocol. 

IPL.  See initial program load. 

IRQ.   See interrupt request. 

ISA.  See Industry Standard Architecture. 

Java Runtime Environment (JRE).  A subset of the 

Java Development Kit (JDK) for end users and 

developers who want to redistribute the Java Runtime 

Environment (JRE). The JRE consists of the Java virtual 

machine, the Java Core Classes, and supporting files. 

JRE.  See Java Runtime Environment. 

label.  A discovered or user entered property value that 

is displayed underneath each device in the Physical and 

Data Path maps. 

LAN.   See local area network. 

LBA.   See logical block address. 

local area network (LAN).  A computer network 

located on a user’s premises within a limited geographic 

area. 

logical block address (LBA).  The address of a logical 

block. Logical block addresses are typically used in 

hosts’ I/O commands. The SCSI disk command 

protocol, for example, uses logical block addresses. 

logical partition (LPAR).  (1) A subset of a single 

system that contains resources (processors, memory, 

and input/output devices). A logical partition operates as 

an independent system. If hardware requirements are 

met, multiple logical partitions can exist within a system. 

(2) A fixed-size portion of a logical volume. A logical 

partition is the same size as the physical partitions in its 

volume group. Unless the logical volume of which it is a 

part is mirrored, each logical partition corresponds to, 

and its contents are stored on, a single physical 

partition. (3) One to three physical partitions (copies). 

The number of logical partitions within a logical volume 

is variable. 

logical unit number (LUN).  An identifier used on a 

small computer system interface (SCSI) bus to 

distinguish among up to eight devices (logical units) with 

the same SCSI ID. 

loop address.  The unique ID of a node in 

fibre-channel loop topology sometimes referred to as a 

loop ID. 

loop group.  A collection of storage area network 

(SAN) devices that are interconnected serially in a 

single loop circuit. 

loop port.  A node port (N_port) or fabric port (F_port) 

that supports arbitrated loop functions associated with 

an arbitrated loop topology. 

LPAR.  See logical partition. 

LUN.  See logical unit number. 

MAC.   See medium access control. 

management information base (MIB).  The 

information that is on an agent. It is an abstraction of 

configuration and status information. 

man  pages.  In UNIX-based operating systems, online 

documentation for operating system commands, 

subroutines, system calls, file formats, special files, 

stand-alone utilities, and miscellaneous facilities. 

Invoked by the man  command. 

MCA.   See micro channel architecture. 

media scan.  A media scan is a background process 

that runs on all logical drives in the storage subsystem 

for which it has been enabled, providing error detection 

on the drive media. The media scan process scans all 

logical drive data to verify that it can be accessed, and 

optionally scans the logical drive redundancy 

information. 

medium access control (MAC).  In local area 

networks (LANs), the sublayer of the data link control 

layer that supports medium-dependent functions and 

uses the services of the physical layer to provide 

services to the logical link control sublayer. The MAC 

sublayer includes the method of determining when a 

device has access to the transmission medium. 

Metro Mirroring.  This term is used to refer to a 

remote logical drive mirror pair which is set up with 

synchronous write mode. See also remote mirroring, 

Global Mirroring. 

MIB.  See management information base. 

micro channel architecture (MCA).   Hardware that is 

used for PS/2 Model 50 computers and above to 

provide better growth potential and performance 

characteristics when compared with the original 

personal computer design. 

Microsoft Cluster Server (MSCS).  MSCS, a feature 

of Windows NT Server (Enterprise Edition), supports the 

connection of two servers into a cluster for higher 

availability and easier manageability. MSCS can 

automatically detect and recover from server or 
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application failures. It can also be used to balance 

server workload and provide for planned maintenance. 

mini hub.  An interface card or port device that 

receives short-wave fiber channel GBICs or SFPs. 

These devices enable redundant fibre channel 

connections from the host computers, either directly or 

through a fibre channel switch or managed hub, over 

optical fiber cables to the DS4000 Storage Server 

controllers. Each DS4000 controller is responsible for 

two mini hubs. Each mini hub has two ports. Four host 

ports (two on each controller) provide a cluster solution 

without use of a switch. Two host-side mini hubs are 

shipped as standard. See also host port, gigabit 

interface converter (GBIC), small form-factor pluggable 

(SFP). 

mirroring.  A fault-tolerance technique in which 

information on a hard disk is duplicated on additional 

hard disks. See also remote mirroring. 

model.  The model identification that is assigned to a 

device by its manufacturer. 

MSCS.   See Microsoft Cluster Server. 

network management station (NMS).  In the Simple 

Network Management Protocol (SNMP), a station that 

runs management application programs that monitor 

and control network elements. 

NMI.   See non-maskable interrupt. 

NMS.   See network management station. 

non-maskable interrupt (NMI).  A hardware interrupt 

that another service request cannot overrule (mask). An 

NMI bypasses and takes priority over interrupt requests 

generated by software, the keyboard, and other such 

devices and is issued to the microprocessor only in 

disastrous circumstances, such as severe memory 

errors or impending power failures. 

node.  A physical device that allows for the 

transmission of data within a network. 

node port (N_port).  A fibre-channel defined hardware 

entity that performs data communications over the 

fibre-channel link. It is identifiable by a unique worldwide 

name. It can act as an originator or a responder. 

nonvolatile storage (NVS).  A storage device whose 

contents are not lost when power is cut off. 

N_port.  See node port. 

NVS.  See nonvolatile storage. 

NVSRAM.   Nonvolatile storage random access 

memory. See nonvolatile storage. 

Object Data Manager (ODM).   An AIX proprietary 

storage mechanism for ASCII stanza files that are 

edited as part of configuring a drive into the kernel. 

ODM.   See Object Data Manager. 

out-of-band.  Transmission of management protocols 

outside of the fibre-channel network, typically over 

Ethernet. 

partitioning.  See storage partition. 

parity check.  (1) A test to determine whether the 

number of ones (or zeros) in an array of binary digits is 

odd or even. (2) A mathematical operation on the 

numerical representation of the information 

communicated between two pieces. For example, if 

parity is odd, any character represented by an even 

number has a bit added to it, making it odd, and an 

information receiver checks that each unit of information 

has an odd value. 

PCI local bus.  See peripheral component interconnect 

local bus. 

PDF.  See portable document format. 

performance events.  Events related to thresholds set 

on storage area network (SAN) performance. 

peripheral component interconnect local bus (PCI  

local bus).  A local bus for PCs, from Intel, that 

provides a high-speed data path between the CPU and 

up to 10 peripherals (video, disk, network, and so on). 

The PCI bus coexists in the PC with the Industry 

Standard Architecture (ISA) or Extended Industry 

Standard Architecture (EISA) bus. ISA and EISA boards 

plug into an IA or EISA slot, while high-speed PCI 

controllers plug into a PCI slot. See also Industry 

Standard Architecture, Extended Industry Standard 

Architecture. 

polling delay.  The time in seconds between 

successive discovery processes during which discovery 

is inactive. 

port.  A part of the system unit or remote controller to 

which cables for external devices (such as display 

stations, terminals, printers, switches, or external 

storage units) are attached. The port is an access point 

for data entry or exit. A device can contain one or more 

ports. 

portable document format (PDF).  A standard 

specified by Adobe Systems, Incorporated, for the 

electronic distribution of documents. PDF files are 

compact; can be distributed globally by e-mail, the Web, 

intranets, or CD-ROM; and can be viewed with the 

Acrobat Reader, which is software from Adobe Systems 

that can be downloaded at no cost from the Adobe 

Systems home page. 

premium feature key.  A file that the storage 

subsystem controller uses to enable an authorized 

premium feature. The file contains the feature enable 

identifier of the storage subsystem for which the 
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premium feature is authorized, and data about the 

premium feature. See also feature enable identifier. 

private loop.  A freestanding arbitrated loop with no 

fabric attachment. See also arbitrated loop. 

program temporary fix (PTF).  A temporary solution or 

bypass of a problem diagnosed by IBM in a current 

unaltered release of the program. 

PTF.  See program temporary fix. 

RAID.   See redundant array of independent disks 

(RAID). 

RAID  level.  An array’s RAID level is a number that 

refers to the method used to achieve redundancy and 

fault tolerance in the array. See also array, redundant 

array of independent disks (RAID). 

RAID  set.  See array. 

RAM.   See random-access memory. 

random-access memory (RAM).   A temporary storage 

location in which the central processing unit (CPU) 

stores and executes its processes. Contrast with DASD. 

RDAC.   See redundant disk array controller. 

read-only memory (ROM).   Memory in which stored 

data cannot be changed by the user except under 

special conditions. 

recoverable virtual shared disk (RVSD).  A virtual 

shared disk on a server node configured to provide 

continuous access to data and file systems in a cluster. 

redundant array of independent disks (RAID).   A 

collection of disk drives (array) that appears as a single 

volume to the server, which is fault tolerant through an 

assigned method of data striping, mirroring, or parity 

checking. Each array is assigned a RAID level, which is 

a specific number that refers to the method used to 

achieve redundancy and fault tolerance. See also array, 

parity check, mirroring, RAID level, striping. 

redundant disk array controller (RDAC).   (1) In 

hardware, a redundant set of controllers (either 

active/passive or active/active). (2) In software, a layer 

that manages the input/output (I/O) through the active 

controller during normal operation and transparently 

reroutes I/Os to the other controller in the redundant set 

if a controller or I/O path fails. 

remote mirroring.  Online, real-time replication of data 

between storage subsystems that are maintained on 

separate media. The Enhanced Remote Mirror Option is 

a DS4000 premium feature that provides support for 

remote mirroring. See also Global Mirroring, Metro 

Mirroring. 

ROM.   See read-only memory. 

router.  A computer that determines the path of 

network traffic flow. The path selection is made from 

several paths based on information obtained from 

specific protocols, algorithms that attempt to identify the 

shortest or best path, and other criteria such as metrics 

or protocol-specific destination addresses. 

RVSD.  See recoverable virtual shared disk. 

SAI.  See Storage Array Identifier. 

SA Identifier.  See Storage Array Identifier. 

SAN.   See storage area network. 

SATA.  See serial ATA. 

scope.  Defines a group of controllers by their Internet 

Protocol (IP) addresses. A scope must be created and 

defined so that dynamic IP addresses can be assigned 

to controllers on the network. 

SCSI.  See small computer system interface. 

segmented loop port (SL_port).  A port that allows 

division of a fibre-channel private loop into multiple 

segments. Each segment can pass frames around as 

an independent loop and can connect through the fabric 

to other segments of the same loop. 

sense data.  (1) Data sent with a negative response, 

indicating the reason for the response. (2) Data 

describing an I/O error. Sense data is presented to a 

host system in response to a sense request command. 

serial ATA.  The standard for a high-speed alternative 

to small computer system interface (SCSI) hard drives. 

The SATA-1 standard is equivalent in performance to a 

10 000 RPM SCSI drive. 

serial storage architecture (SSA).  An interface 

specification from IBM in which devices are arranged in 

a ring topology. SSA, which is compatible with small 

computer system interface (SCSI) devices, allows 

full-duplex packet multiplexed serial data transfers at 

rates of 20 Mbps in each direction. 

server.  A functional hardware and software unit that 

delivers shared resources to workstation client units on 

a computer network. 

server/device events.  Events that occur on the server 

or a designated device that meet criteria that the user 

sets. 

SFP.  See small form-factor pluggable. 

Simple Network Management Protocol (SNMP).   In 

the Internet suite of protocols, a network management 

protocol that is used to monitor routers and attached 

networks. SNMP is an application layer protocol. 

Information on devices managed is defined and stored 

in the application’s Management Information Base 

(MIB). 
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SL_port.  See segmented loop port. 

SMagent.  The DS4000 Storage Manager optional 

Java-based host-agent software, which can be used on 

Microsoft Windows, Novell NetWare, HP-UX, and 

Solaris host systems to manage storage subsystems 

through the host fibre-channel connection. 

SMclient.  The DS4000 Storage Manager client 

software, which is a Java-based graphical user interface 

(GUI) that is used to configure, manage, and 

troubleshoot storage servers and storage expansion 

enclosures in a DS4000 storage subsystem. SMclient 

can be used on a host system or on a storage 

management station. 

SMruntime.  A Java compiler for the SMclient. 

SMutil.  The DS4000 Storage Manager utility software 

that is used on Microsoft Windows, HP-UX, and Solaris 

host systems to register and map new logical drives to 

the operating system. In Microsoft Windows, it also 

contains a utility to flush the cached data of the 

operating system for a particular drive before creating a 

FlashCopy. 

small computer system interface (SCSI).  A standard 

hardware interface that enables a variety of peripheral 

devices to communicate with one another. 

small form-factor pluggable (SFP).  An optical 

transceiver that is used to convert signals between 

optical fiber cables and switches. An SFP is smaller 

than a gigabit interface converter (GBIC). See also 

gigabit interface converter. 

SNMP.   See Simple Network Management Protocol and 

SNMPv1. 

SNMP  trap event.  (1) (2) An event notification sent by 

the SNMP agent that identifies conditions, such as 

thresholds, that exceed a predetermined value. See 

also Simple Network Management Protocol. 

SNMPv1.  The original standard for SNMP is now 

referred to as SNMPv1, as opposed to SNMPv2, a 

revision of SNMP. See also Simple Network 

Management Protocol. 

SRAM.   See static random access memory. 

SSA.  See serial storage architecture. 

static random access memory (SRAM).   Random 

access memory based on the logic circuit know as 

flip-flop. It is called static because it retains a value as 

long as power is supplied, unlike dynamic random 

access memory (DRAM), which must be regularly 

refreshed. It is however, still volatile, meaning that it can 

lose its contents when the power is turned off. 

storage area network (SAN).  A dedicated storage 

network tailored to a specific environment, combining 

servers, storage products, networking products, 

software, and services. See also fabric. 

Storage Array Identifier (SAI or SA Identifier).  The 

Storage Array Identifier is the identification value used 

by the DS4000 Storage Manager host software 

(SMClient) to uniquely identify each managed storage 

server. The DS4000 Storage Manager SMClient 

program maintains Storage Array Identifier records of 

previously-discovered storage servers in the host 

resident file, which allows it to retain discovery 

information in a persistent fashion. 

storage expansion enclosure (EXP).  A feature that 

can be connected to a system unit to provide additional 

storage and processing capacity. 

storage management station.  A system that is used 

to manage the storage subsystem. A storage 

management station does not need to be attached to 

the storage subsystem through the fibre-channel 

input/output (I/O) path. 

storage partition.  Storage subsystem logical drives 

that are visible to a host computer or are shared among 

host computers that are part of a host group. 

storage partition topology.  In the DS4000 Storage 

Manager client, the Topology view of the Mappings 

window displays the default host group, the defined host 

group, the host computer, and host-port nodes. The 

host port, host computer, and host group topological 

elements must be defined to grant access to host 

computers and host groups using logical drive-to-LUN 

mappings. 

striping.  Splitting data to be written into equal blocks 

and writing blocks simultaneously to separate disk 

drives. Striping maximizes performance to the disks. 

Reading the data back is also scheduled in parallel, with 

a block being read concurrently from each disk then 

reassembled at the host. 

subnet.  An interconnected but independent segment 

of a network that is identified by its Internet Protocol (IP) 

address. 

sweep method.  A method of sending Simple Network 

Management Protocol (SNMP) requests for information 

to all the devices on a subnet by sending the request to 

every device in the network. 

switch.  A fibre-channel device that provides full 

bandwidth per port and high-speed routing of data by 

using link-level addressing. 

switch group.  A switch and the collection of devices 

connected to it that are not in other groups. 

switch zoning.  See zoning. 

synchronous write mode.  In remote mirroring, an 

option that requires the primary controller to wait for the 
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acknowledgment of a write operation from the 

secondary controller before returning a write I/O request 

completion to the host. See also asynchronous write 

mode, remote mirroring, Metro Mirroring. 

system name.  Device name assigned by the vendor’s 

third-party software. 

TCP.   See Transmission Control Protocol. 

TCP/IP.  See Transmission Control Protocol/Internet 

Protocol. 

terminate and stay resident program (TSR 

program).  A program that installs part of itself as an 

extension of DOS when it is executed. 

topology.  The physical or logical arrangement of 

devices on a network. The three fibre-channel 

topologies are fabric, arbitrated loop, and point-to-point. 

The default topology for the disk array is arbitrated loop. 

TL_port.  See translated loop port. 

transceiver.  A device that is used to transmit and 

receive data. Transceiver is an abbreviation of 

transmitter-receiver. 

translated loop port (TL_port).  A port that connects 

to a private loop and allows connectivity between the 

private loop devices and off loop devices (devices not 

connected to that particular TL_port). 

Transmission Control Protocol (TCP).  A 

communication protocol used in the Internet and in any 

network that follows the Internet Engineering Task Force 

(IETF) standards for internetwork protocol. TCP 

provides a reliable host-to-host protocol between hosts 

in packed-switched communication networks and in 

interconnected systems of such networks. It uses the 

Internet Protocol (IP) as the underlying protocol. 

Transmission Control Protocol/Internet Protocol 

(TCP/IP).  A set of communication protocols that 

provide peer-to-peer connectivity functions for both local 

and wide-area networks. 

trap.  In the Simple Network Management Protocol 

(SNMP), a message sent by a managed node (agent 

function) to a management station to report an 

exception condition. 

trap recipient.  Receiver of a forwarded Simple 

Network Management Protocol (SNMP) trap. 

Specifically, a trap receiver is defined by an Internet 

Protocol (IP) address and port to which traps are sent. 

Presumably, the actual recipient is a software 

application running at the IP address and listening to 

the port. 

TSR program.  See terminate and stay resident 

program. 

uninterruptible power supply.  A source of power 

from a battery that is installed between a computer 

system and its power source. The uninterruptible power 

supply keeps the system running if a commercial power 

failure occurs, until an orderly shutdown of the system 

can be performed. 

user action events.  Actions that the user takes, such 

as changes in the storage area network (SAN), changed 

settings, and so on. 

worldwide port name (WWPN).   A unique identifier for 

a switch on local and global networks. 

worldwide name (WWN).  A globally unique 64-bit 

identifier assigned to each Fibre Channel port. 

WORM.   See write-once read-many. 

write-once read many (WORM).   Any type of storage 

medium to which data can be written only a single time, 

but can be read from any number of times. After the 

data is recorded, it cannot be altered. 

WWN.   See worldwide name. 

zoning.  (1) In Fibre Channel environments, the 

grouping of multiple ports to form a virtual, private, 

storage network. Ports that are members of a zone can 

communicate with each other, but are isolated from 

ports in other zones. (2) A function that allows 

segmentation of nodes by address, name, or physical 

port and is provided by fabric switches or hubs.
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Index  

A
access controller shell 103 

add
new hard drives 45 

single drive enclosure
final connection 65, 69, 72, 73, 85, 89 

first connection 63, 68, 83, 88 

second connection 64, 68, 84, 88 

storage expansion enclosures 59 

storage expansion units
license requirement 1 

used hard drives 45 

AppWare 36 

array
cannot bring online 55 

configuration data for drives incomplete 55 

RAID-level modification 42 

redundancy checking 42 

return online 103 

arrays, migrating 55 

attention 46, 55, 60, 74, 77, 80, 91 

automatically reset controllers 46, 47, 71, 75 

B
backup

logical drives 52, 79 

storage subsystem data 35, 100 

bag or container, ESD 93 

beginning of drive loop, connect storage expansion 

enclosures 66, 86 

BootWare 36 

bottom of drive loop, connect storage expansion 

enclosures 62, 82 

C
cable

connections 64, 65, 68, 69, 72, 73, 84, 85, 88, 89 

EXP500 to EXP700 7 

EXP700 to EXP500 7 

new storage expansion enclosures 61 

trace connections 80, 100 

cabling, incorrect 21 

cannot bring array online 55 

catastrophic failure 42 

change fibre channel speed settings 7 

change storage server IP address 102 

check drive firmware level 41 

check for configuration data 47 

on newly discovered drives 74 

Class A electronic emission notice 106 

clear configuration data 71 

compliant state 98 

Concepts Guide xxv 

concurrent firmware download 39 

configuration
behavior after replacement 97 

data, clear 71 

configuration data 51 

configure drives 47 

container or bag, ESD 93 

controller
blade, embedded unique identifier 98 

drive loop LED 80, 100 

firmware download during I/O 38 

firmware version 35 

by machine type 36 

by model number 36 

by NVSRAM version 36 

current 38 

firmware, verify level 35, 38, 52, 78, 99 

reset automatically 46, 47, 71, 75 

shell, accessing 103 

controller firmware 36 

controller IP addresses 99 

Copy Services Guide xxv 

copyback, logical drive 42 

customize storage partitioning information 52, 79 

D
DACstore 97, 99 

DCE 42 

delete
FlashCopy 79 

remote mirror relationships 79 

storage partition mappings 79 

disable drive migration settings 46, 70 

become effective 47 

DisableDriveMigration.scr script 48 

documentation
DS4000 Storage Manager xxv 

DS4000-related documents xxvi 

DS4100 Storage Server xxiii 

DS4300 Fibre Channel Storage Server xxii 

DS4400 Fibre Channel Storage Server xxi 

DS4500 Fibre Channel Storage Server xix 

DS4800 Storage Subsystem xxiv 

download firmware with I/O 39 

downloading drive firmware 39 

drive displays as unconfigured 74 

drive expansion enclosure weight 80 

drive firmware
downloading 39 

drive firmware download 39 

drive firmware levels, determining 30 

drive firmware, level 41 

drive ID and model, determining 32 

drive loop
optimal state 41 

pairs, maximum allowable 1 

speed change procedure 7 

drive loop pairs, maximum 9 
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drive loop schemes 21 

drive loop state, determine 35 

drive loops A and B 62, 63, 67, 68, 82, 83, 87, 88 

drive migration
prerequisites 35 

settings
disable 46, 70 

enable 74 

re-enable 46, 71 

drives
CRU assembly 53 

do not appear marked as Failed 55 

do not display 55 

maximum allowable 1 

remove
configuration data 46 

will not spin up 45, 51, 59 

DS4000 Hardware Maintenance Manual xxvi 

DS4000 Problem Determination Guide xxvi, 99 

DS4000 Quick Start Guide xxvi 

DS4000 Storage Manager
documents xxv 

related documents xxvi 

DS4000 Storage Manager publications 32 

DS4000 Storage Subsystem
firmware 36 

NVSRAM 36 

profile 36 

DS4000 support
Web site 38 

DS4000/FAStT product renaming xvii 

DS4100 dual controller replacement with single 

controller 96 

DS4100 single controller replacement with dual 

controller 96 

DS4100 Storage Server library xxiii 

DS4300
1 Gbps fibre channel drives 59 

enclosure IDs 61 

Storage Subsystem firmware and NVSRAM 36 

Turbo Storage Subsystem firmware and 

NVSRAM 36 

DS4300 Fibre Channel Storage Server library xxii 

DS4300 Storage Subsystem migration 96 

DS4400 Storage Server library xxi 

DS4400 Storage Subsystem firmware and 

NVSRAM 36 

DS4500 Fibre Channel Storage Server library xix 

DS4500 Storage Subsystem firmware and 

NVSRAM 36 

DS4800 Storage Subsystem library xxiv 

dual controller replacement with single controller 96 

dual drive loop 1 

DVE 42 

dynamic
capacity expansion, DCE 42 

volume expansion, DVE 42 

E
electronic emission Class A notice 106 

Electronic emission notices
Australia and New Zealand Class A statement 107 

European Union EMC Directive conformance 

statement 107 

Federal Communications Commission (FCC) 

statement 106 

Industry Canada Class A emission compliance 

statement 107 

Japanese Voluntary Control Council for Interference 

(VCCI) statement 108 

Taiwanese Class A warning statement 108 

United Kingdom telecommunications safety 

requirement 107 

electrostatic discharge (ESD) bags 54 

electrostatic discharge (ESD) procedure 45 

electrostatic discharge procedure 44 

empty drive icon 55 

emulation program, sample 103 

EnableDriveMigration.scr script 47, 74 

enclosure ID 26 

end of drive loop, connect storage expansion 

enclosures 62, 82 

environmental service module (ESM) firmware 7 

errors
drive enclosure lost redundancy path 63, 67, 68, 

83, 87, 88 

loss of ESM path redundancy 80, 100 

management event log (MEL) 35 

out-of-compliance 103 

ESD bag or container 81, 93 

ESD procedures 44 

ESM Fault LED 80, 100 

ESM firmware
EXP500 38 

EXP700 38 

upgrade during I/O 36 

version, current 38 

version, upgrade 38 

version, upgrade during I/O 38 

ESM firmware levels, determining 30 

event logs, interpreting 41 

execute script 46, 47, 70, 74 

EXP100
ID settings 27 

EXP500
and EXP700 in a redundant drive loop pair 6 

cabling 7 

drive loop pair maximum 9 

ESM firmware 38 

ID settings 27 

ID switch location 61, 81 

maximum per drive loop pairs 9 

EXP500 and EXP700 enclosure ID settings 29 

EXP500 drive expansion enclosure accommodation 96 

EXP700
1 Gbps fibre channel drives 59 

and EXP500 in a redundant drive loop pair 6 

cabling 7 

drive loop pair maximum 9 

ESM firmware 38 

ID settings 28 
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EXP700 (continued)
ID switch location 61, 81 

maximum per drive loop pairs 9 

EXP700 and EXP710 enclosure ID settings 29 

EXP700 migration to DS4300 96 

expansion enclosure
ID setting 26 

expansion enclosure and storage server 

compatibility 4 

expansion enclosure compatibility, mixed 3 

expansion enclosure speed setting 97, 101 

expansion enclosures
cabling mixed 7 

ESM firmware version 38 

ID setting 61, 81, 101 

LED state 101 

migrate 77 

speeds restriction 6 

expansion unit enclosure speed setting 81 

expansion unit firmware levels, determining 30 

expansion units
ID setting 81 

migrate 77 

external drive enclosure, benefits 3 

F
Failed icons 55 

false storage subsystem identification, example 102 

FAStT/DS4000 product renaming xvii 

FAStT200
enclosure IDs 61 

HA Storage Server firmware and NVSRAM 36 

Storage Subsystem firmware and NVSRAM 36 

FAStT500 RAID Controller Enclosure firmware and 

NVSRAM 36 

FC Worldwide Name (WWN) 94 

FCC Class A notice 106 

fibre channel
connections cabling 64, 65, 68, 69, 72, 73, 84, 85, 

88, 89 

drive firmware 39 

insert drives 45, 46, 51, 55, 59, 60, 71, 90 

remove connection 63, 67, 83, 87 

trace cable connections 80, 100 

Worldwide Name (WWN) storage 94, 97, 98 

fibre channel controller replacement with SATA 96 

firmware
compatibility 36 

controller 36 

controller and NVSRAM levels 52, 78 

controller, NVSRAM, and ESM levels 35 

current 36 

download 103 

ESM, version by expansion enclosure 38 

updates 38 

verify controller and NVSRAM levels 99 

firmware and NVSRAM
DS4300

Storage Subsystem 36 

Turbo Storage Subsystem 36 

firmware and NVSRAM (continued)
DS4400 Storage Subsystem 36 

DS4500 Storage Subsystem 36 

FAStT200
HA Storage Subsystem 36 

Storage Subsystem 36 

FAStT500 RAID Controller Enclosure 36 

firmware download with I/O 39 

firmware levels, determining 30 

FlashCopy
delete 53, 79, 99 

recreate 55, 91, 103 

flush I/O 36, 100 

flush server-cached I/O 36 

force generation SA Identifier 103 

G
GBIC 61, 80, 100, 101 

generate
new premium feature SAFE keys 93, 103 

SA Identifier 103 

gigabit interface converter 61, 80, 100, 101 

glossary 109 

grouping expansion enclosures 6 

H
handling static-sensitive devices 44 

hard drives
add new 45 

add storage expansion enclosures containing 59 

add used 45 

ID/Model Number 45, 51, 59 

migrate 51 

newly discovered 71 

prerequisites 35 

removal 53 

will not spin up 45, 51, 59 

hardware installation process xviii 

help
center 41 

online 42 

prevent data loss 42 

host group names, unique 52, 79 

host kits, purchase 97 

host names, unique 52, 79 

host ports, unique 52, 79 

HyperTerminal, Private Edition 103 

I
I/O, flush 36, 100 

IBM
Help Center, contact 41 

IBM Safety Information xxvi 

IBMSAN.CDM multi-path software 38 

icon
empty drive 55 

Failed 55, 91, 103 

Subsystem Management window 55, 91, 103 

 

Index 121



ID
conflict LED 80, 100 

switch location 61 

ID settings 27 

ID/model number, hard drive 45, 51, 59 

identify
1 Gbps FC drives 45, 51, 59 

firmware updates 38 

ignore
configuration data setting 46 

configuration information 70 

impact of new storage subsystem
on identification 97 

on premium features 97 

IN port 62, 63, 67, 82, 83, 87 

incorrect cabling schemes 21 

initialize a drive 91 

insert drives 71, 90 

insert fibre channel drives 55 

insert SATA drives 55 

installation planning xviii 

installation process xviii 

intermix expansion units 6 

intermixed enclosure ID settings 29 

intermixing EXP500s and EXP700s 7 

intermixing EXP700s and EXP710s 9 

intermixing storage expansion enclosures 3 

IP address, change 102 

IP addresses 99 

L
LED

controller drive loop 80, 100 

expansion enclosure states 101 

ID conflict 80, 100 

port bypass 80, 100 

license requirements 1 

Linux failover adapter driver
multi-path software 38 

listing
DisableDriveMigration.scr script file 48 

EnableDriveMigration.scr script file 47 

load script 46, 47, 74 

logical drive
backup 52, 79 

copyback 42 

creation, FlashCopy 42 

creation, VolumeCopy 42 

dynamic capacity expansion 42 

flashcopies, delete 53 

reconstruction 42 

segment size modification 42 

sparing 42 

synchronization, remote mirror 42 

verify name 52 

Loop Initialization Primitive (LIP) 80 

loss of ESM path redundancy error 80, 100 

M
machine type 1722

Model 60U 1, 36 

Model 60X 1, 36 

Model 6LU 1, 36 

Model 6LX 1, 36 

machine type 1740
Model 1RU 38 

Model 1RX 38 

machine type 1742
Model 1RU 1, 36 

Model 1RX 1, 36 

Model 90U 1, 36 

Model 90X 1, 36 

machine type 3542
Model 1RU 1, 36 

Model 1RX 1, 36 

Model 2RU 1, 36 

Model 2RX 1, 36 

machine type 3552
Model 1RU 1, 36 

Model 1RX 1, 36 

machine type 3560
Model 1RU 38 

Model 1RX 38 

management event log errors 35 

map drives 47 

maximum
allowable drives 1 

drive expansion enclosures 9 

drives per redundant drive loop pair 9 

storage expansion enclosures 9 

MEL errors 35 

menu option
Advanced → Reset Controller 46, 47, 75 

Array → Check Redundancy 42 

Execute 71, 75 

Script 47, 74 

File → Load Script 46, 47, 70, 74 

Initialize 55 

Place → Offline 53, 80, 100 

Place → Online 55, 91 

Tools → Verify and Execute 46, 47, 71, 75 

migrate drives 39 

migrate hard drives 51 

migrate storage expansion enclosures with drives 77 

migrating arrays 55 

migrating from 2 Gbps to 1 Gbps configuration 96 

migration to DS4300 Storage Subsystem 96 

minihub speed, set 101 

mix expansion enclosures 6 

mix expansion units 6 

mixed configuration
EXP500 to EXP700 cabling 7 

EXP700 to EXP500 cabling 7 

model and product ID, determining 32 

model number
DS4000 EXP500

1RU 38 

1RX 38 
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model number (continued)
DS4000 EXP700

1RU 38 

1RX 38 

DS4000 EXP710
710 38 

DS4100
100 36 

DS4300
60U 1, 36 

60X 1, 36 

DS4300 Single Controller
6LU 1, 36 

6LX 1, 36 

DS4300 Turbo
60U 1, 36 

60X 1, 36 

DS4400
1RU 1, 36 

1RX 1, 36 

DS4500
90U 1, 36 

90X 1, 36 

FAStT200
1RU 1, 36 

1RX 1, 36 

2RU 1, 36 

2RX 1, 36 

FAStT500
1RU 1, 36 

1RX 1, 36 

move drives 39 

multi-path software
IBMSAN.CDM 38 

Linux failover adapter driver 38 

RDAC 38 

N
Needs Attention

condition 97 

state 41 

new storage subsystem impact 97 

notes, important 106 

notices
electronic emission 106 

FCC, Class A 106 

null modem serial cable 103 

NVSRAM
clear codes 98 

codes pre-loaded 98 

DS4000 Storage Subsystem 36 

stores IP addresses 99 

verify level 35, 38, 78, 99 

version, by controller firmware version 36 

NVSRAM and controller firmware
DS4300

Storage Subsystem 36 

Turbo Storage Subsystem 36 

DS4400 Storage Subsystem 36 

DS4500 Storage Subsystem 36 

NVSRAM and controller firmware (continued)
FAStT200

HA Storage Subsystem 36 

Storage Subsystem 36 

FAStT500 RAID Controller Enclosure 36 

O
offline state 55, 80, 90, 100 

online help xviii, 42 

online state 55, 91, 103 

optimal state 35, 41, 52, 53, 55, 60, 77, 79, 80, 99, 

101 

orientation
hard drives 54 

OUT port 62, 63, 67, 82, 83, 87 

out-of-band storage server IP addresses 102 

out-of-compliance state 93, 97 

P
place drive online 90 

port bypass LED 63, 67, 68, 80, 83, 87, 88, 100 

post-replacement configuration behavior 97 

post-upgrade configuration behavior 97 

power on
drive expansion enclosure 7 

storage expansion enclosure 7 

storage server 7 

premium feature
enable status 97, 98 

generate new SAFE keys 93, 103 

IBM assigns entitlements 97 

identifier 97 

impact of new storage subsystem on 97 

re-enable 97 

premium features
enabled as standard 98 

prerequisites
adding capacity 35 

drive migration 35 

prevent
data loss 43, 46, 74 

shock 26, 54, 80 

procedure
access controller shell 103 

add new hard drives 45 

add storage expansion enclosures 59 

disable drive migration settings 46 

electrostatic discharge (ESD) 45 

enable drive migration settings 46 

flush server-cached I/O 36 

migrate hard drives 51 

migrate storage expansion enclosures with 

drives 77 

redeploy original (replaced) storage server 103 

save a module profile report 42 

save a storage subsystem profile 42 

unmount file systems 36 

upgrade
storage subsystem 93, 99 
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product ID and model, determining 32 

profile
DS4000 Storage Subsystem 42 

proofs of purchase 93, 98, 100 

publications, DS4000 Storage Manager 32 

purchase
entitlements 1, 93, 97 

host kits 93, 97 

Q
Quorum disk 100 

R
RAID-level modification 42 

re-enable
drive migration settings 46 

premium features 93, 97 

Read_Link_Status
function 35, 41 

readme file 38, 60, 77, 94 

recommended cabling scheme 21 

reconstruction, logical drive 42 

Recovery Guru 35 

redeploy original (replaced) storage server 103 

redistributing data 55 

redundancy checking 42 

redundant disk array controller [RDAC]
multi-path software 38 

redundant drive loop pair 1, 9 

remote mirror
logical drive synchronization 42 

relationships
delete 79, 99 

recreate 91, 103 

remove 53 

remove
configuration data 46 

connection 63, 67, 83, 87 

drive expansion enclosure 80 

drives 52, 80 

hard drives 53 

out-of-compliance errors 103 

remote mirror relationships 53, 79 

storage components 45, 51, 59, 77 

storage expansion enclosure 80 

storage subsystem 99, 101 

renaming xvii 

reordering data 55 

replacement subsystems 94 

reset
controllers 47, 70, 103 

automatically 71 

controllers automatically 75 

storage subsystem setting 46, 47 

restore a storage subsystem configuration 42 

S
SA Identifier 97 

force generation 103 

SAFE
ID 97 

key 100 

Premium Feature Identifier 97 

safety information iii 

SAI 97 

SATA
insert drives 51, 55, 90 

Worldwide Name (WWN) storage 97, 98 

SATA controller replacement with fibre channel 96 

Saving a module profile report and state capture 

information to help prevent data loss 42 

schedule upgrades 38, 60, 77, 100 

script
DisableDriveMigration.scr 48 

editor window 47, 70, 74 

EnableDriveMigration.scr 47 

execute 46, 47, 70, 74 

load 46, 47, 70, 74 

set drive expansion enclosure ID 81 

set enclosure ID 26 

set minihub speed 101 

set storage expansion enclosure ID 81 

setting
out-of-band storage server IP addresses 102 

settings
disable drive migration

become effective 47 

drive migration
disable 46, 70 

enable 74 

re-enable 46, 71 

expansion enclosure speed 101 

fibre channel speed 7 

SFP 61, 80, 100, 101 

shutdown
drive expansion enclosure 7 

storage expansion enclosure 7 

storage server 7 

single controller replacement with dual controller 96 

small form-factor pluggable 61, 80, 100, 101 

SMclient 97 

software compatibility
Web site 38 

software installation process xviii 

sparing, logical drive 42 

speed restriction
drive expansion enclosure 6 

storage expansion enclosure 6 

speed settings
drive loop 7 

expansion enclosure 101 

state
compliant 98 

expansion enclosure LED 101 

Needs Attention 41 

offline 52, 55, 80, 90, 100 

online 55, 91, 103 

 

124 Adding and Migrating Drives and Expansion Enclosures to DS4000 Storage Servers



state (continued)
optimal 35, 41, 45, 52, 53, 55, 60, 77, 79, 80, 99, 

101 

out-of-compliance 93, 97 

static IP address
storage 99 

static-sensitive devices, handling 44 

storage
components removal 77 

DS4000 Storage Subsystem profile 36, 44 

static IP address 99 

Worldwide Name (WWN) 97, 98 

Storage Array Identifier 97 

storage expansion enclosure weight 80 

storage expansion enclosures, intermixing 3 

Storage Manager
installation and support guide 38, 42, 60, 77, 94, 

102 

installation CD 46, 47, 70, 74 

Storage Manager version 8.x drive firmware, 

download 41 

Storage Manager version 9.1x drive firmware 

download 39 

Storage Manager version 9.1x drive firmware, 

download 39 

storage partition mappings
delete 79 

storage partitioning definitions, view 55, 91 

storage pool, unconfigured capacity 91 

storage server
configuration migration 42 

controller firmware behavior after upgrade 97 

controller firmware version 36 

physical configuration, alter 45, 51, 59, 77 

status 41 

upgrade NVSRAM version 36 

storage server and expansion enclosure 

compatibility 4 

storage server firmware levels, determining 30 

storage subsystem
configuration behavior after

redeployment 98 

upgrade and replacement 97 

false identification example 102 

identification 97 

optimal state 41 

redeploy 103 

restore configuration 42 

storage subsystem profile
restore 42 

save 36, 42 

storage 36, 42 

storage subsystem replacements 94 

striping data 55 

Subsystem Management window icon 55 

subsystem replacements, DS4000 94 

supported replacements, DS4000 94 

suspend I/O from hosts during drive firmware 

upgrade 39 

switches
ID 61 

synchronization
remote mirror logical drive 42 

T
technical background on storage server controller 

firmware behavior 97 

terminal emulation program, sample 103 

top of drive loop, connect storage expansion 

enclosures 66, 86 

trace cable connections 80, 100 

U
unconfigured capacity storage pool 91 

United States electronic emission Class A notice 106 

United States FCC Class A notice 106 

unmount file systems 36, 52, 79, 100 

upgrade
drive firmware 39 

ESM firmware 38 

schedule 36, 38, 60, 77, 100 

storage subsystem 99 

important considerations 93 

in functioning configuration 93, 99 

used hard drives 45 

W
Web site 43 

DS4000 documentation 33 

DS4000 support 38 

software compatibility 38 

support 43 

weight of drive expansion enclosure 80 

window
Client Subsystem Management 42, 63, 67, 68, 80, 

83, 87, 88, 100 

Enterprise Management 46, 47, 70, 74 

Load Script file selection 46, 47, 70, 74 

Read_Link_Status 41 

Reset Controller 46, 47, 71, 75 

script editor 46, 47, 70, 74 

Storage Subsystem Management 42, 46, 47, 52, 

55, 71, 75, 80, 90, 100, 103 

WWN 94, 97, 98
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Readers’  comments  —  we  would  like  to hear  from  you.  

IBM  TotalStorage DS4000 

Hard Drive and Storage Expansion Enclosure Installation and Migration Guide 

 Publication No.  GC26-7704-01 

 Overall, how satisfied are you with the information in this book? 

 

 Very Satisfied Satisfied Neutral Dissatisfied Very Dissatisfied 

Overall satisfaction h h h h h

 How  satisfied are you that the information in this book is: 

 

 Very Satisfied Satisfied Neutral Dissatisfied Very Dissatisfied 

Accurate h h h h h 

Complete h h h h h 

Easy to find h h h h h 

Easy to understand h h h h h 

Well organized h h h h h 

Applicable to your tasks h h h h h

 Please tell us how we can improve this book: 

 Thank you for your responses. May we contact you?   h Yes   h No

 When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any 

way it believes appropriate without incurring any obligation to you. 
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Address 

Company or Organization
 

Phone No.
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